
��������� 	
�����
���
��������	

����

�������������������������

585-210-928
Comcode 108869033

Issue 2
April 2001



Copyright 2001 Avaya Inc.
All Rights Reserved

Printed in U.S.A.

Notice

Every effort was made to ensure that the information in this 
document was complete and accurate at the time of printing. 
However, information is subject to change.

Your Responsibility for Your System’s Security

Toll fraud is the unauthorized use of your telecommunications 
system by an unauthorized party, for example, persons other 
than your company’s employees, agents, subcontractors, or 
persons working on your company’s behalf. Note that there 
may be a risk of toll fraud associated with your 
telecommunications system and, if toll fraud occurs, it can 
result in substantial additional charges for your 
telecommunications services.

You and your system manager are responsible for the security 
of your system, such as programming and configuring your 
equipment to prevent unauthorized use. The system manager 
is also responsible for reading all installation, instruction, and 
system administration documents provided with this product in 
order to fully understand the features that can introduce risk of 
toll fraud and the steps that can be taken to reduce that risk. 
Avaya, Inc. does not warrant that this product is immune from 
or will prevent unauthorized use of common-carrier 
telecommunication services or facilities accessed through or 
connected to it. Avaya, Inc. will not be responsible for any 
charges that result from such unauthorized use.

Avaya, Inc. Fraud Intervention

If you suspect that you are being victimized by toll fraud and 
you need technical support or assistance, call Technical 
Service Center Toll Fraud Intervention Hotline at 
1-800-643-2353.
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All other product names mentioned herein are the trademarks of their 
respective owners.

Ordering Information
Call: Avaya, Inc. Publications Center

Voice: 1-800-457-1235
International Voice: +1-317-322-6416
Fax: 1-800-457-1764
International Fax: +1-317-322-6699

Write: Avaya, Inc. BCS Publications Center
2855 N. Franklin Road
Indianapolis, IN 46219
U.S.A.

Order: CentreVu Supervisor Version 9 
Installation and Getting Started guide
Document No. 585-210-928
Comcode 108502170
Issue 2, April 2001

For additional documents, refer to the section entitled “Related 
Documents” in the Preface.
You can be placed on a Standing Order list for this and other 
documents you may need. Standing Order will enable you to 
automatically receive updated versions of individual 
documents or document sets, billed to account information that 
you provide. For more information on Standing Orders, or to be 
put on a list to receive future issues of this document, please 
contact the Avaya Inc. Publications Center.

Avaya, Inc. National Customer Care Center
Avaya, Inc. provides a telephone number for you to use to 
report problems or to ask questions about your call center. The 
support telephone number is 1-800-242-2121.

Document Support Telephone Number
Avaya, Inc. provides telephone numbers for you to use to 
report errors or to ask questions about the information in this 
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Voice: 1-888-584-6366 and
International Voice: +1-317-322-6848.

European Union Declaration of Conformity

Avaya, Inc. Business Communications Systems declares that 
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EMC Directive 89/336/EEC
Low Voltage Directive 73/23/EEC

The “CE” mark affixed to the equipment 
means that it conforms to the above 
Directives.

Disclaimer
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trademarks) and registered to AT&T Corporation has been 
transferred to Avaya, Inc. Incorporated.
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references to Avaya, Inc. Incorporated. The exception is cross 
references to books published prior to December 31, 1996, 
which retain their original AT&T titles.
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Any reference within the text to Lucent Technologies Inc. or 
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DEFINITIONS
l “You”, “Your”, or “Licensee” means the person or business entity who purchased this License 

to use this Client Software or for whom such License was purchased.
l “Client Software” means a software application that operates on a computer system that 

provides resources to Client Software.
l “Documentation” means the manual and any other printed material provided by Avaya Inc. 

with the Client Software.
l “License” means the License purchased and granted pursuant to this Agreement.

LICENSE AND PROTECTION

1. License Grant. Avaya Inc. grants to You, subject to the following terms and conditions, a 
nonexclusive, nontransferable right to use the Client Software on multiple single user devices, 
maximum simultaneous users of the Client Software being limited to the number Licensed and 
authorized by Avaya Inc.. THE SERVER SOFTWARE AUTOMATICALLY PREVENTS 
SIMULTANEOUS USE BY MORE THAN THE AUTHORIZED NUMBER OF USERS. 
Avaya Inc. reserves all rights not expressly granted to You.

2. Protection of Software. You agree to take all reasonable steps to protect the Client Software 
and Documentation from unauthorized copy or use. The Client Software source code 
represents and embodies trade secrets of Avaya Inc. and/or its licensors. The source code and 
embodied trade secrets are not licensed to You and any modification, addition, or deletion is 
strictly prohibited. You agree not to disassemble, decompile, or otherwise reverse engineer the 
Client Software in order to discover the source code and/or the trade secrets contained in the 
source code or for any other reason.

To the extent that the Client Software is located in a Member State of the European 
Community and You need information about the Client Software in order to achieve 
interoperability of an independently created software program with the Client Software, You 
shall first request such information from Avaya Inc. Unless Avaya Inc. refuses to make such 
information available, You shall not take any steps, such as reverse assembly or reverse 
compilation, to derive a source code equivalent to the Client Software. Avaya Inc. may charge 
You a reasonable fee for the provision of such information.

3. Copies. You may make multiple copies of the Client Software, provided You do not receive 
any payment, commercial benefit, or other consideration for reproduction or use. You may not 
copy Documentation unless it carries a statement that copying is permitted. All proprietary 
rights notices must be faithfully reproduced and included on all copies.

4. Ownership. Ownership of, and title to, the Client Software and Documentation (including any 
adaptations or copies) remains with Avaya Inc. and/or its licensors.

5. Restrictions. You agree not to rent, lease, sublicense, modify or time share the Client Software 
or Documentation.
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6. Termination. This Agreement shall automatically terminate if You breach any of the terms or 
conditions of this Agreement. You agree to destroy the original and all copies of the Client 
Software and Documentation, or to return them to Avaya Inc., upon Termination of this 
License.

LIMITED WARRANTY AND LIMITED LIABILITY

1. Compatibility. The Client Software is only compatible with certain computers and operating 
systems. THE SOFTWARE IS NOT WARRANTED FOR NONCOMPATIBLE SYSTEMS.

2. Software. Avaya Inc. warrants that if the Client Software fails to substantially conform to the 
specifications in the Documentations and if the Client Software is returned to the place from 
which it was purchased within one (1) year from the date purchased, then Avaya Inc. will 
either replace the Client Software or offer to refund the License Fee to You upon return of all 
copies of the Client Software and Documentation to Avaya Inc.. In the event of a refund, the 
License shall terminate.

3. DISCLAIMER OF WARRANTIES. Avaya Inc. makes NO WARRANTY, 
REPRESENTATION OR PROMISE NOT EXPRESSLY SET FORTH IN THIS 
AGREEMENT. AVAYA INC. DISCLAIMS AND EXCLUDES ANY AND ALL IMPLIED 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. AVAYA INC. DOES NOT WARRANT THAT THE CLIENT SOFTWARE OR 
DOCUMENTATION WILL SATISFY YOUR REQUIREMENTS OR THAT THE CLIENT 
SOFTWARE OR DOCUMENTATION ARE WITHOUT DEFECT OR ERROR OR THAT 
THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED. Some states or 
countries do not allow the exclusion of implied warranties or limitations on how long an 
implied warranty lasts, so the above limitation may not apply to You. This warranty gives You 
specific legal rights which vary from state to state.

4. EXCLUSIVE REMEDY. EXCEPT FOR BODILY INJURY CAUSED BY AVAYA INC.’S 
NEGLIGENCE, AVAYA INC.’S ENTIRE LIABILITY ARISING FROM OR RELATING TO 
THIS AGREEMENT OR THE CLIENT SOFTWARE OR DOCUMENTATION AND YOUR 
EXCLUSIVE REMEDY IS LIMITED TO DIRECT DAMAGES IN AN AMOUNT NOT TO 
EXCEED $10,000. AVAYA INC. SHALL NOT IN ANY CASE BE LIABLE FOR ANY 
SPECIAL INCIDENTAL, CONSEQUENTIAL, INDIRECT OR PUNITIVE DAMAGES 
EVEN IF AVAYA INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. AVAYA INC. IS NOT RESPONSIBLE FOR LOST PROFITS OR REVENUE, 
LOSS OF USE OF THE CLIENT SOFTWARE, LOSS OF DATA, COSTS OF 
RECREATING LOST DATA, THE COST OF ANY SUBSTITUTE EQUIPMENT OR 
PROGRAM, OR CLAIMS BY ANY PARTY OTHER THAN YOU. Some states or countries 
do not allow the exclusion or limitation of incidental or consequential damages, so the above 
limitation or exclusion may not apply to You.
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GENERAL CONDITIONS.

1. Governing Law. This Agreement shall be governed by, and interpreted in accordance with, 
the substantive laws of the State of New Jersey of the United States of America.

2. Entire Agreement. This Agreement sets forth the entire understanding and agreement 
between You and Avaya Inc. and may be amended only in a writing or writings signed by You 
and Avaya Inc. NO VENDOR, DISTRIBUTOR, DEALER, RETAILER, SALES PERSON 
OR OTHER PERSON IS AUTHORIZED TO MODIFY THIS AGREEMENT OR TO MAKE 
ANY WARRANTY, REPRESENTATION OR PROMISE WHICH IS DIFFERENT THAN, 
OR IN ADDITION TO, THE REPRESENTATIONS OR PROMISES OF THIS 
AGREEMENT ABOUT THE SOFTWARE.

3. Export. Licensee hereby agrees that it will not knowingly, directly or indirectly, without prior 
written consent, if required, of the Office of Export Licensing of the U.S. Department of 
Commerce, Washington D.C. 20230, export or transmit any of the Products to any group Q, S, 
W, Y, or Z country specified in the Export Administration Regulations issued by the U.S. 
Department of Commerce or to any country which such transmission is restricted by 
applicable regulations or statues.

4. U.S. Government Restricted Rights. Use, duplication, or disclosure by the United States 
Government is subject to restrictions as set forth in FAR 52.227-14 (June 1987) Alternate III 
(g)(3) (June 1987), FAR 52.227-19 (June 1987), or DFARS 52.227-7013 (c)(1)(ii) (June 
1988), as applicable Contractor/Manufacturer is Avaya, Inc. 11900 North Pecos Street, 
Westminster, Colorado 80234.

5. Assignment. Avaya Inc. may without your consent or notice to You, assign this Agreement to 
an entity to which it transfers ownership of the Client Software. Upon the effective date of 
such assignment, You agree that Avaya Inc. shall be released and discharged from all 
obligations and liabilities under this Agreement.

0
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CentreVu
Supervisor

Preface 0

Overview 1

The CentreVu® Supervisor Installation and Getting Started document includes 
the following information:
● Instructions for installing CentreVu Supervisor (referred to as Supervisor) 

on a local PC from a network server or CD-ROM

● Procedures for installing Supervisor to a Shared Network Drive

● Procedures for uninstalling Supervisor

● Instructions for using Supervisor

● Procedures for installing and using CentreVu Terminal Emulator

● Guidelines for responding to error messages that may be displayed while 
installing Supervisor or logging into the CentreVu Call Mangement System 
(referred to as CMS) server.

NOTE:
CentreVu Terminal must be separately installed. It is not automatically installed 
with Supervisor Version 9.
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The following sections are included in this Preface:
● Contents of this Document

● Conventions Used in this Document

● Related Documents.

Audience 1

This document is intended for anyone who is installing the Supervisor software for 
use with the DEFINITY® Enterprise Communications Server (ECS) and the CMS. It 
assumes that you are familiar with your PC and the Microsoft Windows* 95† or 
Windows 98‡, Windows NT** 4.0, Windows ME†† or Windows 2000 operating 
systems, including standard Microsoft Windows conventions.

*Microsoft Windows is a trademark of Microsoft Corp.
†Windows 95 is a trademark of Microsoft Corp.
‡Windows 98 is a trademark of Microsoft Corp.
**Windows NT is a registered trademark of Microsoft Corp.
††Windows ME is a trademark of Microsoft Corp.
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Contents of this document 1

The document is organized into the following chapters:

Chapter 1 Introduction

This chapter introduces the Supervisor application. It 
provides information on the following:

● The two methods of installation

● The items that are shipped to you in the 
Supervisor package

● The equipment that is required to run Supervisor

● The Helpline numbers

Chapter 2 Installing CentreVu Supervisor on a local PC

This chapter provides the procedures to install Supervisor 
from a CD-ROM or the network onto a PC that will not 
access Supervisor over the network.

Chapter 3 Installing CentreVu Supervisor on a shared 
network drive

This chapter provides the procedures to install Supervisor 
(executable and default files) to a shared read-only folder 
on the network server.

Chapter 4 Uninstalling CentreVu Supervisor

This chapter provides the procedures to uninstall 
Supervisor from a PC or network server. 
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Chapter 5 Getting started with CentreVu Supervisor

This chapter provides the procedures to start Supervisor, 
log into a CMS server, log out of a CMS server, and exit 
Supervisor. It also describes how to change your 
connection settings and provides information about 
getting help regarding the Supervisor product.

Chapter 6 Performing CentreVu CMS operations

This chapter describes how to use the windows that are 
displayed when you select an item from any Operations 
tab, including detailed information on the Actions menu 
items that are available in Operations input windows. 

Chapter 7 Using CentreVu Supervisor reports

This chapter describes how reports are displayed in 
Supervisor and shows how to format and print reports, 
including selecting run dates and times. This chapter also 
gives detailed information on the Actions menu items that 
are available in the report output windows and shows how 
to export report information to another Microsoft 
Windows application.

Chapter 8 Installing and using CentreVu Terminal

This chapter provides general information about the 
CentreVu Terminal application, including how to install it 
and how to set it up to connect to the CMS server. 

Chapter 9 Troubleshooting

This chapter gives you information on error messages that 
you might receive while installing or using Supervisor and 
provides basic procedures for troubleshooting the error 
messages.
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Conventions used in this document 1

The following conventions are used in this document:

Convention Description

Bold text Menu names, options, and icon names are shown in 
bold text. File names and locations of files are also 
shown in bold text. For example: Select Save from the 
File menu.

Initial Capital 
Letters

Names of windows and keyboard keys. For example: 
This field is in the Manual Login window.

Courier 
Text

Text you are asked to enter and system commands. For 
example: Enter this command. 

< > Variable text is marked by less-than/greater-than signs. 
For example: Couldn’t create <filename>.

KEY+KEY Key combinations for which you must press and hold 
down one key and then press another. For example: 
ALT+4.

Italic Text References to other documents.

Quotation marks 
(“ ”)

Sections and chapters that are referenced. For example: 
See Chapter 1, “Introduction,” for an outline of the 
information in this document.

Click and 
Double-click

References pushing button 1 (the left-most mouse 
button or primary button) one time or two times, 
respectively.

When you are asked to click or double-click the mouse 
button, click button 1 unless button 2 (the right-most 
button on the mouse or secondary button) is specified.
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Microsoft 
Windows or 
Windows

These terms are used to refer to Windows 95 with 
Distributed Component Object Model (DCOM), 
Windows 98, Windows NT 4.0 with Service Pack 4 or 
higher, Windows 2000, or Windows Millenium Edition 

(ME) running on at least a Pentiuma 150

a. Pentium is a registered trademark of Intel Corporation.

Convention Description
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Related documents 1

The following documents include additional information about CMS or 
Supervisor:
● CentreVu® Supervisor Version 5 User Guide, 585-215-829

● CentreVu® Call Management System Release 3 Version 9 Administration, 
585-214-015

● CentreVu® Supervisor Version 9 Reports, 585-210-929, Issue 2

● CentreVu® Call Management System Release 3 Version9 Database Items 
and Calculations, 585-210-945

● CentreVu® Call Management System Custom Reports, 585-215-822, Issue 
2

● Avaya Inc. Version 9 Call Center Change Description, 585-215-942

● CentreVu® Call Management System Release 3 Version 9 External Call 
History Interface, 585-215-952

● CentreVu® Advocate User Guide, 585-215-953

● CentreVu® Report Designer Version 9 User Guide, 585-210-930, Issue 2

● CentreVu® Call Management System Release 3 Version 9 Software 
Installation, Maintenance, and Troubleshooting, 585-215-956

● Sun SPARCserver Hardware Installation documentation, connectivity 
diagrams, and maintenance and troubleshooting documentation
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CentreVu
Supervisor

Introduction 1

Overview 1

This chapter includes the following sections:
● “About CentreVu Supervisor” on page 1-2

● “About CentreVu CMS” on page 1-6

● “Types of installation” on page 1-7

● “Checking package contents” on page 1-8

● “Installation support” on page 1-9

● “What you need on your PC” on page 1-12

● “What you need for your CentreVu CMS server” on page 1-14

● “CentreVu CMS system capacities” on page 1-15
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About CentreVu Supervisor 1

The Avaya CentreVu® Supervisor (referred to as Supervisor) software is a 
graphical user interface to the Avaya CentreVu Call Management System 
(referred to as CMS) Release 3 Version 9 (R3V9), Release 3 Version 8 (R3V8) 
or Release 3 Version 6 (R3V6) software. 

The Supervisor software runs on an Intel* 486-compatible processor (a Pentium 
processor is preferred) that is running one of the following Microsoft Windows† 
operating systems (see page 1-12 for more detailed requirements): 
● Windows 95‡ with Distributed Component Object Model (DCOM)
● Windows 98**

● Windows NT†† 4.0 with Service Pack 4 or a newer service pack
● Windows 2000‡‡

● Windows Millennium Edition (ME)*** running on at least a Pentium††† 
150

* Intel is a registered trademark of Intel Corporation.
†Microsoft Windows is a trademark of Microsoft Corp.
‡Windows 95 is a trademark of Microsoft Corp.
**Windows 98 is a trademark of Microsoft Corp.
††Windows NT is a trademark of Microsoft Corp.
‡‡Windows 2000 is a trademark of Microsoft Corp.
***Windows ME is a trademark of Microsoft Corp.
††† Pentium is a registered trademark of Intel Corporation.
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Languages supported by Supervisor 1

Supervisor is not supported for all languages of Microsoft Windows operating 
systems. For information about which versions of Supervisor are supported for 
which Microsoft Windows operating systems, see the following table (  
indicates that the operating system is supported).

Table 1-1: Languages supported by Supervisor

L
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English Dutch French German Italian
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Spanish Japanese Chinese
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Windows ME
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Windows 95
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4.0

Windows 
2000

Windows ME
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About CentreVu CMS 1

CentreVu Call Management System (CMS) is a software product used by 
customers who use an Avaya DEFINITY® Enterprise Communications Server 
(ECS) or other Avaya telecommunications switch and receive a large volume of 
telephone calls that are processed through the Automatic Call Distribution 
(ACD) feature of the switch. The CMS server collects call-traffic data, formats 
management reports, and provides an administrative interface to the ACD 
feature in the switch.
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Types of installation 1

This document discusses the following methods of installing Supervisor:
● Local installation. With this type of installation, all of the Supervisor 

software is installed locally on each PC from a CD-ROM or from a 
network server. When installing from the network, the network 
administrator first copies the Supervisor installation files to a shared 
installation folder that resides on the network. Then, the user runs a client 
setup from the installation folder to install Supervisor to disk space that is 
local to the PC. See Chapter 2, “Installing CentreVu Supervisor on a Local 
PC,” for details.

● Shared network installation. With this type of installation, the Supervisor 
software is installed in a shared application folder on the network server, 
but user-specific files and logs are stored in a Supervisor folder on each 
user’s PC or on the user’s network drive. See Chapter 3, “Installing 
CentreVu Supervisor on a Shared Network Drive,” for details.
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Checking package contents 1

The Supervisor software package includes the items that are listed in the 
following table. Check the package contents to be sure that all items are 
included.

If either of the items is missing or damaged, contact your Avaya account team. 
For support outside of the United States, contact your Avaya representative or 
distributor.

Table 1-2:  Supervisor package contents

Item Description

CentreVu Supervisor 
Software

CD-ROM

CentreVu® Supervisor 
Installation and Getting 
Started document 

Document number 585-210-928, 
Issue 2
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Installation support 1

If you have difficulty installing Supervisor, refer to the following sources:
● System requirements in “What you need on your PC” on page 1-12.

● The online Help that is provided with the installation program. See “Online 
help” on page 1-10.

● The tips in the readme.txt file on the CD-ROM. Use an editor such as 
Microsoft Windows Notepad to read the file.

● The Install Status window. This window displays a list of all files that are 
installed for Supervisor Version 9. Review this list to see that all files were 
successfully installed.

● Chapter 9, “Troubleshooting” 

If you have further questions, contact the Avaya National Customer Care Center 
on 1-800-242-2121. For support outside of the United States, contact your 
Avaya representative or distributor.

Tips 1

The CD-ROM in your package includes a graphical installer to help you install 
your copy of Supervisor.

The CD-ROM also supports the Microsoft Windows AutoPlay feature. If 
AutoPlay is enabled on the PC, insert the CD-ROM into the drive and the 
Supervisor Setup program starts automatically. 

NOTE:
See your system administrator for information on how to enable or 
disable AutoPlay on your PC.

You can cancel the installation of Supervisor at any time by selecting Close 
from the control menu, pressing Alt+F4, or pressing the F3 key. You can also 
cancel the installation by selecting the Cancel button at the bottom of the 
installation screen. When you cancel an installation, the Supervisor installation 
program exits installation and removes any files that were built by the program 
during the incomplete installation.
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Online help 1

Online Help is provided with Supervisor to assist you in installing and using the 
product. The online Help is divided into main categories or books. To see the 
categories that are available in Help, select the Contents tab on the Help Topics 
window, as shown below.

Help topics 1

Topics are the basic unit of an online Help system. Each Help book that is listed 
above contains a list of topics. Double-click the book name to list the related 
topics, which are represented by a question mark, as shown above under 
Database Items and Calculations.
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Using Help 1

You can get information from Supervisor Help in a number of ways. The 
method you use depends on the type of information for which you are 
searching. The following methods of accessing Help are available:
● Help contents. To display a list of the books and topics the Help system, 

select Contents from the Help menu on the Supervisor Controller 
Window.

● Help on open windows. With a window open, you can press the F1 key to 
get help on that window.

● Help on a specific topic. Select the Find tab from the Help Topics window 
to search for topics that contain a specific term or phrase.

● What’s This? help. With a window open that displays the  icon in the 
title bar, help topics are available for each area or individual item in the 
window. Click the icon, followed by the item or area on which you want 
help. You can also right-click certain items and select “What’s This?”

Additional features, such as bookmarks, are available in the Supervisor Help 
system. For more information on using the standard Help features, see your 
Microsoft Windows documentation.
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What you need on your PC 1

To install and run Supervisor, you need the following minimum configuration 
of hardware and software is recommended.
● A Pentium133-MHz processor (Pentium 150 for Windows ME).

NOTE:

The minimum supported PC configuration is an Intel 486-compatible 66-
MHz processor. Response time will be slower with this processor.

● A hard disk drive with 50 MB of free space. If you are installing Supervisor 
in more than one language, you also need an additional 5 MB of disk space 
for each installation of Supervisor in another language. 

● A CD-ROM drive.

● A minimum of 32 MB RAM. If simultaneous Supervisor instances are 
running in the background, additional memory may be required to maintain 
acceptable performance.

● An SVGA monitor and adapter set to at least 800 x 600 x 256 colors 
graphics resolution.

● Windows 95 with DCOM, Windows 98, Windows NT 4.0 with Service 
Pack 4 or higher, Windows ME ona Pentium 150, or Windows 2000 
operating system.

NOTE:

If you are installing Supervisor on a Windows NT 4.0 operating system, 
you must first install the Microsoft Service Pack 4 or later version. 

● A mouse that is compatible with the supported Microsoft Windows 
operating systems.

● For network connection:

— A WinSock 1.1 compliant TCP/IP stack 

— An ethernet communications board.
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● For serial connection:

— A serial cable that is correctly wired to support hardware flow control 
and a 16550A UART communications port

— An available COM port.

● For modem connection:

— At least a 19.2 Kbps modem and a 16550A UART communications 
port. If the modem is external, the cable must be correctly wired to 
support hardware flow control.

Other requirements 1

In addition to the recommended hardware and software requirements, the 
following items affect Supervisor installation.
● If you are upgrading from Supervisor Version 1.0 or Version 5.0 and you 

are running Windows 3.1, Windows for Workgroups 3.11, or Windows NT 
3.51, you must upgrade your PC operating system to Windows 95, 
Windows 98, Windows NT 4.0, Windows ME, or Windows 2000 before 
you can install Supervisor Version 9.

● If you are installing Supervisor on a Windows 95 or Windows 98 operating 
system that does not have Internet Explorer 4.0, you must install DCOM95 
before installing Supervisor. To install DCOM95, run the dcom95.exe 
program that is located in the Dcom95 folder on your Supervisor CD-
ROM, or in the Supervisor folder on the network server. 

NOTE:

DCOM95 requires that you reboot your PC, so you need to close any open 
applications before you run it. 

● If you are running Windows NT 4.0 and do not have Service Pack 4 
installed, you must install it before installing Supervisor.

NOTE:

If you have Windows NT 4.0 without a Service Pack or if you have Service 
Pack 1 or Service Pack 2, you must install Service Pack 3 and then Service 
Pack 4. If you have Windows NT 4.0 with Service Pack 3, you must 
upgrade to Service Pack 4.
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What you need for your CentreVu CMS server 1

To install and run Supervisor, you need the following CMS platform and 
version:
● A Sun* Ultra5, Sun E3000, or Sun E3500 computer with Solaris 8

● CentreVu CMS R3V9, R3V8, or R3V6 running on the Sun platform.

NOTE:

If you are upgrading from Supervisor 1.0 or 5.0, you must upgrade your 
CMS server before you upgrade Supervisor. When you log in to the CMS 
server, you must have both Supervisor Version 9 and CMS R3V9, R3V8, 
or R3V6 or the login fails and the system displays an error message. You 
are given the option to choose a version of CMS to use when you log in to 
Supervisor.

*Sun is a registered trademark of Sun Microsystems, Inc.
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CentreVu CMS system capacities 1

The CMS system capacities are unchanged by the Supervisor software. If you 
are putting your Supervisor users on a LAN, your network must be able to 
support the additional network traffic.

Number of Supervisor windows allowed 1

Supervisor makes it possible for users to open as many as 12 windows 
simultaneously. This limit is set for each user by the CMS system administrator. 
Microsoft Windows that do not directly use CMS data, such as the color 
customization data, are not included in this limit. Also, windows that are open 
for applications other than Supervisor are not included in this limit.

The Supervisor application can connect to a single CMS. Supervisor does not 
provide the capability to combine data from more than one CMS.

Number of simultaneous instances allowed 1

With the recommended configuration listed in “What you need on your PC” on 
page 1-12, you can run as many as four simultaneous Supervisor instances. 
With an Intel 486-compatible processor, you are limited to one instance of 
Supervisor with one report.

With Windows 95, you are limited to one instance of Supervisor with six 
reports running or four instances of Supervisor with one report each. 

The ability to run several instances of Supervisor and the performance of the 
Supervisor software in this situation depends on the memory and speed of the 
PC that you are using. It is also affected by any other applications that are 
running on the PC while Supervisor is in use. If simultaneous Supervisor 
instances are running in the background, the PC may require additional memory 
to maintain acceptable performance.
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Number of PCs allowed to run Supervisor 1

The number of PCs that are running Supervisor is limited by the number of 
simultaneous users who are contracted for in the site-licensing agreement with 
Avaya. The CMS software counts the number of active Supervisor clients that 
are logged in and limits the number of simultaneous users to the number of 
logins that were purchased by the customer.

A client may be logged in to a CMS server once per user ID on a single PC.

Performance 1

When you are using Supervisor you may experience slightly slower response 
times for some actions. The following are a few possible reasons for slower 
performance:
● The PC’s configuration, processor speed, Level 2 cache, hard disk speed, 

and video RAM could affect the response time.

● If the Supervisor application is running simultaneously with other 
applications, performance of the Supervisor application could be affected 
by those other applications.

● Two or more Supervisor instances that are running simultaneously could 
result in slightly slower response time. 

● If Supervisor is running in a LAN environment, Supervisor generates 
additional network traffic. For example, if 250 Supervisor instances are 
running two real-time reports each, Supervisor could require 
approximately 20% of the LAN’s capacity. Therefore, ensure that your 
LAN is engineered appropriately.

● In a LAN environment, network backups can cause congestion on the 
network and adversely affect the network performance. 
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Reliability and availability 1

If serial links or LAN connectivity drop and you are logged in using the 
Automatic Login capability, Supervisor automatically attempts to restore the 
connection. 

Security 1

When Supervisor is connected to CMS, you have the same level of security as 
you do when you use a dedicated CMS terminal. The existing CMS permissions 
structure is honored. When you are using Supervisor on a LAN, you are able to 
access only the information that is available in a direct-connect environment.
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Overview 2

Local installation means that you install all of the files necessary to run 
CentreVu® Supervisor (Supervisor) on disk space within a PC. You can perform 
this installation from either a CD-ROM or a network server. 

If you are installing Supervisor from the network, you must first copy the 
Supervisor installation files from the CD-ROM onto the network. Then you 
install Supervisor onto each client PC from the network.

You must have administrator privileges to install Supervisor on a PC that is 
running Windows NT* 4.0.

This chapter includes the following sections:
● “Installation procedures” on page 2-2

● “Preparing the network folder” on page 2-2

● “Setting up the PC” on page 2-3

*Windows NT is a trademark of Microsoft Corp.
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Installation procedures 2

Installing Supervisor over a network is a two-step process that consists of:
● Preparing the installation folder

● Installing Supervisor on each PC

Use these procedures to install Supervisor on a PC that will run the application 
from a local disk drive. If you are using the network to install Supervisor on 
each PC, start with “Preparing the network folder”below. If you are using the 
CD-ROM to install Supervisor on each PC, start with “Setting up the PC” on 
page 2-3.

NOTE:
For installation requirements, see “Other requirements” on page 1-13.

Preparing the network folder 2

This section describes how to set up the network folder that will house the 
Supervisor files for installation on individual PCs. After preparing the network 
folder, you will set up the PC and then install Supervisor.

To prepare the network folder:

1. At a PC that is connected to the network, insert the CentreVu Supervisor 
CD-ROM into the CD-ROM drive.

2. If AutoPlay is enabled on the PC, the CentreVu Supervisor Setup program 
starts automatically after you insert the CD-ROM into the drive. Select the 
Cancel button in the window that is displayed and continue with Step 3.

NOTE:

See your system administrator for information on how to enable or disable 
AutoPlay on your PC.

3. Open Microsoft Windows* Explorer.

4. Create a folder on the network drive, and record the path to the folder for 
later use.

*Microsoft Windows is a trademark of Microsoft Corp.
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5. Use the Copy command or the drag-and-drop method to copy the contents 
of the CD-ROM to the folder that you created in Step 4. Be sure to copy all 
of the files. 

6. Verify that the network drive to which you copied the contents of the 
distribution medium is available to each PC that will be installing 
Supervisor from the network.

7. Continue with “Setting up the PC”.

Setting up the PC 2

Complete these steps to install Supervisor on a PC.

1. Before starting the installation, close all programs that are running on the 
PC. 

2. On the Supervisor distribution medium (CD-ROM or installation folder), 
locate and double-click the Readme.txt file to view last-minute installation 
tips for this Supervisor release.

The readme.txt file displays in Microsoft Windows Notepad, as shown 
below:

3. Close the Notepad application to exit the readme.txt file.
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4. Perform one of the following actions:

a. If you are installing from the CD-ROM and AutoPlay is enabled, 
insert the CD-ROM. Skip Step 5 through Step 9 and continue with 
Step .

b. If you are installing from the CD-ROM and AutoPlay is not enabled, 
complete Step 5 and Step 6, insert the CD-ROM and then continue 
with Step 10.

c. If you are installing from the network, complete Step 5, skip Step 6, 
complete Step 7, Step 8, and Step 9, and continue with Step 10.

5. From the Microsoft Windows Start menu, select Run. 

The system displays the Run window.

6. In the Open text box, enter the letter that designates the drive from which 
you are installing Supervisor, followed by setup, and then select OK. In 
the following example, the “c:” drive is selected.
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7. In the Run window, select the Browse button. 

The system displays the Browse window.

8. In the Browse window, navigate to the drive and directory that contain the 
Supervisor files.

NOTE:

If the drive that contains the Supervisor installation files is not mapped to 
the PC, you must map this drive now. To do this, open Microsoft Windows 
Explorer and select Map Network Drive from the Tools drop-down menu. 
Select any available drive letter and enter the appropriate description in the 
path field, for example, \my_server\folder_name.
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9. Locate and double-click on the setup.exe file to begin the installation.

After a short wait, the system displays the Supervisor Installation Welcome 
window.

10. Select Next. 

Setup begins searching for a previous installation of Supervisor on your 
PC.

The system displays the Type of Location window. 
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11. Select Install to Local PC to install Supervisor to a stand-alone client PC 
or on the client’s own LAN drive.

12. Select Next. 
● If the system displays the Select Location window, it means that the 

setup program did not find any previous installation of Supervisor. Go 
to Step 21.

● If the setup program finds a previous installation of Supervisor the 
system displays the Previous Version Found window. Continue with 
Step 13.

13. Select OK to continue with the installation.

14. Perform one of the following actions, depending on which version of 
Supervisor that the setup program finds:
● If the system displays the Replace CentreVu Supervisor 5.0 window, it 

means that the setup program found an installation of Supervisor 
Version 5. Go to Step 15.

● If the system displays the Replace CentreVu Supervisor 1.0 window, it 
means that the setup program found an installation of Supervisor 
Version 1. Go to Step 18.

● If the system finds a previous installation of V6, V8, or V9 CentreVu 
Supervisor, you will be prompted to remove it or to install CentreVu 
Supervisor R9 as an upgrade, replacing the previous release. Continue 
with Step 21 or see Chapter 4: Uninstalling CentreVu Supervisor in 
this document.
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15. The systems displays the Replace CentreVu Supervisor 5.0 window

16. Select one of the following:
● Replace Existing. The setup program deletes the existing installation 

of Supervisor Version 5 and installs Supervisor Version 9 in its place.

● Keep Existing. The setup program keeps the existing installation of 
Supervisor Version 5 and prompts you to install Supervisor Version 9 
in a different folder.

NOTE:

If you keep the previous installation of Supervisor Version 5, you can 
uninstall it later using the uninstall executable file on the Supervisor CD-
ROM. This file is named removeV5.exe.

17. Select Next and continue with Step 21.

18. The system displays the Replace CentreVu Supervisor 1.0 window

19. Select one of the following:
● Replace Existing. The setup program deletes the existing installation 

of Supervisor Version 1 and installs Supervisor Version 9 in its place.

● Keep Existing. The setup program keep the existing installation of 
Supervisor and prompts you to install Supervisor Version 9 in a 
different folder.

NOTE:

If you keep the previous installation of Supervisor Version 1, you can 
uninstall it later using the uninstall executable file on the Supervisor CD-
ROM. This file is named removeV1.exe.

20. Select Next.
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21. The system displays the Select Location window. If you are replacing the 
existing version of Supervisor, the Browse button is disabled.

22. Make sure that you have enough disk space to install the application to the 
specified drive.

NOTE:

The numbers at the bottom of the window indicate the total space that is 
available on the specified drive and the total space that will be available 
after installation of Supervisor.

23. Perform one of the following actions, depending on where you want to 
install the Supervisor files:
● If you want to install the Supervisor files in the default installation 

path displayed, skip Step 24 through Step 26 and continue with Step 
27. 

● If you want to install the Supervisor files in a different drive or folder, 
continue with Step 24.
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24. Select the Browse button to display the Select Destination Folder window.

25. In the Select Destination Folder window, perform one of the following 
actions:
● Navigate to the drive and folder where you want to install the files. 

Double-click the name of the folder to select it.

● Type the name of the drive and folder where you want to install the 
files. If the folder does not exist, the Setup program creates it.

26. When you have selected the location, select OK. 

The system displays the destination path that you chose Select Location 
window. 



  
 CentreVu Supervisor V9 Installation and Getting Started
Installing CentreVu Supervisor on a local PC
Installation procedures 2-11

27. Select Next. 

The system displays the Type of Install window.

28. In the Type of Install window, select one of the following options and then 
the Next button.
● Typical. This selection installs all of the basic options in English, 

which is required, and all of the basic options in the language of your 
Microsoft Windows operating system. Skip Step 29 through Step 30 
and continue with Step 31.

● Custom. This selection lets you choose which options and language 
versions to install. Continue with Step 29.

NOTE:

If you are performing a Supervisor Version 9 upgrade, you must also install 
all of the required languages. The Supervisor upgrade does not 
automatically reinstall the required languages.
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29. If you select Custom, the system displays the Select Components window. 
Use this window to select the components and language versions that you 
want to install.

Before making your selections, read the bottom half of the window. It 
provides you with the following information:

● The total space that is required to install the options that you selected

● The total space that is available on the specified drive (both the 
destination drive and the drive on which Microsoft Windows exists).

30. Select the components in the list box that you want to install. 

NOTE:

The English versions of Supervisor and online help are always installed. If 
you are running a supported nonEnglish version of Microsoft Windows, 
Setup installs Supervisor and online help in the language that matches your 
Microsoft Windows system. See page 1-3 for a table that lists the supported 
versions of Microsoft Windows and Supervisor in different languages.
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31. Select Next. 

The system displays the Select Folder window.

32. Perform one of the following actions, depending on the folder in which you 
want to put Supervisor shortcuts.
● Choose the default folder that is displayed.

● Type a different folder name in the text box. The Supervisor setup 
program creates the folder.

● Select a folder name from the list of existing groups.
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33. Select Next.

The system displays the Ready to Install window.

34. Select Install to begin the installation. 

The system displays a progress indicator that shows what percentage of the 
files are being installed.

NOTE:

The Install Status window displays a list of all files that are installed for 
Supervisor Version 9. Review this list to see that all files were successfully 
installed.
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When the installation is complete, the system displays the Install 
Successful window.

35. Select Finish to return to your desktop.

Supervisor installation is complete. 

Go to Chapter 5, “Getting Started with CentreVu Supervisor,” for the 
procedures on establishing a connection to the CMS server.
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Overview 3

This chapter explains how to install the CentreVu Supervisor (referred to as 
Supervisor) software for use in a shared application folder configuration on the 
network drive. With this type of installation, the Supervisor executable files 
reside on the application server and are shared by multiple computers.

You must have administrator privileges to install Supervisor on a PC that is 
running Microsoft Windows NT* 4.0.

You must first do a network setup to install Supervisor onto the network. Then, 
from each client workstation, you do a client setup to make it possible for users 
to access Supervisor from their workstations. 

This chapter includes the following sections:
● “Installation procedures” on page 3-2

● “Network setup” on page 3-2

● “Client setup” on page 3-11

*Windows NT is a trademark of Microsoft Corp.
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Installation procedures 3

Installing Supervisor to a shared application folder is a two-step process that 
consists of the following:
● Performing the network setup

● Performing a client setup at each client PC

The network setup expands all program files and all language options into the 
network directory. In addition, this setup transfers a client setup program and its 
associated files to the network directory. You can do this setup from either the 
network installation folder or from a CD-ROM.

The client setup program makes it possible for clients to access Supervisor from 
the network server. Client setup creates a folder on the client PC. The icons in 
the folder point to the executable files on the application server. In addition, 
client setup allows you to identify where you want to put the user-specific files. 
These files can be located on the client’s local drive or on the network.

NOTE:
For installation requirements, see “Other Requirements” on page 1-13.

Network setup 3

To perform a network setup, you must first have administrative privileges on a 
workstation that is running Microsoft Windows*. 

To perform network setup:

1. Log into the PC as a user with administrative privileges.

2. Close all programs that are running on the PC.

3. Create a folder on the network drive to hold the Supervisor application 
files, and make it read-only and shared.

4. Verify that the network drive that contains the application folder is 
connected to each client PC.

*Microsoft Windows is a trademark of Microsoft Corp.
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5. On the Supervisor distribution medium (CD-ROM or installation folder), 
locate and double-click on the Readme.txt file to view last-minute 
installation tips for this Supervisor release. 

The file displays in Microsoft Windows Notepad, as shown below:

6. Close the Notepad application to exit the readme file.

7. Insert the Supervisor CD-ROM into the CD-ROM drive. One of the 
following will occur:
● If AutoPlay is enabled, setup starts automatically when you insert the 

CD-ROM. Skip Step 8 and Step 9 and continue with Step 10.

● If AutoPlay is not enabled, proceed with Step 8. 
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8. From the Microsoft Windows Start menu, select Run. 

The system displays the Run window.

9. In the Open text box, enter the letter that designates the drive from which 
you are installing Supervisor, followed by setup, and then select OK. In 
the following example, the “d:” drive is selected.

You can also install Supervisor from an installation folder on the network 
drive. If the drive that contains the Supervisor installation files is not 
mapped to your PC, type the network path in the Open box of the Run 
window to map it to your PC.
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10. After a short wait, the system displays the Supervisor Installation Welcome 
window.
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11. Select Next. 

The system displays the Type of Location window. 

12. Select Install on Shared Network Drive to install the Supervisor 
application files to a folder on a shared network server. 



  
 CentreVu Supervisor V9 Installation and Getting Started
Installing CentreVu Supervisor on a shared network drive
Installation procedures 3-7

13. Select Next. 

The system displays the Select Network Location window.

The setup program expands all program files and all language versions into 
the network directory specified in the Select Network Location window.

14. Make sure that you have enough disk space to install the application to the 
specified drive.

NOTE:
The numbers at the bottom of the window indicate the total space 
that is available on the specified drive and the total space that will 
be available after installation of Supervisor.

15. Perform one of the following actions, depending on where you want to 
install the Supervisor files:
● If you want to install the Supervisor files in the default installation 

path displayed, skip Step 15 through Step 17 and continue with Step 
19. 

● If you want to install the Supervisor files in a different drive or folder, 
continue with Step 15.
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16. In the Select Network Location window, use the Browse option to display 
the Select Destination Folder window. 

17. Navigate to the drive that contains the folder that you created in Step 3 and 
double-click the folder to select it.

NOTE:
If you are performing a Supervisor upgrade, the upgrade must be installed 
in the same folder that contains the previous Supervisor Version 9 software. 
It is the system administrator’s responsibility to make sure that the client’s 
PC is mapped to the network drive and folder that contain the Supervisor 
Version 9 software.

18. Select OK. 

The system displays the System Network Location window, which shows 
the drive and folder in which Supervisor will be installed.
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19. Select Next.

 The system displays the Ready to Install window.

20. Select Install to begin the installation. 

The system displays a progress indicator that shows what percentage of the 
files are installed.
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When the installation is complete, the system displays the Install 
Successful window.

Select Finish to return to your desktop.

Supervisor installation to the network drive is complete. 
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Client setup 3

The client setup program sets up the client computer to access Supervisor from 
the network server. Supervisor setup installs the application files on the 
network. Client setup installs the user-specific files that are needed to run 
Supervisor on the PC.

NOTE:
You must run client setup from the actual PC that the will be used to 
access Supervisor. If you just logon to the network as each user and then 
run client setup, the program does not install properly.

To set up a client PC:

1. Close programs that are running on the PC.

2. In Microsoft Windows Explorer or Network Neighborhood (Microsoft 
Windows 95 or 98, Microsoft Windows NT 4.0, Microsoft Windows ME or 
Microsoft Windows 2000), navigate to the directory where Supervisor is 
installed on the network. 

3. Locate and then double-click the setupclt.exe file. 

After a short wait, the system displays the Supervisor Installation Welcome 
window.
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4. Select Next. 

Setup begins to search for a previous installation of Supervisor on the PC. 
● If the system displays the Select Destination Directory window, it 

means that the setup program did not find any previous installation of 
Supervisor. Continue with Step 13.

● If the setup program finds a previous installation of Supervisor the 
system displays the Previous Version Found window.

5. Select OK to continue with the installation.

6. Perform one of the following actions, depending on which version of 
Supervisor that the setup program finds:
● If the system displays the Replace CentreVu Supervisor 5.0 window, it 

means that the setup program found an installation of Supervisor 
Version 5. Go to Step 15.

● If the system displays the Replace CentreVu Supervisor 1.0 window, it 
means that the setup program found an installation of Supervisor 
Version 1. Go to Step 18.

● If the system finds a previous installation of V6, V8, or V9 CentreVu 
Supervisor, you will be prompted to remove it or to install CentreVu 
Supervisor R9 as an upgrade, replacing the previous release. Continue 
with Step 13 or see Chapter 4: Uninstalling CentreVu Supervisor in 
this document.

7. The systems displays the Replace CentreVu Supervisor 5.0 window
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8. Select one of the following:
● Replace Existing. The setup program deletes the existing installation 

of Supervisor Version 5 and installs Supervisor Version 9 in its place.

● Keep Existing. The setup program keeps the existing installation of 
Supervisor Version 5 and prompts you to install Supervisor Version 9 
in a different folder.

NOTE:
If you keep the previous installation of Supervisor Version 5, you 
can uninstall it later using the uninstall executable file on the 
Supervisor CD-ROM. This file is named removeV5.exe.

9. Select Next and continue with Step 21.

10. The system displays the Replace CentreVu Supervisor 1.0 window

11. Select one of the following:
● Replace Existing. The setup program deletes the existing installation 

of Supervisor Version 1 and installs Supervisor Version 9 in its place.

● Keep Existing. The setup program keep the existing installation of 
Supervisor and prompts you to install Supervisor Version 9 in a 
different folder.

NOTE:
If you keep the previous installation of Supervisor Version 1, you 
can uninstall it later using the uninstall executable file on the 
Supervisor CD-ROM. This file is named removeV1.exe.

12. Select Next.
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13. The system displays the Select Destination Directory window. If you are 
replacing the existing version of Supervisor, the Browse button is disabled.

NOTE:
The Select Destination Directory window lets you choose where you want 
to install user-specific files. If a previous user file location is not detected, 
the default location is c:\Avaya\CentreVu\Supervisor. If a previous user 
file location is detected, the client setup displays the user file path that was 
used for the previous installation. 

14. Perform one of the following actions, depending on where you want to 
install the Supervisor files:
● If you want to install the Supervisor files in the default installation 

path that is displayed, skip Step 15 through Step 17 and continue with 
Step 18. 

● If you want to install the Supervisor files in a different drive or folder 
than the one that is displayed, continue with Step 15.
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15. Select the Browse button to display the Select Destination Folder window.

16. In the Select Destination Folder window, perform one of the following 
actions:
● Navigate to the drive and folder where you want to install the files. 

Double-click the folder to select it.

● Type the drive and folder where you want to install the files. If the 
folder does not exist, the Setup program creates it.

NOTE:
The user files can be located on the client’s local drive or on the network.

17. When you have selected the location, select the OK button.

The destination system displays the that path you chose in the Select 
Location window. 
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18. Select Next. 

The system displays the Type of Install window.

19. In the Type of Install window, select one of the following:

20. In the Type of Install window, select one of the following options and then 
the Next button.
● Typical. This selection installs all of the basic options in English, 

which is required, and all of the basic options in the language of your 
Microsoft Windows operating system. Skip Step 21 and Step 22 and 
continue with Step 23.

● Custom. This selection lets you choose which options and language 
versions to install. Continue with Step 21.

NOTE:
If you are performing a Supervisor Version 9 upgrade, you must 
also install all of the required languages. The Supervisor upgrade 
does not automatically reinstall the required languages.
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21. If you selected Custom, the system displays the Select Components 
window. This window lets you select the components and language 
versions that you want to install. 

Before making your selections, read the bottom half of the window. It 
provides you with the following information:

● The total space that is required to install the options that you selected

● The total space that is available on the specified drive (both the 
destination drive and the drive on which Microsoft Windows exists).

22. Select the components in the list box that you want to install. 

NOTE:
The English versions of Supervisor and online help are always 
installed. If you are running a supported nonEnglish version of 
Microsoft Windows, Setup installs Supervisor and online help in 
the language that matches your Microsoft Windows system. See 
page 1-3 for a table that lists the supported versions of Microsoft 
Windows and Supervisor in different languages.
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23. Select Next. 

The system displays the Select Folder window.

24. Perform one of the following actions, depending on the folder in which you 
want to put Supervisor shortcuts.
● Choose the default folder that is displayed.

● Type a different folder name in the text box. The Supervisor setup 
program creates the folder.

● Select a folder name from the list of existing groups.
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25. Select Next. 

The system displays the Ready to Install window.

26. Select Install to begin the setup. 

The system displays a progress indicator that shows what percentage of the 
files are being installed.

NOTE:
The Install Status window displays a list of all files that are installed 
for Supervisor Version 9. Review this list to see that all files were 
successfully installed.
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When the installation is complete, the system displays the Install 
Successful window.

27. Select Finish to return to your desktop.

Supervisor installation is complete. 

Go to Chapter 5, “Getting Started with CentreVu Supervisor,” for the 
procedures on establishing a connection to the CMS server.

NOTE:
If you get a message that you need to restart your computer before running 
Supervisor, select OK to restart your computer.
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Overview 4

You can easily uninstall the CentreVu Supervisor (Supervisor) application using 
the Microsoft Windows* Add/Remove Programs wizard. Uninstall removes the 
Supervisor files and folders from the PC. Uninstall does not remove 
components, registry entries, files that are being used by other applications, or a 
folder that is not empty. 

NOTE:
A registry is a Microsoft Windows database that holds information about 
the system and its applications, including system settings, client, and 
server information.

This chapter includes the following section:
● “Performing the uninstall” on page 4-2

*Microsoft Windows is a trademark of Microsoft Corp.
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Performing the uninstall 4

To uninstall Supervisor:

1. Close all programs that are running on the PC.

2. From the Microsoft Windows Start menu, select Settings > Control 
Panel. 

3. Double-click the Add/Remove Programs icon. 

The system displays the Add/Remove Programs Properties window.

4. Select the Install/Uninstall tab.

5. Highlight CentreVu Supervisor 9.0 in the list of installed software.
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6. Select the Add/Remove button. 

The system displays the Remove CentreVu Supervisor 9.0? window.

7. Select Yes. 

The system displays the Perform Uninstall window and a progress 
indicator that shows what percentage of the files are installed.

NOTE:

If you press Cancel at this time, the system cancels the uninstall 
process. However, because some files have been deleted, Supervisor 
will not run. Also, the system prevents you from trying to uninstall 
Supervisor files a second time if you cancel the first attempt.

After the uninstall is complete, the system returns you to the desktop.
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Overview 5

This chapter provides information on the main components of the Supervisor 
Controller window. It also provides procedures for common operations that you 
will perform in Supervisor. This chapter includes the following sections:
● “Logging in to the CentreVu CMS server for the first time” on page 5-10
● “Logging into the CentreVu CMS server after first time” on page 5-11
● “Logging off the CentreVu CMS server” on page 5-15
● “Exiting Supervisor” on page 5-16
● “Changing connection settings” on page 5-17
● “Exploring the CentreVu Supervisor Controller” on page 5-19
● “Using the system tray icon” on page 5-37

● “Using Supervisor menus” on page 5-38
● “Using Supervisor selector windows” on page 5-39
● “Completing input windows” on page 5-41
● “Completing input fields” on page 5-43
● “Using the browse button” on page 5-44
● “Using the history list” on page 5-47
● “Closing Supervisor windows” on page 5-48
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Establishing CentreVu CMS server connection 
settings 5

NOTE:
If you have already established connection settings, skip this section and 
continue with the following sections:
● “Logging in to the CentreVu CMS server for the first time” on page 

5-10

● “Logging into the CentreVu CMS server after first time” on page 
5-11.

You must establish connection settings in order to connect to the CMS server. 

There are three connection options: 
● Network

● Serial

● Modem. 

There are two ways to set these options to connect to the CMS server:
● Automatic. To log in to the CMS server directly from Supervisor.

● Manual. To log in to the CMS server by way of the server’s Solaris* 
system. You would use manual login for the following reasons:

— You need to access cmssvc and cmsadm menus.

— You are instructed to do so for troubleshooting.

— Your version of Supervisor resides in a different Solaris system than 
the CMS server.

NOTE:

For more information about your Solaris system, see your Solaris system 
administrator. 

Now you are ready to open Supervisor and establish a connection to the CMS 
server.  Continue with “Opening the CentreVu Supervisor application” on page 
5-3.

*Solaris is a registered trademark of Sun Microsystems.
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Opening the CentreVu Supervisor application 5

To open the Supervisor application:

1. From the Microsoft Windows* Start menu, select Programs > Avaya 
CentreVu Supervisor 9.0.

2. Select CentreVu Supervisor-English from the Avaya CentreVu 
Supervisor menu.

At this point, the Supervisor application is open, but you are not logged in 
to the CMS server. If you have not yet established connection settings to a 
CMS server, the system displays the Supervisor Controller and an open 
Options window, as shown below.  

Continue with “Establishing the connection” on page 5-4.

*Microsoft Windows is a trademark of Microsoft Corp.

1. Supervisor controller
2. Options icon
3. Login icon
4. Options window

4

2 3

1
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Establishing the connection 5

To establish connection settings to a CMS server, you must use the Options 
window. The Options window is displayed with the CMS Servers tab as the 
only active tab. 

To establish a connection:

1. Perform one of the following actions, depending on how you want to 
connect to the CMS server:
● If you want to connect manually, select the Manual Login check box.

● If you want to connect automatically, do not select the Manual Login 
check box.

2. Since this is a new connection, select New. 

The system displays the Server Properties window. 

3. Perform one of the following actions, depending on the type of connection 
that you want to establish:
● For a Network connection, continue with “Network” on 5-5.

● For a Serial connection, continue with “Serial on 5-7.

● For a Modem connection, continue with “Modem” on 5-8.
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Network 5

When you select New in the Options window, the system displays the Server 
Properties window with the Network connection selected, as shown in the 
following figure.

To establish a network connection:

1. In the Server Name text box, type the name of the server that you will be 
using. As you type it, the system displays the Server Name in the CMS 
Network Address text box.

2. In the Network Port: text box, use the default of 23 unless otherwise 
instructed by your system administrator.

1

2

3

2. Connection box
3. CMS Network Address: text box

1. Server Name text box
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3. Select OK. 

The system displays the CMS Servers tab folder with the options that you 
chose.

NOTE:
Besides New, the other options in the CMS Servers tab are as follows:
● Remove. Highlight the name of the server and select this option to 

remove the CMS server configuration that you entered previously. 
You will get a message asking if are sure you want to delete the 
server configuration. Select Yes or No.

● Properties. Highlight the name of the server and select this option to 
display the Server Properties window, where you can view or change 
the CMS server configuration properties. 

4. Select OK to accept the Network settings. You have to select a server from 
the list before you select OK.

The system displays the Supervisor Controller window. At this point you 
are still not logged in to the CMS server, but you have established 
connection settings to the CMS server. 

5. Continue with “Logging in to the CentreVu CMS server for the first time” 
on page 5-10.
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Serial 5

When you select New in the Options window, the system displays the Server 
Properties window with the Network connection selected. Select Serial in the 
Connection box and the system displays the window as shown in the following 
figure.

To establish a serial connection:

1. In the Connection box, select Serial.

2. In the Server Name text box, type the name of the server that you will be 
using.

3. In the Serial Settings box, enter all settings for the serial connection. Each 
setting has a list with various options as shown in the example above. See 
your CMS administrator for the appropriate serial settings.

4. When you finish entering the serial settings, select OK.

The system displays the CMS Servers tab.

5. Select OK to accept the serial settings.

The system displays the Supervisor Controller window. At this point you 
are still not logged in to the CMS server, but you have established 
connection settings to the CMS server. 

6. Continue with “Logging in to the CentreVu CMS server for the first time” 
on page 5-10.

Pull-down list
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Modem 5

When you select New in the Options window, the system displays the Server 
Properties window with the Network connection selected. Select Modem in 
the Connection box and the system displays the window as shown in the 
following figure:

To establish a modem connection:

1. In the Connection box, select Modem.

2. In the Server Name text box, type the name of the server that you will be 
using.

3. In the Phone Number text box, type the telephone number of the CMS 
server. If you do not know the telephone number, contact your CMS 
administrator.

4. In the Modem box, select the modem from the pull-down list of modems 
that are configured in Microsoft Windows.

5. Select OK. 

The CMS Servers tab displays.

Pull-down list
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6. Select OK to accept the modem settings.

The system displays the Supervisor Controller window. At this point you 
are still not logged in to the CMS server, but you have established 
connection settings to the CMS server. 

7. Continue with “Logging in to the CentreVu CMS server for the first time” 
on page 5-10.
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Logging in to the CentreVu CMS server for the 
first time 5

After you establish connection settings to the CMS server, you can log in to 
the CMS server by using the Connect menu or using the Login icon, as shown 
in the following figure.

To log in to the CMS server for the first time:

1. Use one of the following methods to log in to the CMS server:
● Select Login from the Connect menu.

● Click on the Login icon: .

Depending on how you established connection settings to the CMS server, 
one of two actions will occur:

● For an automatic login connection, the system displays the Login 
Information window. Continue with Step 3 through Step 6 in 
“Automatic login” on page 5-11.

● For a manual login connection, the system displays the Manual Login 
window. Continue with Step 2 through Step 4 in “Manual login” on 
page 5-12.

Connect menu Login Icon
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Logging into the CentreVu CMS server after 
first time 5

After you log in to Supervisor for the first time and establish your login ID and 
password, the login procedures change slightly. Follow the procedures below 
for automatic and manual login.

Automatic login 5

If the connection settings are established for automatic login, you will log in to 
the CMS server through the Automatic Login window. Now, each time that you 
open Supervisor, the system displays the Supervisor Controller window and the 
Login Information window.

To log into the CMS server using automatic login:

1. Double-click the Supervisor icon in its program group or on the desktop.

The system displays the Supervisor Controller window with the Login 
Information window in front of the Controller, as shown in the following 
figure:

2. From the CMS Server pull-down list, select the IP address of the CMS 
server.

3. Type your CMS login ID in the Login ID: text box, or choose it from the 
history list of IDs if it has been entered previously.

4. Press the Tab key to move to the Password: text box.

2. Login ID: text box
3. Password: text box
4. History list of Login IDs

1 2 3
1. CMS server: text box

4



  
 CentreVu Supervisor V9 Installation and Getting Started
Getting started with CentreVu Supervisor
Logging into the CentreVu CMS server after first time 5-12

5. Type your CMS password in the Password: text box.

6. Select OK.

The system displays a message box that indicates that Supervisor is 
connecting to the CMS server.

Once you connect to the CMS server, the system displays the Supervisor 
Controller window with the CMS operations that are available on the 
toolbar. The status line is active and the system displays two new menus, 
Commands and Scripts, in the menu bar.

NOTE:

For more information on the scripting feature, refer to Chapter 3, 

“Scripting,” in the CentreVu® CMS R3V9 Administration, 585-214-015.

See “Exploring the CentreVu Supervisor Controller” on page 5-19 for more 
information on using the Supervisor Controller window.

Manual login 5

If the connection settings are established for manual login, you will log in to the 
CMS server through the Manual Login window. Now, each time that you open 
Supervisor, the system displays the Supervisor Controller window and the 
Manual Login window.

NOTE:
The Manual Login window is not recommended for standard Solaris use, 
for example, it should not be used for editing files. The Manual Login 
window is not a Terminal Emulator.
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To log into the CMS server using manual login:

1. Double-click the Supervisor icon in its program group or on the desktop.

The system displays the Supervisor Controller window with the Manual 
Login window in front of the Controller, as shown in the following figure. 
At this time, you are not logged in to the CMS server.

2. In the Manual Login window, at the login: prompt, enter your CMS 
Login ID.

NOTE:

The system displays the prompts only after you enter information for the 
previous prompt. All prompts are shown in the example of the Manual 
Login window for convenience.

3. At the Password: prompt, enter your CMS password.
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4. Perform one of the following actions, depending on which prompt that the 
system displays:
● If the system displays the Enter Terminal Type: prompt, enter 

cvsup.

● If the system displays the Solaris system prompt, enter cms.

The system displays the Supervisor Controller window. 

Once you connect to the CMS server, the system displays the Supervisor 
Controller window with the CMS operations that are available on the 
toolbar. The status line is active and the system displays two new menus, 
Commands and Scripts, in the menu bar.

NOTE:

For more information on the scripting feature, refer to Chapter 3, 

“Scripting,” in the CentreVu® CMS R3V9 Administration, 585-214-015.

See “Exploring the CentreVu Supervisor Controller” on page 5-19 for more 
information on using the Supervisor Controller window.
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Logging off the CentreVu CMS server 5

You can log off the CMS server by using the Connect menu, using the Logout 
icon, or using the Exit icon.

To log off the CMS server:

1. Use one of the following methods to log off of the CMS server:
● Select Logout from the Connect menu.

● Click the Exit icon , or from the Connect menu, select Exit. 
This logs you out of the CMS server and out of Supervisor.

● Click on the Logout icon .

The system asks you to verify whether you want to log out:

2. Select Yes to log off the CMS server. 

If you selected Exit in Step 1, Supervisor logs you out of CMS and closes 
the application. 

If you selected Logout in Step 1, Supervisor logs you out of CMS but the 
Controller window remains open. See “When you are not logged in to the 
CentreVu CMS server” on page 5-19 for details.

3. Continue with “Exiting Supervisor” on page 5-16.

Connect menu
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Exiting Supervisor 5

To exit the Supervisor application:

1. From the Connect menu, select Exit.

If you have logged off the CMS server, Supervisor closes.

If you have not logged off the CMS server, the system displays the 
following message:

a. In response to the message, select one of the following:

● Yes. Supervisor automatically logs you off the CMS server and then 
exits from the application.

● No. You are returned to the Supervisor Controller window and 
remain logged in to the CMS server.
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Changing connection settings 5

To change connection settings to the CMS server:

NOTE:
You cannot be logged in to a CMS server when you change connection 
settings.

1. Open the Supervisor application. 

2. Perform one of the following actions, based on which type of login you 
use:
● If your connection to the CMS server is set for automatic login, select 

Cancel from the Login Information window to close it.

● If your connection to the CMS server is set for manual login, select 
Cancel from the Manual Login window to close it.

The system displays the Supervisor Controller window.

3. Open the Options window using one of the following methods:
● From the Tools menu, select Options....

● Click on the Options icon:

● From the Connect menu, select CMS Servers

The system displays the Options window with the CMS Servers tab folder 
open.
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4. In the CMS Servers tab folder, select Properties.

The system displays the Server Properties window. Notice that the Server 
Name is displayed and cannot be changed.

5. In the Connection box, click the type of connection you want, Network, 
Serial, or Modem.

NOTE:

See “Establishing the connection” on page 5-4 for information on entering 
serial and modem information.

6. Change any settings as needed.

7. Select OK to change the connection. 

The system displays the CMS Servers tab folder.



  
 CentreVu Supervisor V9 Installation and Getting Started
Getting started with CentreVu Supervisor
Exploring the CentreVu Supervisor Controller 5-19

Exploring the CentreVu Supervisor Controller 5

The following sections explain the different parts of the Supervisor Controller 
window as it is displayed when you are not logged in to the CMS server and 
when you are logged in to the CMS server.

When you are not logged in to the CentreVu CMS
server 5

This section describes the Supervisor Controller window as it is displayed when 
you are not logged in to the CMS server. The following figure illustrates the 
basic window:

System menu box 5

The system menu box is a common Microsoft Windows convention. Use the 
system menu box to perform common windows operations, such as closing the 
current window or application.

4

2
3

1

1. System menu box
2. Title bar
3. Maximize/minimize/close window sizing buttons
4. Status bar
5. Toolbar
6. Menu bar
7. Login status indicator

5 6 7
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Title Bar 5

The title bar is a common Microsoft Windows convention. It shows the name of 
the application.

Toolbar 5

The toolbar contains buttons that are used for quick access to specific features 
of the application. When you are not logged in to the CMS server, the two 
buttons available on the toolbar are as follows:

When you move your cursor over a toolbar button, the system displays a brief 
description of the command that the button performs. The system also displays 
a brief description of the command on the status bar.

Maximize, minimize, and close buttons 5

The maximize, minimize, and close buttons are a common Microsoft Windows 
convention. They adjust the size of the window or close the window.

Status bar 5

The status bar is located at the bottom of the Supervisor Controller window. It 
displays a brief description of each of the toolbar buttons when you move the 
cursor over the button. The status bar also includes a Login Status Indicator. 
This indicator shows a green light if you are currently logged in to the CMS 
server, or shows a gray light if you are not logged in to the CMS server.

Button Name Command

Options Accesses the window needed to change your 
login options. 

Login Initiates a connection to the CMS server.



  
 CentreVu Supervisor V9 Installation and Getting Started
Getting started with CentreVu Supervisor
Exploring the CentreVu Supervisor Controller 5-21

Menu bar 5

The menu bar is a common Microsoft Windows convention that lists the 
available menus. When you are not logged in to the CMS server, the following 
menus are available:

Connect

Tools

Help

The following sections outline the options available from each menu.

Connect menu 5

From the Connect menu, you can initiate or discontinue a connection to the 
CMS server. The Connect menu has the options that are shown in the following 
figure and described in the following table:

Menu item Action

Login Selecting Login from the Connect menu displays the 
Manual Login window if the Manual Login Option is set, 
and displays items in the Automatic Login window if the 
Manual Login Option is not set.

CMS 
Servers

(No Icon)

Selecting CMS Servers from the Connect menu opens the 
CMS Service tab in the Options window. When you are not 
logged in to the CMS server, the CMS Service tab allows 
you to select network, serial, and modem settings.

Exit

(No Icon)

Selecting Exit from the Connect menu closes the 
Supervisor application.
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Tools menu 5

The Tools menu has the options that are shown in the following figure and 
described in the following table:

Help 5

You can access Supervisor online help from all windows by doing any of the 
following:
● Pressing F1 (Help) displays help that is specific to the current window.

● Selecting the Help button (if available) displays help that is specific to the 
current window.

● Selecting Help from the menu bar (shown below) offers you the options 
that are shown in the following figure an described in the following table:

Menu item Action

Options... Selecting Options from the Tools menu or selecting the 
Options button on the toolbar, opens the Options window. 
When you are not logged in to the CMS server, you can set 
standard Supervisor communications options in the Options 
window. 

Advanced...

(No Icon)

Selecting Advanced... from the Tools menu opens the 
Advanced window. This menu item is used for debugging 
purposes. Do not change the settings on the Advanced 
window unless you are instructed to do so by Avaya.



  
 CentreVu Supervisor V9 Installation and Getting Started
Getting started with CentreVu Supervisor
Exploring the CentreVu Supervisor Controller 5-23

A style of help that is called “What’s This?” is available in some windows. 
When you select the  icon on a title bar, the system displays a Help topic 
with information about the area of the window to which the mouse cursor is 
pointing. You can also click the right mouse button when the cursor is pointing 
to an area on the window and select the “What’s this?” item that is displayed.

Menu item Action

Contents Selecting Contents opens the Supervisor online 
help table of contents.

Technical Support Selecting Technical Support opens a window that 
provides Technical Support information.

About CentreVu 
Supervisor

Selecting About CentreVu Supervisor opens the 
Supervisor Help About window, which shows the 
software version number.
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When you are logged in to the CentreVu CMS
server 5

This section describes the Supervisor Controller window as it is displayed when 
you are logged in to the CMS server. The following figure illustrates the basic 
window:

NOTE:
The system menu box, title bar, and maximize and minimize buttons are 
not defined below because they work the same when you are logged in to 
the CMS server as they do when you are not logged in to the server. See 
“When you are not logged in to the CentreVu CMS server” on page 5-19 
for information on these components.

Depending on what your CMS user permissions are, some menu items and 
toolbar buttons may not be accessible. 

1. Title bar 
2. Menu bar
3. Toolbar
4. Status line
5 . Login status indicator

6 . Exception count
7. ACD status indicator(s)
8. CMS date and time
9. Minimize button
10. Maximize button

1 3

4
7 8 9 10

5 6

2
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Toolbar 5

The toolbar contains buttons that are used for quick access to specific CMS 
commands and tools. Based on your CMS user permissions, the system displays 
some or all of the following buttons on your toolbar when you are logged in to 
CMS.

When you move your cursor over a toolbar button, the status bar gives a 
description of what the toolbar button does.

Button Name Command

Options Accesses the window that is needed to change 
your environment options. 

Logout Disconnects you from the CMS server.

Reports Initiates the Reports command.

Dictionary Initiates the Dictionary command.

Exceptions Initiates the Exceptions command.

Agent 
Administration

Initiates the Agent Administration command.

Call Center 
Administration

Initiates the Call Center Administration 
command.
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Status bar 5

The status bar is located at the bottom of the window and is used to display 
CMS application status. It is also used to display a brief description of each of 
the toolbar buttons when the mouse pointer is over the button. 
● Login status indicator. Shows a green light if you are connected to the 

CMS server. Shows a gray light if you are disconnected from the CMS 
server.

● Exception count. Gives you the current count of exceptions for all ACDs 
for which you have exception permissions. The exceptions count is cleared 
to zero at the beginning of the interval. For information on CMS 
exceptions, see CentreVu® CMS R3V9 Administration, 585-214-015.

Report Wizard Initiates the Report Wizard command.

CMS System 
Setup

Initiates the CMS System Setup tool.

Maintenance Initiates the Maintenance tool.

User 
Permissions

Initiates the User Permissions tool.

Exit Logs you out of CMS and closes the 
Supervisor application. The system displays a 
message box that notifies you that you are 
logged in and asks if you want to continue the 
exit.

Button Name Command
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● ACD status indicators. Shows which ACDs are active or inactive. There 
can be up to eight ACD icons showing, depending on how many ACDs this 
CMS supports. If you place your mouse over the ACD status indicator, the 
current ACD is displayed in the status bar. There are two variations of 
ACD status indicators, as follows:

— If the link to any one of the ACDs is not functioning, the icon is 
crossed out. 

— If there is a TCP/IP connection between the switch and CMS, the ACD 
icon contains a bar. This means that CMS and the switch are not fully 
communicating at this time. This is a transitory state. 

● Current date and time. Shows the current date and time of the CMS 
server that you are logged in to.

Menu bar 5

The menu bar lists the available menus. When you are logged in to the CMS 
server, five menus are available on the menu bar:
● Connect

● Commands

● Tools

● Scripts

● Help.

NOTE:
The Commands menu is available only when you are logged in to the 
CMS server. All of the options on the Commands menu are specific to 
CMS.

The following sections describe the options that are available on each menu.



  
 CentreVu Supervisor V9 Installation and Getting Started
Getting started with CentreVu Supervisor
Exploring the CentreVu Supervisor Controller 5-28

Connect 5

From the Connect menu, you can initiate or discontinue a connection to the 
CMS server. The Connect menu has the options that are shown in the following 
figure and described in the following table:  

Menu item Action

Logout Selecting Logout from the Connect menu or the Logout 
button on the toolbar allows you to log out of the CMS 
server. When you select Logout, the system displays a 
message box that confirms the logout request. If you select 
OK, the logout sequence begins. Once the logout is 
complete, Supervisor is still open but you are not connected 
to the CMS server.

Exit Selecting Exit from the Connect menu closes the 
Supervisor application. If you are logged in to the CMS 
server when you select Exit, the system displays a message 
box that notifies you that you are logged in and asks if you 
want to continue the exit. If you select Yes, you are 
automatically logged out of the CMS server and Supervisor 
is closed. If you select No, the exit is cancelled and you are 
returned to the Supervisor Controller window, but you are 
still logged in to the CMS server.
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Commands 5

The Commands menu gives you access to the Reports, Dictionary, 
Exceptions, Agent Administration, and Call Center Administration 
subsystems in CMS. It also gives you access to the Report Wizard. These 
options are shown in the following figure and described in the following table:   

Menu Item Action

Reports When you select Reports from the Commands menu or 
select the Reports button on the toolbar, the system 
displays the Reports selector window. The following tabs 
are available:

● Real-Time

● Historical

● Integrated

Any Custom Reports that you create are ported to 
Supervisor. You can view and print the reports in 
Supervisor. To edit the reports, or create new ones, use the 
CentreVu Terminal Emulator or a CMS terminal.

From the Reports command, you can view, print, and 
export data from all of the standard CMS reports, Custom 
CMS reports, Supervisor Integrated and Graphical reports, 
and Report Designer reports.
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Dictionary When you select Dictionary from the Commands menu 
or select the Dictionary button on the toolbar, the system 
displays the Dictionary selector window. The following 
tabs are available:

● Operations

● Reports

From the Dictionary command, you can:

● Assign names to splits/skills, trunk groups, call work 
codes, reason codes, ACDs, VDNs and vectors

● Enter and edit agent names and agent groups

● View and define CMS database items and calculations

● Modify split/skill and trunk string values

Exceptions When you select Exceptions from the Commands menu 
or select the Exceptions button on the toolbar, the system 
displays the Exceptions selector window. The following 
tabs are available:

● Operations

● Reports

From the Exceptions command, you can administer 
timing-based or counting-based thresholds for exceptions 
and report on those exceptions.

Menu Item Action
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Agent 
Administration

When you select Agent Administration from the 
Commands menu or select the Agent Administration 
button on the toolbar, the system displays the Agent 
Administration selector window. The following tabs are 
available:

● Operations

● Reports

From the Agent Administration command, you can view, 
add, delete, or modify Agent-related parameters on the 
switch, such as Change Agent Skills.

Call Center 
Administration

When you select Call Center Administration from the 
Commands menu or select the Call Center button on the 
toolbar, the system displays the Call Center selector 
window. The following tabs are available:

● Operations

● Reports

From the Call Center command, you can:

● View, add, delete, or modify call work codes

● Change VDN skill preferences

● Set up split/skill and VDN call profiles

● Make trunk and VDN group assignments

Menu Item Action
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Tools 5

The Tools menu, gives you access to the Options window and the Add Button 
and Remove Button wizards. It also gives you access to the CMS System 
Setup, Maintenance, and User Permissions subsystems. These options are 
shown in the following figure and described in the following table:

Report 
Wizard

When you select Report Wizard from the Commands 
menu or select the Report Wizard button on the toolbar, the 
system displays the Report Wizard window.

The wizard guides you through a series of tasks that create 
a new customized report. Report Wizard is a supplement to 
Report Designer.

For more information about the Report Designer, see 
CentreVu® Report Designer Version 9 User Guide, 585-
210-930, or select Help in any Report Designer or Report 
Wizard window.

Menu Item Action
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Menu item Action

Options... When you select Options from the Tools menu or select 
the Options button on the toolbar, the system displays the 
Options window. You can set standard Supervisor 
preferences in the Options window. The following tabs 
are available:

● General

● Report Colors

● Threshold Colors

● Name Format

● Scripting

NOTE:
Selecting the Scripting tab in the Options window lets you 
log script execution as minimum, normal, or maximum. 
This window also lets you select a default script owner for 
automatic scripts. You can also specify a name for the log 
file and view the contents of the log file.

Advanced... This menu item is used for debugging. Do not change the 
settings on the Advanced window unless you are 
instructed to do so by an Avaya associate.

Add Button Selecting the Add Button tool starts the Add Button 
wizard, which guides you through the process of creating a 
button and adding it to the toolbar.

Remove 
Button...

Selecting the Remove Button tool displays a window that 
tells you how to remove a button from the toolbar.
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System Setup When you select System Setup from the Tools menu or 
select the CMS System Setup button on the toolbar, the 
system displays the CMS System Setup window. The 
Operations tab is available on the CMS System Setup 
window.

From CMS System Setup you can view and modify 
information about how the CMS and switch were 
configured during installation.

Maintenance When you select Maintenance from the Tools menu or 
select the Maintenance button on the toolbar, the system 
displays the Maintenance window. The following tabs are 
available:

● Operations

● Reports

Use the Maintenance window to perform routine 
maintenance of the CMS, including backing up data, 
checking on the status of the connection to the switch, and 
scanning the error log.

User 
Permissions

When you select User Permissions from the Tools menu 
or select the User Permissions button on the toolbar, the 
system displays the User Permissions window. The 
Operations is available on the User Permissions window.

The CMS administrator uses the User Permissions 
window to define CMS user IDs and access capabilities 
for each user.

Menu item Action
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Scripts 5

The Scripts menu gives you access to the Organize Scripts window which 
displays all logged-in user’s scripts and script folders. The Scripts menu is 
shown in the following figure:

You can perform the following functions in the Organize Scripts window:
● List script names, or show details regarding list size, type, and date 

modified

● Add a new folder

● Move a script

● Delete a script

● Rename the script

NOTE:
Scripts are a replacement for Bookmarks. For more information, see 

CentreVu® CMS R3V9 Administration, 585-214-015.
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The following figure shows an example of the Organize Scripts:

Help 5

The Help menu is the same when you are logged in to the CMS as it is when 
you are not connected. See “Help” on page 5-22 for details on using the online 
Help in Supervisor.
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Using the system tray icon 5

The Supervisor icon resides in the system tray while the application is 
running. 

You can use the system tray icon in the following ways:
● Threshold highlights. When a real-time report threshold highlight 

caution or warning condition is met, the system tray icon changes to the 
Caution or Warning icon, as appropriate.

● Open windows. Select the system tray icon to display a list of all of the 
Supervisor windows that are open. You can then select a window from the 
list to make it the current window.

NOTE:

If a report threshold highlight caution or warning condition has been met, 
the Caution or Warning icon (as appropriate) displays next to the listed 
reports that are affected by that condition.

Depending on the state that is shown by the system tray icon, one of the 
following things happens when you double-click on the icon:
● If the Supervisor icon is shown, the Supervisor Controller window 

becomes the current window.

● If the Caution icon is shown, all reports that are currently running with a 
caution condition are brought to the front.

● If the Warning icon is shown, all reports that are currently running with a 
warning condition are brought to the front.

You can control the sort order of the system tray icon menu and turn the 
feature on and off by selecting the option on the General tab that is accessed 
by choosing Options from the Tools menu. For more information, see 
CentreVu® CMS R3V9 Administration, 585-214-015.
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Using Supervisor menus 5

Supervisor menu items can be selected by performing any of the following 
actions: 
● Clicking on the item.

● Using the arrow keys to highlight the item and then pressing Return.

● Using the assigned Microsoft Windows keyboard access characters or 
accelerator keys (hold down the Alt or Ctrl key and press the letter that is 
underlined in the word that you want to select).
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Using Supervisor selector windows 5

A selector window is the window that the system displays after you select an 
item from the Commands or Tools menu. The following figure shows an 
example of a selector window:

Tab folders 5

Typically, there are two tabs, Operations and Reports, on any Commands or 
Tools selector window. The exceptions to this are the Commands | Reports 
selector window, which has Real-Time, Historical, and Integrated tabs and the 
Tools | Options window, which has General, Report Colors, Threshold Colors, 
Name Format, Controller, and Scripting tabs.

Select the appropriate tab to bring that folder to the front.

1

2

1. Tab folders
2. Available windows
3. Current ACD
4. Script... button
5. OK, Cancel, Help (and Apply) buttons 

3

4
5
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Available windows 5

Use the up-arrow and down-arrow keys or the mouse to highlight an item from 
the list of available windows and then select OK to open that window. The list 
of available windows is usually a list of Operations windows or a list of Reports 
windows.

Current ACD 5

The ACD: box shows the ACD that is currently selected.

Script... button 5

Scripts are tags that you can use to easily access operations and reports that you 
use often.

To create a script for a report or operation: 

1. Highlight the item in the selector box.

2. Select the Script... button. 

The system displays the Save as Script window.

For more information on using the Scripting feature, see CentreVu® CMS R3V9 
Administration, 585-214-015.

OK, Apply, Cancel, and Help buttons 5

The OK, Apply, Cancel, and Help buttons that are on Supervisor windows 
perform standard Microsoft Windows actions:
● OK. Accepts the current input and continues to the next window.

● Apply. Accepts the current input but does not continue to the next window 
(or return to the previous window).

● Cancel. Cancels the current input and returns you to the previous window.

● Help. Opens the help topic that is specific to this window.
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Completing input windows 5

Once you select an operation or report, the system displays an input window. 
The information that is required on the input window depends on what you are 
doing in the system. The following figure shows an example of an input 
window.

Input windows have all or some of the following items:
● Menu bar. Includes menus for CMS Actions (Add, Delete, Find One, 

Next, Previous, List All, and Exit), Edit options (Cut, Copy, Paste, and 
Clear All), and Supervisor Help.

● Toolbar action buttons. Make it possible to perform CMS actions (Add, 
Delete, Find One, Next, Previous, List All, and Exit) by clicking a button. 
See Chapter 6, “Performing CentreVu CMS Operations,” for more 
information on the action buttons.

● Input fields. Provide text boxes where you type in or select the 
information that is needed to complete the CMS action.

● History list. Displays a list of inputs you have previously used in the 
input field.

t

1. Menu bar
2. Toolbar action(s)
3. Input field(s)
4. Browse button
5. History list
6. Current ACD

1

2

3
4

5

6
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● Browse button. Provides a list of all possible items for the input field from 
which you can then select one or more items as input. See “Using the 
browse button” on page 5-44 for more information. Also see “Selecting 
report run dates” on page 7-7 and “Selecting report run times” on page 
7-10.

● Current ACD. Displays the ACD on which you are working.
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Completing input fields 5

The following figure shows an example of an input window. The items that are 
related to completing input windows are labeled.

To complete an input field, do one of the following:
● Type in the information that is requested.

● Select the information from the history list of previously used items.

NOTE:
During each CMS session, Supervisor recalls the items that you 
previously selected for each input field. If an input field has an associated 
history list, you can use the history list to select an item for the input 
field.

● Use the Browse button to view all of the available items for the input 
field, and then select one or more items as input. Also see “Selecting 
report run dates” on page 7-7 and “Selecting report run times” on page 
7-10.

1 321. Input field(s)
2. History list
3. Browse button
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Using the browse button 5

When you select the Browse button, the system displays a window that lets you 
can use to select items for the input field. The browse selection window is 
different depending on whether the input is for a single entity or for multiple 
entries of the entity.

Single entity input 5

If the input is for a single entity (split/skill, vector, agent, VDN, trunk, or trunk 
group), the system displays a Browse window that is similar to the following 
example: 

To use the Browse window:

1. In the list, highlight the name or number of the entity with which you want 
to work.

2. Select OK.

The system displays the input window. The input field is populated with 
the name or number of the entity that you selected in the Browse window.
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Multiple entries input 5

If the input allows for multiple entries of the entity (split/skill, vector, agent, 
VDN, trunk, or trunk group), the system displays a Browse window that is 
similar to the following example:

To use the Browse window:

1. In the Choices box, perform one of the following actions:
● Highlight the names or numbers of the entities with which you want to 

work

● Select a range of entity numbers

To select a range:

a. Select the Range of... option.

b. In the First: text box, type the beginning entity number for the 
range.

c. Press the Tab key to move to the to Last: text box.

d. In the to Last: text box, type the ending entity number for the 
range.
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NOTE:

For example, if your call center has skills 1, 2, 3, 4, and 5 and you want to 
select all of them, type 1 in the First: text box and type 5 in the to Last: text 
box.
● Use a combination of highlighting names or numbers in the list and 

selecting a range of entity numbers.

2. Select Add>>. 

The entities that were highlighted in the Choices box are now listed in the 
Selected ... box.

3. Select OK.

The system displays the input window and the input field is populated with 
the names or numbers of the entities that you selected.
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Using the history list 5

There is a drop-down history list on the right of each entity text box. This 
history list shows values that you have entered previously in this field.

To use the history list to select the entity that you want to include for the report 
or operation that you are running:

1. Place the cursor in the text box.

2. Select the drop-down button.

3. Click the item that you want to add to the input field.

The system closes the history list and the item is added to the text box.

1 32
1. Input field(s)
2. Drop-down button
3. Browse button
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Closing Supervisor windows 5

To close Supervisor windows, use any of the standard Microsoft Windows-
based methods. You can also select Exit from the Connect menu to close all 
windows and quit the Supervisor application.

If the CMS server shuts down or is being changed to single-user mode, 
Supervisor displays a warning message and then any open windows are closed. 
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Overview 6

This chapter provides information about the menus and inputs that you use to 
perform CentreVu Call Management System (CMS) operations in CentreVu 
Supervisor (Supervisor). This chapter includes the following sections:
● “Running an operation” on page 6-3

● “Operations menus” on page 6-6

● “Adding items to the CMS database” on page 6-11

● “Finding items in the CMS database” on page 6-12

● “Modifying items in the CMS database” on page 6-14

● “Deleting items from the CMS database” on page 6-16
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This chapter gives you general information about how to use the windows that 
you access from the Supervisor Operations tabs. The Operations tabs are 
available under the following commands and tools:
● Commands > Dictionary

● Commands > Exceptions

● Commands > Agent Administration

● Commands > Call Center Administration

● Tools > System Setup

● Tools > Maintenance

● Tools > User Permissions

No matter which command or tool you use to select an operation, how you 
perform the operation is the same.

NOTE:
Additional information that is specific to each Operations tab (that is, 
Dictionary, Exceptions, Agent Administration, Call Center 
Administration, System Setup, Maintenance, or User Permissions), 

can be found in CentreVu® CMS R3V9 Administration, 585-214-015.
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Running an operation 6

To run an operation:

1. From the Commands or Tools menu, select one of the following options:
● Dictionary

● Exceptions

● Agent Administration

● Call Center Administration

● System Setup

● Maintenance

● User Permissions

The system displays the Operations list box for the application that you 
selected. In the following example, Dictionary was selected.

2. Select an operation from the Operations list box.



  
 CentreVu Supervisor V9 Installation and Getting Started
Performing CentreVu CMS operations
Running an operation 6-4

3. From the ACD drop-down list, select the ACD for which you want to 
perform the operation, as shown in the following figure:

4. Select OK.

5. The system displays the operation input window. The inputs that are 
required vary, depending on which operation you are running. 

6. Complete the operation input window. 

The following example from the Commands > Call Center 
Administration > Operations tab shows the possible types of information 
that might be required to complete an operation input window.

7. Fill in the input fields. Input fields are where you specify the information 
that you want to view, add, modify, or delete. Use any of the following 
methods:
● Type in the name or number of the input that is requested.

● Use the history list to select an input that you have previously used.

● Select the Browse button to view all of the available inputs and then 
select one.

1. Input field(s)
2. History list
3. Browse button

1 32
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8. Perform one of the following actions, depending on the ACD for which 
you want to perform the operation:
● If you want to perform the operation for the ACD that is currently 

selected, that is, the one that is displayed at the bottom of the input 
window, continue with Step 9.

● If you want to perform the operation for an ACD other than the one 
that is currently selected, that is, the one that is displayed at the bottom 
of the input window, perform the following Steps a through d. 

a. Go to the selector window you chose in Step 1.

b. Change the ACD on the selector window.

c. Select the operation you want to perform.

d. Select OK.

The system displays the input window again and the input fields are 
populated with any inputs that you previously entered.

9. Select OK.

The system runs the operation.
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Operations menus 6

The Actions and Edit menu options are commonly found on windows that you 
access from the Operations tab. 

Actions menu 6

The Actions menu is found in the Dictionary, Exceptions, Agent 
Administration, Call Center Administration, Maintenance, System Setup, 
and User Permission operations windows. Actions are used to perform CMS-
related functions. The following figure shows what the menu bar looks like 
when the Actions menu item is available:

This menu contains all of the CMS actions that are available in the current 
window. The menu items and their associated buttons on the toolbar are in the 
same order. For example, Add, Delete and Modify are grouped together, as are 
Find One, Previous, Next, and List All. Exit is always last on the menu and 
the last button on the toolbar.

The following table lists the Actions menu items, their associated buttons, and a 
definition of each action. Not all of the actions are available to you all of the 
time. If an action is not available in the current window, it is displayed in gray 
on the Actions menu and it does not appear on the toolbar.
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Action Button Description

Add Adds the data that you entered in the current 
window to the database.

Cancel Cancels the operation that is in progress.

Copy Group/ 
Create

Creates a new group from an existing one.

Delete Removes the entry on your current window 
from the CMS database.

Exit Exits the window and other associated 
windows.

Find one Searches the database for entries that match the 
input values in the current window.

Get contents Provides access to the members of the agent 
group.

List all Lists all of the entries that matched the current 
field values.

List Devices Lists all the devices that are specified in the 
Backup/Restore Devices window.

Modify Changes the database entry to reflect the new 
values that are entered in the current window.

Next If you have used the Find One function, the 
Next button displays the next match that is 
found. Otherwise, this button is not available.

Previous If you have used the Find One function, the 
Previous button displays the previous match 
that is found. Otherwise, this button is not 
available.
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Run/Start Starts the process for your current window.

Script... (No 
icon)

Displays the Save as Script - Action window. 
Use this window to enter information in the 
appropriate fields, and then select the Add, 
Modify, or Delete action, and save it as a script. 
If Add, Modify, or Delete are not present, the 
Save as Script menu item is not present.

Select tables Allows you to select specific tables to back up 
or restore.

Action Button Description
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Edit menu 6

The Edit menu is found on all Dictionary, Exceptions, Maintenance, System 
Setup, and User Permissions operations windows. Edit options are used to 
perform functions that are related to Microsoft Windows*. The following figure 
shows what the menu bar looks like when the Edit menu item is available:

The following table lists the options on the Edit menu:

*Microsoft Windows is a trademark of Microsoft Corp.

Menu item Shortcut Action

Cut Ctrl + X A standard feature of Microsoft Windows that 
removes selected text or graphics and places 
the items on the clipboard. This item is 
available on windows that have input fields 
and on List All windows.
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Copy Ctrl + C A standard feature of Microsoft Windows that 
copies the image of the currently selected 
chart, text, or cell to the clipboard in Microsoft 
Windows metafile format (*.wmf). This makes 
it possible for you to paste the item into any 
Microsoft Windows application that supports 
the Copy and Paste commands, such as a word 
processor. This item is available when text is 
selected in the window or the cell is selected in 
a List All window. You can also access the 
Copy command from menu that is displayed 
when you click the button on the right-side of 
the mouse.

Paste Ctrl + V A standard feature of Microsoft Windows that 
inserts a copy of the contents of the clipboard 
at the insertion point or replaces the selection 
(if any) with the text on the clipboard. This 
item is available only on windows that have 
input fields and when the clipboard is not 
empty.

Clear all Ctrl + E A feature that is available only on windows 
that have input fields. This item clears all of 
the values that are entered in the input fields 
and resets option buttons to their default value.

Menu item Shortcut Action
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Adding items to the CMS database 6

After you select an operation, the system displays an input window. You can use 
this input window to add an item to the CMS, such as an agent group, a CMS 
user ID, or agent login IDs. 

To add items from an operations input window:

1. Fill in the information that is required in the input fields.

2. Use one of the following methods to activate the Add action:
● From the Actions menu, select Add 

● Select the Add button  on the toolbar

● Press Ctrl+A

If the item was added successfully, the system displays the word 
“Successful” in the status bar at the bottom of the window.

If you do not have the required write permissions to add the item, the 
system displays the word “Failed” in the status bar at the bottom of the 
window and then displays an error message.
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Finding items in the CMS database 6

After you select an operation, the system displays an input window. If you want 
to work with an item in the CMS, such as an agent group, a CMS user ID, or 
agent login IDs, but do not recall how that entity is named or specific details 
about the entity, select List all or Find one from the Actions menu.

List all 6

Use the List all command when you do not recall any of the specific 
information about an entity, or when you want to list all of the entities of a 
specific type to see if any already exist that meet your needs. 

To list all of the items that are related to an operations window:

1. Perform one of the following actions, depending how specific you want the 
list of items to be:
● Leave the text boxes on the input window blank to list all of this type 

of entity that exist on the CMS

● Complete specific text boxes to refine the list to a specific range of 
output.

2. Use one of the following methods to activate the List all action:
● From the Actions menu, select List all 

● Select the List all button  on the toolbar

● Press Ctrl+L

The system displays a list of all of the items that match the criteria on the 
input window.
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Find one 6

Use Find one when you know some or all of the information that is specific to 
an entity, or when you want to list all of the entities of a specific type, one by 
one. 

To find one entity at a time:

1. Complete all or some of the text boxes on the input window to try to find a 
match, or leave the text boxes blank to list, one-by-one, all of this type of 
entity that exist on the CMS.

This is your find criteria.

2. Use one of the following methods to activate the Find one action:
● From the Actions menu, select Find one 

● Select the Find one button  on the toolbar

● Press Ctrl+F

The text boxes are completed with information related to the first entity 
that matches the find criteria for which you have permissions.

If there is more than one match, the status bar reads “xx matches found”, 
where xx is the number of matches found.

3. Use one of the following methods to scroll through the Find one matches:
● From the Actions menu, select Next and Previous

● Select the Next button  or the Previous button  on the toolbar

● Pressing the F3 key (Next) or the Shift+F3 key (Previous)

You can also search on partial strings (for example, ac) if the input field is not 
labeled with an “(s)”. For example, you cannot use the wild cards * or ? to 
search for strings in any entity name input fields that are labeled with “(s)”, 
such as Split(s).

NOTE:
For more information on the List all and Find one commands, see 

CentreVu® CMS R3V9 Administration, 585-214-015.
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Modifying items in the CMS database 6

After you select a category from the Operations tab, the system displays an 
input window. If you want to modify the information for an item that already 
exists in the CMS database, such as an agent group, a CMS user ID, or agent 
login IDs, complete the following steps:

! CAUTION:
If you leave any fields blank and select the Modify command, any data that is 
currently stored in those blank fields is erased from the CMS database.

1. Perform one of the following actions, depending on the amount of 
information you know about the item that you want to modify:
● If you know all or part of the specific information that is required for 

the input text boxes:

a. Complete all or some of the text boxes on the input window to 
try to find a match, or leave the text boxes blank to list, one-
by-one, all of this type of entity that exist on the CMS.

This is your find criteria.

b. Use one of the following methods to activate the Find one action:

— From the Actions menu, select Find one 

— Select the Find one button  on the toolbar

— Press Ctrl+F

● If you do not know the specific information that is required for the 
input text boxes:

a. Use one of the following methods to activate the List all 
action:

— From the Actions menu, select List all 

— Select the List all button  on the toolbar

— Press Ctrl+L

b. Locate the information for the entity that you want to modify and 
note the relevant information.
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c. Close the List all window. 

The system displays the input window.

d. Complete the text boxes for which you have information.

e. Use one of the following methods to activate the Find one action:

— From the Actions menu, select Find one 

— Select the Find one button  on the toolbar

— Press Ctrl+F

2. Update the information in the text boxes.

3. Use one of the following methods to activate the Modify action:
● From the Actions menu, select Modify 

● Select the Modify button  on the toolbar

● Press Ctrl+M

If the item was modified successfully, the system displays the word 
“Successful” in the status bar at the bottom of the window.

If you do not have the required write permissions to modify the item, the 
system displays the word “Failed” in the status bar at the bottom of the 
window and then displays an error message.

NOTE:

If you try to modify a database entry that does not yet exist in the CMS, the 
status bar reads, “Does not exist,” and you need to follow the instructions 
in “Adding items to the CMS database” on page 6-11 to add the item to the 
database. 
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Deleting items from the CMS database 6

After you select an operation from the Operations tab, the system displays an 
input window. If you want to delete the information for an item that already 
exists in the CMS, such as an agent group, a CMS user ID, or agent login IDs, 
complete the following steps:

! CAUTION:
The system does not display a warning message when you select Delete. The 
item that you specify is automatically be deleted from the CMS database.

1. Perform one of the following actions, depending on the amount of 
information you know about the item that you want to modify:
● If you know all or part of the specific information that is required for 

the input text boxes:

a. Complete all or some of the text boxes on the input window to 
try to find a match, or leave the text boxes blank to list, one-
by-one, all of this type of entity that exist on the CMS.

This is your find criteria.

b. Use one of the following methods to activate the Find one action:

— From the Actions menu, select Find one 

— Select the Find one button  on the toolbar

— Press Ctrl+F

● If you do not know the specific information that is required for the 
input text boxes:

a. Use one of the following methods to activate the List all 
action:

— From the Actions menu, select List all 

— Select the List all button  on the toolbar

— Press Ctrl+L

b. Locate the information for the entity that you want to modify and 
note the relevant information.



  
 CentreVu Supervisor V9 Installation and Getting Started
Performing CentreVu CMS operations
Deleting items from the CMS database 6-17

c. Close the List all window. 

The system displays the input window.

d. Complete the text boxes for which you have information.

e. Use one of the following methods to activate the Find one action:

— From the Actions menu, select Find one 

— Select the Find one button  on the toolbar

— Press Ctrl+F

2. Use one of the following methods to activate the Delete action:

— From the Actions menu, select Delete 

— Select the Delete button  on the toolbar

— Press Ctrl+D

If the item was deleted successfully, the system displays the word 
“Successful” in the status bar at the bottom of the window.

If you do not have the required write permissions to delete the item, the 
system displays the word “Failed” in the status bar at the bottom of the 
window and then displays an error message.

If the item does not exist in the CMS database the system displays “Does 
not exist” in the status bar.



  
 CentreVu Supervisor V9 Installation and Getting Started
Performing CentreVu CMS operations
Deleting items from the CMS database 6-18



   CentreVu Supervisor V9 Installation and Getting Started
Using CentreVu Supervisor reports
Overview 7-1

CentreVu
Supervisor

Using CentreVu 
Supervisor reports 7

Overview 7

The reports that are produced by the CentreVu Call Management System 
(CMS) display in CentreVu Supervisor (Supervisor). These reports display, 
report, and summarize the performance of any measured subset of the ACD, 
including agents, splits/skills, trunks, trunk groups, VDNs, and vectors.

This chapter provides information on how to display CMS reports in 
Supervisor. This chapter includes the following sections:
● “Running a report” on page 7-3

● “Selecting report run dates” on page 7-7

● “Selecting report run times” on page 7-10

● “Report menu bar” on page 7-11

● “Report layouts” on page 7-21

● “Formatting table reports” on page 7-24

● “Formatting chart reports” on page 7-28

● “Minimizing report output windows” on page 7-39

● “Using right mouse button menus” on page 7-42

● “Rotating a three-dimensional chart” on page 7-46
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● “Exporting report data” on page 7-47

● “Copying chart reports” on page 7-50

● “Resizing report windows” on page 7-51

● “Changing column widths” on page 7-52

● “Selecting a printer” on page 7-53

● “Using Page Setup” on page 7-54

● “Setting report threshold highlights” on page 7-56

● “Report Options” on page 7-74

● “Exiting and restarting reports” on page 7-89

Report menus and tabs 7

The way you select, run, edit, and view a report is the same, no matter where 
you run it from. Reports are available from the following menus and tabs:
● Commands > Reports > Real-Time, Historical, or Integrated tab

● Commands > Dictionary > Reports tab

● Commands > Exceptions > Reports tab

● Commands > Agent Administration > Reports tab

● Commands >Call Center Administration > Reports tab

● Commands >Report Wizard

● Tools > Maintenance > Reports tab

NOTE:
Additional information that is specific to each Commands or Tools menu 
option can be found in CentreVu® CMS R3V9 Administration, 585-214-
015.
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Running a report 7

To run a CMS report in Supervisor:

1. In the Supervisor Controller toolbar, select Commands to display the 
Commands menu.

2. Select one of the following options:
● Commands > Reports > Real-Time, Historical, or Integrated tab

● Commands > Dictionary > Reports tab

● Commands > Exceptions > Reports tab

● Commands > Agent Administration > Reports tab

● Commands > Call Center Administration > Reports tab

● Tools > Maintenance > Reports tab

NOTE:
If you have Report Designer and want to quickly and easily generate a 

new customized report, select the Report Wizard  button in the 

Controller toolbar. For more information about the Report Designer, see 
the CentreVu® Report Designer Version 9 User Guide, 585-210-930. 
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The system displays the Report Selector window. The following figure shows 
an example of the Report Selector window. The tabs in this window will vary, 
depending on which option you chose from the Commands or Tools menu.

3. Select a category from the Category list.

4. Select a report from the Report list.

5. Use the drop-down menu to select the ACD for which you want to run the 
report from the Run Report for ACD text box.

6. Perform one of the following actions, depending on whether or not you 
want to schedule a script:
● If you do not want to schedule a script, continue with Step 7.

● If you want to schedule the selected report to run at a certain time, 
select the Script button. 

The Script button displays the Save as Script window, which lets you 
create a new script for the selected report, but does not run the report. 
The script type is set to interactive and cannot be changed. 

7. Select OK, or double-click the report. 

The system displays the report input window. The inputs that are 
required vary, depending on which report you are running.

8. Continue with “Completing the report input window” on page 7-5.
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Completing the report input window 7

The following figure shows possible types of input that might be required to run 
a report. The inputs that are required vary, depending on which report you are 
running. 

1. Report title

1

2. History list
3. Browse button
4. Destination selection

2 3

5. Input field(s)
6. Current ACD

4 5
6
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To complete an input window:

1. Use the following methods to complete the input field(s).
● Type in the name or number of the input requested.

● Select the Browse button to view all of the available inputs.

● Use the history list to select an input that you have previously entered.

2. For all reports other than the Commands > Reports Real-Time tab and 
the Commands > Reports Integrated tab, select the report destination.

Reports can be viewed on screen or printed to any printer to which your PC 
is connected.

3. Perform one of the following actions to select the report destination:
● Select the View Report on Screen destination.

● Select the Print Report on: destination. If you want to print on a 
printer other than the one that is displayed, click the  button.

4. Ensure that the correct ACD is selected. The current ACD, which is 
selected on the Report Selector window, is displayed at the bottom right of 
the input window.

5. If you want to run a report for a different ACD than the one that is selected, 
perform Step a through Step d:

a. If you are in an input window, select Cancel to exit the report input 
window.

b. Go to the selector window that you chose in Step 1.

c. Change the ACD on the selector window.

d. Select the Report that you want to run.

6. Select OK to run the report. 
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Selecting report run dates 7

When you run historical reports, you must select the date or dates for which to 
run the report. Use one of the following methods to select a date:
● Type the date or date range in the Date(s): input field.

● Type a relative date, for example, -2 for two days ago.

● Select the date or dates from the history list of previously used dates for 
this report.

● Select the Browse button . 

— If you select the Browse button and the input needed is a single date, 
the system displays the following window:

To select a specific date, click the day that you want. The day is 
highlighted.

To choose a date that is not in the current month, use the arrow keys at 
the bottom of the calendar box to scroll through the months.
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— If you select the Browse button and the input needed is for more than 
one date, the system displays the following window:

To select specific dates, click the day that you want. The day is 
highlighted. You can select as many days as you want. 

To select a range of dates, select the Range button, click the first day 
of the range, and then click the last day of the range. The dates that you 
select are highlighted. You can select as many ranges as you want, but 
you must select the Range button to define each range.

To choose a date that is not in the current month, use the arrow keys at 
the bottom of the calendar box to scroll through the months.

To clear the current selections, select the Clear button.
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— If the input needed is for 1 month, the system displays the following 
window:

This window is used in monthly reports where the data is for a single 
month. The form is initially displayed with the values in the input field 
or to the month previous to the current month when the input field is 
empty. Select a single month and year for the report. The earliest date 
that you can select is January 1980. The latest date that you can select 
is December 2055.

— If the input needed is for more than 1 month, the system displays the 
following window:

This window is available in monthly reports where the data is for 1 or 
more months. The report runs, beginning with the month entered in the 
First Month: field, and going through as many months as are 
specified in the Number of Months: field.

The months are in calendar order. The earliest date that you can select 
is January 1980. The latest date that you can select is December 2055.
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Selecting report run times 7

When you run interval historical reports, you must select the time period for 
which to run the report. Use one of the following methods to select the time 
period in the report input window:
● Type the time range in the Times: input field.

● Select the times from the history list of previously used times for this 
report.

● Select the Browse button  that is to the right of the Times: field.

If you select the Browse button, the system displays the following window:

Provide the following input in the Select Times box:

— Starting Interval. Select the time that you want the report to begin 
with from the drop-down list. The report data will begin with the 
interval that begins immediately after the time that you enter.

— Ending Interval. Select the time that you want the report to end with 
from the drop-down list. The report data will go through the interval 
that falls within the time that you enter.
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Report menu bar 7

When you run a report, the menu bar at the top of the window has the following 
options:
● Report

● Edit

● Format

● Tools

● Options

● Help

The following sections describe the options that are available in each of these 
menus.
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Report 7

The Report menu includes standard Microsoft Windows* options that relate to 
the report you are running. The following figure shows the items that are 
available in the Report menu.

*Microsoft Windows is a trademark of Microsoft Corp.

Menu item Action

Restart Closes the current report output window and displays the input 
window for the current report. This allows you to run the same 
report, changing inputs as needed.

The Restart menu item is unavailable if you are currently running 
a drill-down report or if the report is an unsaved report that was 
created using the Report Wizard.

Page 
Setup...

Displays the Page Setup window. See “Using Page Setup” on 
page 7-54 for more information.

Print... Displays the Print window. See “Selecting a printer” on page 7-53 
for more information.

NOTE:
When you select Print, the report that is active is printed 
according to the options that you choose in the Print window. If 
the report is a real-time report, only one instance of the report 
prints. The real-time report does not print each time it is refreshed.
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Print 
Preview...

Displays the report so that you can see it before printing.

Design Allows you to access the Report Designer Design Mode window 
from any report if you have purchased the Report Designer 
software and your CMS User ID is authorized to use the Report 
Designer.

When you select Design, the report that is currently running 
remains visible, but you are placed in the Design Mode, where 
you can edit the report. 

The Design menu item is unavailable if you are currently running 
a drill-down report.

NOTE:
For more information on the Design Mode, see CentreVu® Report 
Designer Version 9 User Guide, 585-210-930.

Save Saves the report that you edited.

Save As Saves the report that you edited under a different file name.

Save as 
HTML...

Displays the Save as HTML window, which you can use to save a 
snapshot of the report output as an HTML file. Selecting the 
Script button in this window displays the Save as Script window, 
in which you can create a script to run the specified report and 
save the output as an HTML file.

NOTE:
For more information on the Save as HTML feature, see 
Appendix A, “Saving as HTML.”

Menu item Action
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Script... Displays the Save as Script window, which enables you to create a 
script to run a specified report on schedule and display it on your 
PC. The script can be interactive or automatic, as follows:

● Interactive. The script runs in the current Supervisor session 
and the actions are displayed on the PC. You can input 
requested information while the script is running.

● Automatic. The script launches a new Supervisor session that 
logs in to CMS and runs the requested tasks in the background. 
Actions are not displayed on the PC.

The scripts require a customer-provided scheduler to be run at a 
later time.

Exit Closes the active report output window. The location of the report 
output window is saved when the report is exited. The report is 
displayed the next time that you run it.

Menu item Action
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Edit 7

The following figure shows the standard Microsoft Windows editing options 
that are available in the Edit menu.

Menu item Action

Copy Copies the image of the currently selected chart to the 
clipboard in Microsoft Windows metafile (*.wmf) format. This 
makes it possible for you to paste the chart image into any 
Microsoft Windows application that can read the metafile 
format. For instance, you an copy chart reports and import the 
files into word processing files to be used as viewgraphs. 

You can also access Copy from the menu that is displayed 
when you click the right mouse button while the cursor is on a 
report.

See “Copying chart reports” on page 7-50 for more 
information.

Export Chart 
Data...

Accesses the Data Export Options window which makes it 
possible for you to export the data in the currently selected 
chart. If the report is a real-time report, only one instance of the 
data is exported. If there is more than one chart on this report, 
this option is unavailable until you select a chart.

You can also access the Data Export Options window from the 
menu that is displayed when you click the right mouse button 
while the cursor is on a chart. 

For more information, see “Exporting report data” on page 
7-47.
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Export Table 
Data...

Accesses the Data Export Options window which makes it 
possible for you to export the table data in the report. If the 
report is a real-time report, only one instance of the data is 
exported. If there is more than one table on the report, this 
option is unavailable until you select a table. 

You can also access the Data Export Options window from the 
menu that is displayed when you click the right mouse button 
while the cursor is on a chart. 

For more information, see “Exporting report data” on page 
7-47.

Export All 
Data...

Accesses the Data Export Options window which makes it 
possible for you to export all of the data in the report. You can 
also include labels and headers in the data that are exported. If 
the report is a real-time report, only one instance of the data is 
exported. 

You can also access the Data Export Options window from the 
menu that is displayed when you click the right mouse button 
while the cursor is on a chart. 

For more information, see “Exporting report data” on page 
7-47.

Menu item Action
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Format 7

The Format menu contains actions for modifying the display format of the 
currently selected object. If an action does not apply to the selected object, it is 
unavailable. The following figure shows the items that are available in the 
Format menu.

Menu Item Action

Chart... Allows you to format a chart. 

You can also access the Format Chart window from the 
menu that is displayed when you click the right mouse 
button while the cursor is on a report. 

Table... Allows you to format a table. 

You can also access the Format Table window from the 
menu that is displayed when you click the right mouse 
button while the cursor is on a report. 

Sort by... Allows you to sort the table by several parameters that are 
specific to the information in the selected table. 

You can also access the Sort by window from the menu that 
is displayed when you click the right mouse button while 
the cursor is on a report. 
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Tools 7

The Tools menu contains additional actions that affect the currently selected 
object. The following figure shows the items that are available in the Tools 
menu.

Menu item Action

Available 
drill-down 
reports

Allows you access any drill-down reports that are available 
from the report that is currently running.

You can also access the drill-down reports from the menu 
that is displayed when you click the right mouse button 
while the cursor is on a report. 

For information on drill-down reports, see the appropriate 
chapter in CentreVu® Supervisor Version 9 Reports, 585-
210-929. 

Threshold 
settings...

Opens a window that allows you to view or modify 
threshold highlight settings. Threshold highlight settings 
apply only to some real-time data items in real-time and 
integrated reports. 

You can also access the Threshold settings from the menu 
that is displayed when you click the right mouse button 
while the cursor is on a report.

For information on setting threshold highlights, see 
“Setting report threshold highlights” on page 7-56.
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Change 
Agent 
Splits/Skills

NOTE:
If the current ACD supports Expert Agent Selection (EAS), 
this menu item reads Change Agent Skills. If the current 
ACD does not support EAS, this menu item reads Change 
Agent Splits.

Opens the Change Agent Skills window (EAS) or Change 
Agent Split (non-EAS) for the selected agent. You can then 
modify the split/skill assignments for the agent.

This menu item is enabled only when the selected table cell 
in a report is an agent name or agent login ID. If you do not 
have write permission for Agent Administration, this menu 
item is not shown.

For information on changing agent splits/skills, see the 
appropriate chapter in CentreVu® CMS R3V9 
Administration, 585-214-015.

Menu item Action
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Options 7

The Options menu contains actions that affect the basic display of the report. 
The following figure shows the items that are available in the Options menu.

Menu Item Action

Thresholds Turns threshold highlighting on or off for this real-time 
report.

When threshold highlighting is on, the report shows the 
threshold colors, or icons if the report is minimized, that 
are specified in the Threshold Settings window.

When threshold highlighting is off, the report does not 
show the threshold colors.

Status Bar Shows or hides the status bar. 

When the status bar is hidden, the window remains the 
same size but the contents are resized to fill the window. 
Hide the status bar to get a larger viewing area for the 
report.

When the status bar is made visible, the window remains 
the same size but the contents are resized to fill the 
smaller window area.

The status bar setting is saved in the report view.

Restore 
Original View

Restores the report view to the original settings. All 
changes that were made to the format of this report are 
discarded.
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Report layouts 7

There are two types of report layouts in Supervisor:
● Tables. The Supervisor presentation of standard CMS reports

● Charts. The Supervisor presentation of graphical reports.

A report can consist of only one or more tables, only one or more charts, or a 
combination of tables and charts.

In addition to the tables and charts that make up the main body of reports, 
reports can include text and field names that are followed by single data items. 
Text and data fields are used on both table and chart reports.

The following sections describe each type of report layout.
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Tables 7

Most standard CMS reports are displayed in tables. The following figure shows 
how the information on a standard report window is organized:

Standard real-time reports can be sorted. See “Formatting table reports” on page 
7-24 for more information.

4

1. Menu bar
2. Headings
3. Table
4. Columns
5. Current ACD
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5

1
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Charts 7

Reports for which the name begins with “Graphical” are displayed in charts. 
The following figure shows how the information on a chart report window is 
organized:

There are several options for formatting the appearance of the charts. For more 
information, see “Formatting chart reports” on page 7-28. 

1. Bar chart
2. Line chart
3. Pie chart
4. Legend
5. Current ACD
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Formatting table reports 7

If you are in a report that contains a table, you can format how the report is 
displayed using the Table Format Options window.

NOTE:
The changes that you make to a report’s format affect only your view of 
the report. The changes do not affect how other CMS users see the report.

Use one of the following methods to access the Table Format Options window:
● Double-click on a column heading in the report. 

● From the Format menu, select Format Table or Sort by.

You can also access the Format menu from the menu that is displayed 
when you click the right mouse button while the cursor is on a report.

NOTE:
The Table Format Options window makes it possible for you to make 
layout changes to a table. All changes that you make are saved as part of 
the report view when you exit the report.

If you select Sort by, the system displays the Table Format Options 
window with the Sort tab active. 

If you select Format Table, the system displays the Table Format Options 
window with the General tab active.

The following sections describe the General and Sort tabs.
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General tab 7

Use the General tab to make format changes to a table.

The following table parameters can be changed:
● Show Gridlines. Specifies whether or not table lines are shown in the 

table.

● Fixed Region, Columns. Specifies the number of columns from the left of 
the table that are fixed in place and do not scroll. Valid values are in the 
range of 0 through 99. Use the Columns box to select a valid value or type 
in the value.

● Fixed Region, Rows. Specifies the number of rows from the top of the 
table that are fixed in place and do not scroll. Valid values are in the range 
of 0 through 99. Use the Rows box to select a valid value or type in the 
value.

Spin box
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Sort tab 7

Use the Sort tab to specify the order in which the following information on the 
real-time table report displays. 

To set up the display order for a real-time report, specify the sort column and 
the sort order in the Sort By area. The Sort By list shows all of the database 
table and item names that are used in the report. Select either Ascending or 
Descending as the sort order.

Sorting may cause report refreshes to take longer. To speed up the refresh rate, 
turn off the sort options by selecting none for all of the Sort By criteria.

1. Sort By criteria drop-down lists
2. Sort order

21
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Using sorting to view alphabetically 7

To view a list of agents alphabetically:

1. Select Agent Name from the first Sort By drop-down list.

2. Select Ascending as the sort order.

3. Leave the other two Sort By boxes set to none.

4. Select OK.

Using sorting to search 7

To search for agents who have been in a certain state for too long:

1. Select State from the first Sort By drop-down list.

2. Select Time from the second Sort By drop-down list.

3. Select Descending as the sort order for the second Sort By.

4. Leave the third Sort By box set to none.

5. Select OK.
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Formatting chart reports 7

The charts in graphical reports provide a graphical representation of data. 
Values or data points are displayed in formats such as bars, lines, filled areas, 
and pie charts. These data points are grouped into series that are identified with 
unique colors. 

In many chart types, one data point from each series is grouped together by 
category across an axis. Categories are plotted along the x-axis, while values 
are plotted along the y-axis. A two-dimensional chart shows series next to each 
other. A three-dimensional chart plots series along the z-axis. A chart can also 
have a title and a legend.

If you are in a graphical report, you can format how the report is displayed.

NOTE:
The changes that you make to a report’s format affect only your view of 
the report. The changes do not affect how other CMS users see the report.

To format a chart report:

1. From the Format menu, select Format Chart or Sort by.

You can also access the Format menu from the menu that is displayed 
when you click the right mouse button while the cursor is on a report.

The system displays the Chart Format Options window:
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The following sections describe each of the tabs.

General tab 7

Use the General tab to specify several general parameters that apply to the 
chart.

The following chart parameters can be changed:
● Background Color. Use this area to specify whether the backdrop of the 

chart is a solid color or whether it is displayed as a gradient, that is, a 
smooth transition from one color to another. The gradient transition can be: 
Horizontal, Vertical, Rectangle, or Oval. The quality of the gradient 
effect depends on the video card that is installed in the PC, or the 
capabilities of the printer for printed reports.

● Real-Time. If the chart is a rolling chart, use this area to specify the 
number of data points to be displayed in the chart. Permitted values are 2 
through 100. The default is 10. A rolling chart is a line chart that is initially 
displayed with no data points. Each time that report is refreshed, a data 
point is added. As data points are added, the chart “rolls” from left to right. 
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When the chart is displaying the number of specified data points, the oldest 
data point is dropped from the display and the newest data point is 
displayed the next time that the report is refreshed.

3D Effects tab 7

Use the 3D Effects tab to control the three-dimensional appearance of the chart. 
If the current chart is a two-dimensional chart, this tab is unavailable. 

The following chart parameters can be changed:
● Elevation. A number from 0 through 90 degrees that describes the relative 

height from which a chart is viewed. An elevation of 90 looks directly 
down on the top of the chart. An elevation of 0 looks directly at the side of 
the chart. The sample charts throughout this document use an elevation of 
30 degrees.

● Rotation. A number from -360 through 360 degrees that specifies the 
angle that the chart is turned relative to the viewing position. The sample 
charts throughout this document use a rotation of 60 degrees. Rotation does 
not apply to three-dimensional pie charts.
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● Projection. Use this field to select one of three mathematical algorithms 
that are used to give a three-dimensional appearance on a two-dimensional 
sheet of paper or computer screen. You can choose the following values:

— Oblique: The chart has depth but the X-Y plane does not change when 
the chart is rotated or elevated.

— Orthogonal: Perspective is not applied to the chart, resulting in less of 
a three-dimensional effect. The advantage of using this type of 
projection is that vertical lines remain vertical, making some charts 
easier to read.

— Perspective: This provides the most realistic three-dimensional 
appearance. Objects farther away from you converge toward a 
vanishing point.

● Viewing Distance. A number from 50 through 1000 that represents the 
distance from which the chart is viewed as a percentage of the depth of the 
chart.

● Width to Height. A number from 5 through 2000 that represents the 
percentage of the chart’s height that is used to draw the chart’s width.

● Depth to Height. A number from 5 through 2000 that represents the 
percentage of the chart’s height that is used to draw the chart’s depth.

See “Rotating a three-dimensional chart” on page 7-46 for an easy way to 
change the elevation and rotation of a chart using the mouse.



  
 CentreVu Supervisor V9 Installation and Getting Started
Using CentreVu Supervisor reports
Formatting chart reports 7-32

Axis tab 7

Use the Axis tab to specify the title that displayed on each axis of the chart 
report.

The Axis Display chart parameter can be changed. Use the check boxes in the 
Axis Display area to make each of the axes visible or invisible. The choices are 
X Axis, Y Axis, 2nd Y Axis, and Z Axis. 
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Type tab 7

Use the Type tab to change the chart type.

The following chart parameters can be changed:
● 2D and 3D. Changes the chart between two-dimensional and three-

dimensional views. 

NOTE:
Two-dimensional charts update faster than three-dimensional charts. If the 
drawing speed seems slow, display charts as two-dimensional.

● Chart Type. Specifies how the data is presented. Choose a chart type from 
the list. The types of charts available vary depending on whether you select 
a two-dimensional or three-dimensional chart. The possible chart types are 
as follows:

— Bar (two-dimensional and three-dimensional)

— Line (two-dimensional and three-dimensional)

— Area (two-dimensional and three-dimensional)
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— Step (two-dimensional and three-dimensional)

— Horizontal Bar (two-dimensional and three-dimensional)

— Clustered Bar (three-dimensional only)

— Pie (two-dimensional and three-dimensional).

● Stacked check box. Causes the data for all series to be stacked rather than 
shown separately. This check box is unavailable for pie charts.

● % Axis check box. Causes the value axis (y-axis) to be displayed as 
percentages rather than as actual data values. This can be combined with 
the stacked check box to produce a percentage stacked chart.
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Title tab 7

Use the Title tab to control the location of the chart title.

The following chart parameters can be changed:
● Visible check box. Allows you to display or not display report titles. 

NOTE:
Since the title takes up space, the chart will be smaller if you select the 
Visible option. To increase the size of the chart, do not select the Visible 
option.

● Location. If you choose to have report titles visible, use the Location area 
to select where the titles are displayed. The options are Top Left, Top 
(center), Top Right, Left, Right, Bottom Left, Bottom (center), and 
Bottom Right.
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Legend tab 7

Use the Legend tab to control the location of the chart legend.

The following chart parameters can be changed:
● Visible check box. Allows you to display or not display report legends.

NOTE:
Since legends take up space, the chart will be smaller if you select the 
Visible option. To increase the size of the chart, do not select the Visible 
option.

● Location. If you choose to have report legends visible, use the Location 
area to select where the legend displays. The options are Top Left, Top 
(center), Top Right, Left, Right, Bottom Left, Bottom (center), and 
Bottom Right.
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Data Labels tab 7

Use the Data Labels tab to control the location of the data point labels. 

Use the Location area to specify the following chart parameters:
● None. Labels are not displayed.

● Above Point. Displays the label above the data point. This location is valid 
only for bar, line, area, and step charts.

● Below Point. Displays the label below the data point. This location is valid 
only for bar, line, area, and step charts.

● Center. Displays the label centered on the data point. This location is valid 
only for bar, line, area, and step charts.

● Base. Displays the label along the category axis, directly beneath the data 
point. This location is valid only for bar, line, area, and step charts. 

● Inside. Displays the label inside a pie slice. This location is valid only for 
pie charts.

● Outside. Displays the label outside a pie slice. This location is valid only 
for pie charts.
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● Left. Displays the label at the left of a pie slice. This location is valid only 
for pie charts.

● Right. Displays the label at the right of a pie slice. This location is valid 
only for pie charts.

If data labels are displayed, use the Show Label Text area to specify that the 
labels include one of the following:
● Value. Displays the value of the data point in the label.

● Percent. Displays the value of the data point in the label as a percentage.

● Series Name. Uses the series name to label the data point.

● Category Name. Uses the category name to label the data point.

NOTE:
The position of data point labels can affect the readability of the chart. 
The label text may overlap in some situations, making it difficult or 
impossible to read the labels.



  
 CentreVu Supervisor V9 Installation and Getting Started
Using CentreVu Supervisor reports
Minimizing report output windows 7-39

Minimizing report output windows 7

To minimize a report window, select the minimize button, which is located in 
the upper right corner of the window.

When a report output window is minimized, the system displays the report’s 
icon. The following table shows the icons that are displayed for the various 
report types: 

Icon Report type

Agent Administration reports

Agent Real-Time, Historical, and Integrated reports

Call Center Administration reports

Dictionary reports

Exceptions reports

Maintenance reports
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Other, Queue/Agent, and Custom Real-Time and 
Historical reports

Split/Skill Real-Time, Historical, and Integrated 
reports

Trunk/Trunk Group Real-Time and Historical reports

VDN Real-Time, Historical, and Integrated reports

Vector Real-Time and Historical reports

Icon Report type
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Minimized report thresholds 7

If Report Thresholds are enabled, real-time and integrated reports continue to 
be updated while they are minimized. If no caution or warning threshold 
condition is currently being met, the report’s normal icon, as shown on the 
previous table, is displayed on the toolbar and in the system tray. If thresholds 
are being met, the report’s icon on the toolbar remains the same, but the system 
displays the caution or warning threshold icon in the system tray. 

The following table shows the icons that are displayed for the caution and 
warning thresholds:

For more information on how the Supervisor icon in the system tray works, see 
Chapter 5, “Getting Started with CentreVu Supervisor.”

Icon Threshold type

Caution threshold

Warning threshold
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Using right mouse button menus 7

When running reports, you can click the right mouse button to display a menu. 

The menu that is displayed depends on the location of your cursor. It can 
include options from the Edit, Format, and Tools menus on the Reports menu 
bar. The applicable menu items for the input field are enabled. If a report object 
is not selected, a menu is not displayed when you hold down the right mouse 
button. To deselect a selected object, click anywhere else on the report.

NOTE:
See CentreVu® Supervisor Version 9 Reports, 585-210-929, for 
descriptions of reports.

The right mouse button menus are available when you perform any of the 
following actions:
● Select a cell in a table and hold down the right mouse button. The 

system draws a dotted border around the cell and displays the following 
menu:

If you select a cell that displays an agent name, agent number, or work 
mode, the available drill-down reports for that cell are displayed at the top 
of the menu that is displayed when you click the right mouse button. See 
examples of these later in this section.

● Select an output field or label and hold down the right mouse button. 
The system draws a dotted border around the field and displays the 
following menu:

The Threshold Settings menu item is enabled if the highlighted field has 
related threshold settings. 
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● Select a data point in a chart and hold down the right mouse button. 
The system highlights the data point using selection handles, which are 
dots along the edges of the data point, and displays the following menu:

If you select a data point that allows report threshold highlighting to be set, 
the menu item is unavailable.

● Select an agent name or agent number in a table and hold down the 
right mouse button. The system highlights the agent name with a dotted 
border and displays the following menu:

If you do not have the EAS feature, the drill-down reports that are available 
are the Real-Time Agent Information report and the Integrated Agent 
Information report.

From this menu, you can access either the Real-Time or the Integrated 
Agent Graphical Information report. If you double-click the agent name 
and you are running a real-time report, the default drill-down report is the 
Real-Time Agent Graphical Information report. 

See CentreVu® Supervisor Version 9 Reports, 585-210-929, for 
descriptions of reports.
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NOTE:
You can change an agent’s splits/skills while you are in a report using this 
method of selection. See the appropriate chapter in CentreVu® CMS R3V9 
Administration, 585-214-015, for more information.

● Select a cell on a table or a point on a chart that displays agent work 
state information and hold down the right mouse button. The system 
highlights the data point using selection handles, which are dots along the 
edges of the data point, and displays the following menu:

If you have the EAS feature, the Real-Time AUX Agent drill-down report 
is also available. 

From this menu, you can access the Real-Time Split/Skill Work State 
Report, which is also displayed when you double-click a work state in the 
report. 

● Select a cell on a table or a point on a chart that displays Top Agent 
work state information and hold down the right mouse button. The 
system highlights the data point using selection handles, which are dots 
along the edges of the data point, and displays the following menu:

If you have the EAS feature, the Real-Time AUX Agent drill-down report 
is also available. 
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From this menu, you can access the Real-Time Split/Skill Top Agent Work 
State Report, which is also displayed when you double-click a work state in 
the report. 
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Rotating a three-dimensional chart 7

The rotation and elevation of any three-dimensional chart can be changed 
interactively using the mouse. This is easier than using the 3D Effects tab of the 
Chart Format window (see “Formatting chart reports” on page 7-28 for 
information on using the 3D Effects tab). 

To change the rotation and elevation of a three-dimensional chart:

1. Place the pointer over a three-dimensional chart.

2. Press and hold CTRL. 

The pointer changes to indicate that the chart can be rotated.

3. Click and hold the left mouse button. 

A dotted three-dimensional outline is displayed around the chart.

4. Move the pointer up and down to change the chart elevation, and left and 
right to change the chart rotation. The dotted three-dimensional outline 
shows the position of the chart as you move the mouse.

5. When you find the rotation and elevation that you want, release the mouse 
button. 

The system redraws the chart in the new position.

The three-dimensional rotation and elevation of each chart is saved as part of 
the report view.
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Exporting report data 7

You can export the data from both standard (table) and graphical (chart) reports, 
either to a file or to the Microsoft Windows clipboard. Once you export report 
data, you can copy the report information into another application, for instance, 
a spreadsheet.

Select the Script button on the Data Export window to display the Save as 
Script window. You can use this box to create a new script to run the selected 
report and then export it at a scheduled time.

NOTE:
By default, only the data from the chart or table is exported. You must 
select the Include Labels and Headers check box on the Export Data 
window to include that information in the export of data.

Reports are exported from Supervisor in the following format:
● Data is exported as ASCII characters.

● For table reports, each row of data is written as one line, terminated by a 
carriage return (ASCII value 13).

● The field separator character is written between fields.

● The field separator does not follow the last character in the line.

● Text strings are delineated according to the specified text delimiter.

To export the data from a report:

1. Click on the table or chart within a report.

2. From the Edit menu, select Export Table Data, Export Chart Data, or 
Export All Data, as appropriate.

You can also access the menu for exporting from the menu that is displayed 
when you click the right mouse button while the cursor is on a report.
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The system displays the Export Data window. The Export Data window 
allows you to copy the data from a report to the clipboard or a file. 

3. Complete the following parts of the Export Data window:
● Destination. Select to Export to Clipboard or Export to File. If you 

select Export to File, you can:

—Type in a name for the file in the next box.

—Select the File button  to the right of the box  to browse the 
files on your PC.

—Use the history list to select a file that you previously used.
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● Export Format selection box. Define the export format of the report. 
The character you choose from the drop-down list in the Field 
Separator box is what will be placed between each field in the report. 

The character you choose for the Text Delimiter determines what is 
used around text strings in the exported file. If a text delimiter is 
specified, no special checks are done to ensure that the data does not 
contain that character, and the data is written unmodified. 

If you want to export data to Microsoft Excel, choose Tab as the field 
separator and None as the text delimiter.

● Export Null Values as Zero. Select this check box to include data that 
is null as a zero in the export of information. This is helpful if you are 
exporting a table report because a null value that is not included in the 
export of the data could disrupt the order of the rows/columns in the 
data.

● Include Labels and Headers check box. Select this check box to 
include the text information (such as column headers in table reports) 
in the export of the report’s data.

● Export Time Durations in Seconds. Select this check box to include 
the time duration in the export of information.

4. If you want to automatically export data at a scheduled time, select the 
Script button to display the Save as Script window, which lets you create a 
script to export the data from the report and then exit the report.
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Copying chart reports 7

Chart reports can be copied to the Microsoft Windows clipboard in the 
Microsoft Windows metafile (*.wmf) format. This makes it possible for you to 
paste the chart image into any Microsoft Windows application that can read the 
metafile format. For instance, you can copy chart reports and import the files 
into word processing files to be used as viewgraphs.

To copy a chart report to the metafile format:

1. Run a chart (graphical) report.

2. Select the image that you want to copy by clicking it.

3. From the Edit menu, select Copy.

You can also select Copy from the menu that is displayed when you click 
the right mouse button while the cursor is on the chart.

The system copies the chart that you selected to the clipboard.
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Resizing report windows 7

To resize report windows:

1. Moving the cursor to the edge of the window.

2. When the resize arrow appears, hold down the left mouse button and move 
the mouse to size the window.

3. Release the mouse button when the window is the size you that want it to 
be.

You can also use the maximize and minimize buttons at the top of the window 
to size the window.

When you resize a Supervisor report output window, the resulting effect 
depends on whether you are running a standard CMS report or a graphical 
report. The following sections outline the effects of resizing each type of report 
window.

Standard CMS reports 7

When you resize the window of a standard report, the contents of the window 
do not change in size to reflect the new window size. 

If you made the window smaller than the size of the report, use the scroll bars 
that are displayed to view the entire contents of the report.

Graphical reports 7

When you resize the window of a graphical report, the contents of the window 
change in size to reflect the new window size.

If a window is made too small, some elements may shrink in such a way to 
become unreadable. If this happens, resize the window to a more appropriate 
size. You may also choose to turn chart legends or data labels off to make more 
room for the chart itself. 

The window size is saved as part of the report view.
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Changing column widths 7

You can change the width of an individual column in a table or chart report by 
positioning the mouse pointer on the vertical line between the column headers. 
The pointer changes to indicate that a resize is possible, and you can then drag 
the mouse to change the column size. 
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Selecting a printer 7

The Print window is a standard feature of Microsoft Windows. 

To access the Print window:

1. Select a report from Reports, Dictionary, Exceptions, Call Center 
Administration, or Maintenance.

2. Use one of the following methods to initiate the print process:
● Select the Print button  on the report input window

● From the Report menu select Print.

The system displays the Print window.

The default printer is listed in the Name box. To select another printer, click the 
down arrow to the right of the box to display a drop-down list of installed 
printers. You can choose any printer that has been installed in the Microsoft 
Windows Control Panel. Depending on what printers are installed, nonprinter 
devices such as files and fax may display here. 

To print to a file, select the Print to file box.

Other entries in the Printer area, including Status, Type, Where, and 
Comment, vary depending on the chosen printer. The Microsoft Windows 
system software determines what is available here.
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Using Page Setup 7

Use the Page Setup window to specify how each page of a report is positioned 
when it is printed. The changes that you make in this window apply only to 
printed reports and do not affect reports that are displayed on the screen.

The Page Setup window for printing options is a standard feature of Microsoft 
Windows. 

To access the Page Setup window:

1. Select a report from Reports, Dictionary, Exceptions, Call Center 
Administration, or Maintenance.

2. Complete the report input window and selecting View Report On Screen 
as the destination.

3. Select OK to run the report.

4. Once the report is running, from the Report menu, select Page Setup.

The system displays the Page Setup window:
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The following options are available in the Page Setup window:
● Margins (inches). Use to define the spaces at the edges of the page where 

nothing is printed. The margin settings are defined as:

— Top. The margin is measured from the top of the page. The report is 
offset by this amount at the top of each page.

— Bottom. The margin is measured from the bottom of the page. When a 
printed table reaches the bottom of the page, it continues printing at 
the top of the next page, with the table titles repeated. If a chart 
overlaps the bottom margin, it is scaled smaller so that it fits within the 
margin. Text that reaches the bottom of the page is printed on the next 
page.

— Left. The margin is measured from the left of the page. The report is 
offset by this amount on the left of each page.

— Right. The margin is measured from the right of the page. Tables and 
text that are too wide to fit on the printed page are truncated at the right 
margin. Charts that overlap the right margin are scaled smaller to fit 
within the margin.

● Page Numbers. Use to specify whether to display page numbers. The 
following settings are valid:

— Yes. Page numbers are displayed.

— No. Page numbers are displayed.

● Box Around Tables. Use to specify whether to display a box around report 
tables when printed. The following settings are valid:

— Box. Boxes are displayed.

— No Box. Boxes are not displayed.
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Setting report threshold highlights 7

Use the report threshold highlights feature to set visual flags that notify you 
when a real-time data item is out of acceptable bounds. This feature makes it 
possible for you to run a minimized report and be notified through color or icon 
changes when an item passes a specific threshold.

You can set threshold highlights for real-time data items in real-time or 
integrated reports only. The threshold highlights that you set tell you when data 
for an entity, that is, a split/skill, agent, agent group, or VDN, has reached the 
threshold level that you defined.

Threshold highlight settings apply to a single entity on a specific ACD. For 
example, if you run a real-time split report for split 17 on ACD 1 and set the 
threshold highlights, the threshold settings apply to split 17 on ACD 1 for all 
reports that you run for that split and ACD. Also, the threshold highlight 
settings are saved on the PC that you are currently using. So, if you move to 
another PC, you must set up the threshold highlights on that PC. If multiple 
users log in to the same PC, each user’s threshold highlight settings are saved 
individually.

By default, the thresholds for each report are turned on, but the threshold 
highlight settings are empty and the sample size threshold is zero. Therefore, no 
threshold highlights show on any reports until you create them using the 
Threshold Settings window. You can turn thresholds on and off for each report 
by selecting and clearing the Thresholds Settings check box in the report input 
window, or by selecting Threshold Settings from the Options menu in the 
report output window.
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Example of setting thresholds 7

For example, say that you want to set thresholds for Time on ACD Calls in the 
skill named Sales. You might set the High Caution threshold to 50 seconds and 
the High Warning threshold to 60 seconds. If an agent spends more than 50 
seconds, but less than 60 seconds, on an ACD call in the Sales skill, the system 
highlights the item on the report with the High Caution threshold color. If the 
time exceeds 60 seconds, the system highlights the item on the report with the 
High Warning threshold color. However, if the agent spends more than 50 
seconds on an ACD call in any other skill that does not have the same 
thresholds, the system does not display any threshold highlighting for the item 
on the report.

NOTE:
Report threshold highlights are not the same as CMS Exceptions 
Thresholds. The threshold highlighting you can do with this feature is 
available through the Supervisor interface only.

To set report threshold highlights:

1. Run a report that contains real-time data. Reports that contain real-time 
data are a real-time reports and integrated reports.

2. Select on a data item in the report for which you can set threshold 
highlights

NOTE:
When one or more data items for which threshold highlights can be set are 
selected, the Threshold Settings menu item is available. When the data 
item that is selected does not allow thresholds, an error message is 
displayed. See the “Available agent threshold settings” on page 7-62, 
“Available split/skill threshold settings” on page 7-67, and “Available 
VDN threshold settings” on page 7-71 tables for a list of the report outputs 
that allow threshold highlighting

3. From the Tools menu, select Threshold Settings. from the right mouse 
button or.

You can also select Threshold Settings from the menu that is displayed 
when you click the right mouse button while the cursor is on the data item.
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4. Complete the Threshold Settings window:

NOTE:
The Sample Size box is present only if you select a data item that is a 
percentage or an average.

The Threshold Settings window includes the following information and text 
boxes:
● Item. Shows the name of the report threshold that applies to the selected 

data value. In most cases, this box contains a single entry. If the data value 
is agent “Time in State” or “Time in Workmode,” or agent group “Time in 
State” or “Time in Workmode,” this list box contains multiple names, one 
for each possible agent state or workmode. Threshold highlights can be set 
for each individual state and workmode.

● Description. Shows a description of the threshold that is currently 
selected.

 
 

1.

2.

3.

4.

5.

1. Data item threshold definition
2. Item
3. Description
4. Icons
5. Thresholds
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● Thresholds. Shows the colors (as defined in the Options Threshold 
Colors tab, which is accessed from the Tools menu), icons, and current 
numerical settings for the threshold highlights of this item. For thresholds 
that are time related, the numbers that you enter are in seconds. For 
example, if you are entering a high caution threshold for 3 minutes, type 
180 (for 180 seconds) in the High Caution field.

— Low Warning. Contains the current value for the low warning 
threshold for the selected data item. If no value is defined, the field is 
blank. You can set the value to any positive integer from 0 to 
999,999,999 or leave it blank. If the field is blank, no threshold is set.

— Low Caution. Contains the current value for the low caution threshold 
for the selected data item. If no value is defined, the field is blank. You 
can set the value to any positive integer from 0 to 999,999,999 or leave 
it blank. If the field is blank, no threshold is set.

— High Caution. Contains the current value for the high caution 
threshold for the selected data item. If no value is defined, the field is 
blank. You can set the value to any positive integer from 0 to 
999,999,999 or leave it blank. If the field is blank, no threshold is set.

— High Warning. Contains the current value for the high warning 
threshold for the selected data item. If no value is defined, the field is 
blank. You can set the value to any positive integer from 0 to 
999,999,999 or leave it blank. If the field is blank, no threshold is set.

● Sample Size. Contains the current value for the sufficient sample size 
value. You can set this to any value from 0 to 999. When you set this value, 
you are defining a minimum number of items that must be currently 
tracked before the threshold highlighting is enabled. Sample Size is only 
available if the data item that you selected is a percentage or an average.

5. Select OK.
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Tips for setting report threshold highlights 7

The following information is helpful when you are setting report threshold 
highlights.
● Before you can administer threshold highlights for a data item, you must 

first click the data item in the report to select it. When a data item is 
highlighted in a table (standard) report, it is outlined with a dotted line. 
When a data item is highlighted in a chart (graphical) report, it has “pull-
bars” around the perimeter.

● See“Available agent threshold settings” on page 7-62, “Available split/skill 
threshold settings” on page 7-67, and “Available VDN threshold settings” 
on page 7-71 for more information on the real-time data items in reports for 
which you can set threshold highlights.

● In standard reports, you can select items from the table or from the output 
information at the top of the report.

● In chart reports, you can select items from the pie charts, bar charts, 
graphical reports, or tables.

● When you set threshold highlights for an entity, that is, for a split/skill, an 
agent, an agent group, or a VDN, that set of threshold highlights applies to 
every report that is run specifically for that entity.

● The report threshold highlights are updated each time that the report is 
refreshed.

● The numbers that you define for the threshold highlights must increase 
from left to right. So, the number that you use for Low Warning must be 
less than the number that you use for High Warning.
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● You can set the label colors by choosing Options from the Tools menu on 
the Supervisor Controller window. Depending on how you define the 
colors, you can set the sample size threshold to behave in the following 
ways: 

— If you want to be alerted to the fact that a particular calculation is not 
statistically significant, set the Insufficient color to a different color 
than any other threshold condition. This causes data with insufficient 
sample size to be highlighted in a special color.

— If you want to ignore values with insufficient sample sizes, set the 
Insufficient color to be black text on a gray background. This causes 
the value with insufficient sample size to not be highlighted. 

● Setting report threshold highlights affects how report data is displayed in 
the following ways:

— If the data calculation contains a nonzero Sample Size threshold, the 
denominator of the specified calculation is compared to the Sample 
Size threshold. If the denominator is less than the Sample Size 
threshold, the value is displayed in the Insufficient color, indicating 
that the sample size is insufficient for the value to be significant. 

— If the sample size is sufficient or if there is no sample size that is 
associated with the data, the data value is compared to the Low 
Warning, Low Caution, High Caution, and High Warning 
threshold values to determine which band applies. The value is 
displayed in the color that is associated with the appropriate threshold.
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Available agent threshold settings 7

All of the data that Supervisor uses for agent threshold highlights are retrieved 
from the cagent (current interval agent) database table. See CentreVu® CMS 
R3V9 Database Items and Calculations, 585-210-945 for more information on 
the database tables. The following table lists the agent threshold highlights that 
you can set.

Threshold Description/database item or calculation

Time in AUX State Description — Amount of time that the agent is in the 
Auxiliary Work state. 

Measures — DURATION while AGSTATE = AUX

Time in AUX-IN State Description — Amount of time that the agent is on an 
incoming call while in the Auxiliary Work state. 

Measures — DURATION while AGSTATE = 
AUX-IN

Time in AUX-OUT 
State

Description — Amount of time that the agent is on an 
outgoing call while in the Auxiliary Work state.

Measures — DURATION while AGSTATE = 
AUX-OUT

Time in ACW State Description — Amount of time that the agent is in the 
After Call Work state. 

Measures — DURATION while AGSTATE = ACW

Time in ACW-IN State Description — Amount of time that the agent is on an 
incoming call while in the After Call Work state.

Measures — DURATION while AGSTATE = 
ACW-IN

Time in ACW-OUT 
State

Description — Amount of time that the agent is on an 
outgoing call while in the After Call Work state.

Measures — DURATION while AGSTATE = 
ACW-OUT
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Time in AVAIL State Description — Amount of time that the agent is in the 
AVAIL state.

Measures — DURATION while AGSTATE = AVAIL.

Time in ACD State Description — Amount of time that the agent is in the 
ACD state. 

Measures — DURATION while AGSTATE = ACD

Time in ACD-IN State Description — Amount of time that the agent is in the 
ACD-IN state. 

Measures — DURATION while AGSTATE = 
ACD-IN

Time in ACD-OUT 
State

Description — Amount of time that the agent is in the 
ACD-OUT state. 

Measures — DURATION while AGSTATE = 
ACD-OUT

Time in DACD State Description — Amount of time that the agent is in the 
DACD state.

Measures — DURATION while AGSTATE = DACD

Time in DACD-IN 
State

Description — Amount of time that the agent is in the 
DACD-IN state.

Measures — DURATION while AGSTATE = DACD-
IN

Time in DACD-OUT 
State

Description — Amount of time that the agent is in the 
DACD-OUT state. 

Measures — DURATION while AGSTATE = DACD-
OUT

Time in DACW State Description — Amount of time that the agent is in the 
DACW state.

Measures — DURATION while AGSTATE = DACW

Threshold Description/database item or calculation
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Time in DACW-IN 
State

Description — Amount of time that the agent is in the 
DACW-IN state. 

Measures — DURATION while AGSTATE = DACW-
IN

Time in DACW-OUT 
State

Description — Amount of time that the agent is in the 
DACW-OUT state. 

Measures — DURATION while AGSTATE = DACW-
OUT

Time in RING State Description — Amount of time that the agent is in the 
RING state. 

Measures — DURATION while AGSTATE = RING

Time AUX Workmode Description — Amount of time that the agent is in the 
AUX workmode, including incoming and outgoing 
calls. This time measures the time that the agent 
remains in AUX, regardless of any incoming or 
outgoing calls handled.

Measures — AGTIME while WORKMODE = AUX.

Time in ACD 
Workmode

Description — Amount of time that the agent is in the 
ACD workmode, including incoming and outgoing 
calls. This time measures the time that the agent 
remains in ACD, regardless of any incoming or 
outgoing calls handled.

Measures — AGTIME while WORKMODE = ACD

Time in ACW 
Workmode

Description — Amount of time that the agent is in the 
ACW workmode, including incoming and outgoing 
calls. This time measures the time that the agent 
remains in ACW, regardless of any incoming or 
outgoing calls handled.

Measures — AGTIME while WORKMODE = ACW

Threshold Description/database item or calculation
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Time in AVAIL 
Workmode

Description — Amount of time that the agent is in the 
AVAIL workmode, including incoming and outgoing 
calls. This time measures the time that the agent 
remains in AVAIL, regardless of any incoming or 
outgoing calls handled.

Measures — AGTIME while WORKMODE = AVAIL

Time in DACD 
Workmode

Description — Amount of time that the agent is in the 
DACD workmode. This time measures the time that the 
agent remains in DACD, regardless of any incoming or 
outgoing calls handled. (Applies only to Generic 3 
switches.)

Measures — AGTIME while WORKMODE = DACD

Time in DACW 
Workmode

Description — Amount of time that the agent is in the 
DACW workmode, including incoming and outgoing 
calls. This time measures the entire time that the agent 
remains in DACW, regardless of any incoming or 
outgoing calls handled.

Measures — AGTIME while WORKMODE = DACW

Calls in Direct Agent 
Queue

Description — Number of Direct Agent calls that are 
queued to the agent. DA_INQUEUE is the current 
number of Direct Agent calls that are waiting in any 
split/skill queue for a specific agent. (Applies only to 
Generic 3 switches.)

Measures — DA_INQUEUE

Time call waiting in 
Direct Agent Queue

Description — Amount of time that the caller has 
waited in the Direct Agent queue. DA_OLDESTCALL 
is the length of time that the oldest Direct Agent call 
has waited in any split/skill queue for this agent. 
(Applies only to Generic 3 switches.)

Measures — DA_OLDESTCALL

Threshold Description/database item or calculation
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Average talk time Description — Average length of time that the agent 
spends talking on ACD calls. 

NOTE:
Sample Size thresholds apply to this threshold.

Measures — AVG_AGENT_TALK_TIME calculation.

Threshold Description/database item or calculation
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Available split/skill threshold settings 7

All of the data that Supervisor uses for split/skill threshold highlights is 
retrieved from the csplit (current interval split) database table. See 
CentreVu® CMS R3V9 Database Items and Calculations, 585-210-945 for 
more information on the database tables. The following table lists the split/skill 
threshold highlights that you can set.

Threshold Description/database item or calculation

Oldest Call Waiting Description — Amount of time that the oldest call to 
this split/skill has waited in queue. OLDESTCALL is 
the number of seconds that the oldest split/skill ACD 
call has waited in queue or ringing.

Measures — OLDESTCALL

Number of Calls 
Waiting in Queue

Description — Number of calls that are queued to this 
split/skill. The computation measures the number of 
calls that are in queue or ringing at an agent position.

Measures — INQUEUE + INRING

Number of Calls 
Abandoned

Description — Number of calls that were queued to 
this split/skill and then abandoned. ABNCALLS is the 
number of calls offered to a split queue which were 
subsequently abandoned by the caller.

Measures — ABNCALLS

Average Speed of 
Answer

Description — Number of seconds, on average, before 
a call to this split/skill is answered. The average speed 
of answer is the ANSTIME, which is the time that 
callers spent in queue or ringing before being 
answered, divided by the ACDCALLS, which is the 
number of calls that queued to the split/skill and were 
answered by an agent at this split/skill.

NOTE:
Sample Size thresholds apply to this threshold.

Measures — AVG_ANSWER_SPEED
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Average Talk Time Description —Average length of time that is spent on 
ACD calls to the split/skill.

NOTE:
Sample Size thresholds apply to this threshold.

Measures — AVG_ACD_TALK_TIME

Average Time to 
Abandon

Description — Average length of time that callers 
waited before abandoning calls to the split/skill. 

NOTE:
Sample Size thresholds apply to this threshold.

Measures — AVG_ABANDON_TIME

Full-Time Equivalent 
Agents Staffed

Description — Number of total full-time equivalent 
agents who are currently staffed for the skill.

Measures — FTE_AGENTS

Number of Calls 
Forced Busy

Description — Number of calls to the split/skill that 
were given a busy signal by the switch. 

Measures — BUSYCALLS

Number of Calls 
Disconnected

Description — Number of calls to the split/skill that 
were disconnected by the switch.

Measures — DISCCALLS

Percent of Calls 
Answered in Service 
Level

Description — Percentage of ACD calls to the 
split/skill that were answered within the service level. 

NOTE:
Sample Size thresholds apply to this threshold.

Measures — PERCENT_SERV_LVL_SPL

Threshold Description/database item or calculation
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Percent of Calls 
Abandoned

Description — Percentage of ACD calls to the 
split/skill that were abandoned.

NOTE:
Sample Size thresholds apply to this threshold.

Measures — PERCENT_CALL_ABAN

Number of Agents 
Staffed

Description — Number of agents who are logged into 
the split/skill.

Measures — STAFFED

Percent of Calls 
Answered

Description — Percentage of ACD calls that were 
offered to the split/skill and answered.

NOTE:
Sample Size thresholds apply to this threshold.

Measures — PERCENT_CALL_ANS

Call Profile Abandon 
per Service Level 
Increment

Description — Number of abandoned calls to the 
split/skill for any service level increment. A single 
report threshold applies to all of the values. If the 
number of abandoned calls for the split/skill reaches 
the threshold for any of the service level increments, 
the value for that service level increment is 
highlighted.

Measures — ABNCALLS1 through ABNCALLS10

Rolling Average Speed 
of Answer

Description — Switch-based Rolling Average Speed 
of Answer for this split/skill. The Rolling Average 
Speed of Answer is the average speed of answer across 
intervals.

Measures — ASA

Expected Wait Time 
(Low)

Description — Expected Wait Time for a call that is 
queued to this split/skill at a low priority level.

Measures — EWTLOW

Threshold Description/database item or calculation
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Expected Wait Time 
(Medium)

Description — Expected Wait Time for a call that is 
queued to this split/skill at medium priority level.

Measures — EWTMEDIUM

Expected Wait Time 
(High)

Description — Expected Wait Time for a call that is 
queued to this split/skill at high priority level.

Measures — EWTHIGH

Expected Wait Time 
(Top)

Description — Expected Wait Time for a call that is 
queued to this split/skill at top priority level.

Measures — EWTTOP

Threshold Description/database item or calculation
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Available VDN threshold settings 7

All of the data that Supervisor uses for VDN threshold highlights are retrieved 
from the cvdn (current interval VDN) database table. See CentreVu® CMS 
R3V9 Database Items and Calculations, 585-210-945 for more information on 
the database tables. The following table lists the VDN threshold highlights that 
you can set.

Threshold Description/database item or calculation

Number of Calls 
Abandoned During the 
Interval

Description — Number of calls that were queued to 
this VDN and then abandoned.

Measures — ABNCALLS

Number of Calls 
Forced Busy During the 
Interval

Description — Number of calls to the VDN that were 
given a busy signal by the switch.

Measures — BUSYCALLS

Number of Calls 
Disconnected During 
the Interval

Description — Number of calls to the VDN that were 
disconnected by the switch by the vector “disconnect” 
command.

Measures — DISCCALLS

Oldest Call Waiting Description — Number of seconds that the oldest call 
has waited in this VDN.

Measures — OLDESTCALL

Number of Calls 
Waiting

Description — Number of calls queued to this VDN 
that have not been answered by an agent.

Measures — INPROGRESS - ATAGENT

Percent of Calls 
Answered in Service 
Level

Description — Percentage of ACD calls to the VDN 
that were answered within the service level.

NOTE:
Sample Size thresholds apply to this threshold.

Measures — 100*(ACCEPTABLE / INCALLS)
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Percent of Calls 
Abandoned

Description — Percentage of ACD calls to the VDN 
that were abandoned.

NOTE:
Sample Size thresholds apply to this threshold.

Measures — 100*(ABNCALLS / INCALLS)

Percent of Calls 
Answered

Description — Percentage of ACD calls offered to the 
VDN that were answered.

NOTE:
Sample Size thresholds apply to this threshold.

Measures — 100a [(ACDCALLS + 
CONNECTCALLS) / INCALLS]

Call Profile Abandon 
per Service Level 
Increment

Description — Number of abandoned calls to this 
VDN for any service level increment. A single report 
threshold applies to all of the values. If the number of 
abandoned calls for the VDN reaches the threshold for 
any of the service level increments, the value for that 
service level increment is highlighted.

Measures — ABNCALLS1 through ABNCALLS10

Average Speed of 
Answer

Description — Number of seconds, on average, before 
a call to this VDN is answered. This value is the time 
callers spent in queue or ringing before being 
answered, divided by the number of calls queued to the 
VDN that were answered by an agent at this VDN.

NOTE:
Sample Size thresholds apply to this threshold.

Measures — AVG_ANSWER_SPEED

Threshold Description/database item or calculation
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Average Talk Time Description — Average length of time that is spent on 
ACD calls to the VDN.

NOTE:
Sample Size thresholds apply to this threshold.

Measures — AVG_ACD_TALK_TIME

Average Time to 
Abandon

Description — Average length of time that callers 
waited before abandoning calls to the VDN.

NOTE:
Sample Size thresholds apply to this threshold.

Measures — AVG_ABANDON_TIME

Rolling Average Speed 
of Answer

Description — Switch-based Rolling Average Speed 
of Answer for this VDN. The Rolling Average Speed 
of Answer is the average speed of answer across 
intervals.

Measures — ASA

Threshold Description/database item or calculation
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Report Options 7

Use the Options window to:
● Set the ACD and other general options to which Supervisor defaults when 

you log in. See “Options General tab” on page 7-75 for more information.

● Set up the colors that will be used in your graphical reports. See “Options 
Report Colors tab” on page 7-77 for more information.

● Set up the colors that will be used in reports to tell you when threshold 
highlights (not exceptions thresholds) are reached. See “Setting report 
threshold highlights” on page 7-56 for more information on threshold 
highlights.

● Choose or create a name format using {name} for Dictionary Name, 
{entity} for entity type, and {number} for entity number. The name format 
determines how items are displayed in reports. For instance, if you select 
the name format of {entity}{number}, all of the entities, that is splits/skills, 
ACDs, VDNs, vectors, trunks, trunk groups, call work codes, and AUX 
codes, that can be named in the Dictionary are displayed as the entity type 
and number instead of the Dictionary name. If you selected {name} as the 
name format, the names that are assigned to the entities in the Dictionary 
are displayed.
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Options General tab 7

NOTE:
The General tab is accessible when you are connected to a CMS server.

The following figure shows the General tab on the Options window. This 
figure shows the default settings for the General tab.

Use the General tab to set your first calendar day, default ACD, and other 
general options.
● First Day of Week. This option affects only how the calendar is displayed. 

It does not change the CMS Start of Week day for weekly data collection 
(the CMS Start of Week day is set through the System Setup—Storage 
Intervals window). For example, if you browse for a date, the calendar 
starts the week based on the day that you choose.

Use the drop-down list to make your selection.

● Default ACD. When you select an ACD, that ACD is the default that is 
listed in the functions windows and drop-down list options. 

Use the drop-down list to make your selection.
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● Synchronize PC and CMS Time at Login. Select this check box to set the 
PC’s clock to read the same time as the CMS clock. If you do not activate 
this selection, the PC clock and the CMS clock may not read the same time. 
This does not affect the CMS clock.

● Use Sound. Select this check box to receive an audible alert when the 
Exceptions Indicator box is updated. The Exceptions Indicator box is on 
the Controller status bar. The sound that you hear is the sound that you 
chose for the exclamation event that is associated with your PC.

NOTE:
Threshold Highlighting does not use sound. It uses color only as an 
indicator of a threshold being met.

● Use Tooltips. Select this check box to make tooltips visible. For example, 
when you are working in the Supervisor Controller window, you can place 
your mouse cursor over a toolbar button and the system displays a yellow 
box that provides a brief description of that button.

● Use Taskbar Icon. Select this check box to use the Supervisor system tray 
icon feature. See Chapter 5, "Getting started with CentreVu Supervisor" for 
more information on using the Supervisor system tray icon.

● Window Menu Sort Order. Use this item to determine how the items that 
display in the system tray icon menu are sorted. This item is only available 
is you select the Use Taskbar Icon.

— Start Order. Select this button to display the items in the system tray 
icon menu in the order in which you started them from Supervisor. 

— Alphabetical. Select this button to display the items in the system tray 
icon menu in alphabetical order, regardless of the order in which you 
started them.
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Options Report Colors tab 7

NOTE:
The Report Colors tab is accessible when you are connected to a CMS 
server.

The following figure shows the Report Colors tab on the Options window. 
This figure shows the default settings for the Report Colors tab.

Use the Report Colors tab to set up the colors that are used in your graphical 
reports. 
● Scheme. There are two ways to select the report color scheme that you 

want to use for Supervisor reports:

— From a series of predefined color schemes. Use the Scheme drop-
down list to select a different scheme from the one that is currently 
displayed.

— By creating a new color scheme. See “Creating a new report color 
scheme” on page 7-82 for instructions on creating report color 
schemes. 
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● Background. There are two choices for the background color of reports:

— White. Select this button to make the background of all reports white.

— Automatic. Select this button to make the background of all reports 
match the color that you set up for the PC in Microsoft Windows.

Options Threshold Colors tab 7

NOTE:
The Threshold Colors tab is accessible when you are connected to a 
CMS server.

The following figure shows the Threshold Colors tab on the Options window. 
This figure shows the default settings for the Threshold Colors tab.
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Use the Threshold Colors tab to set up the colors that are used in reports to tell 
you when exceptions thresholds are reached. 
● Scheme. There are two ways to select the report color scheme that you 

want to use for Supervisor reports:

— From a series of predefined color schemes. Use the Scheme drop-
down list to select a different scheme from the one that is currently 
displayed.

— By creating a new color scheme. See “Creating a new report color 
scheme” on page 7-82 for instructions on creating report color 
schemes. 
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Options Name Format tab 7

NOTE:
The Name Format tab is accessible when you are connected to a CMS 
server.

The following figure shows the Name Format tab on the Options window. 
This figure shows the default settings for the Name Format tab.

Use the Name Format tab to choose or create formats for how CMS entities, 
that is, splits/skills, ACDs, VDNs, vectors, trunks, trunk groups, call work 
codes, and AUX codes, are displayed in Supervisor. The display can be set to 
any one or a combination of {name} for Dictionary Name, {entity} for entity 
type, and {number} for entity number.
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Defining the name format 7

To define the name format for entities:

1. From the Entity box, select the item for which you want to set formats.

2. In the Format text box, use one of the following methods to select a 
format:
● Type the format that you want ({name}, {entity}, and/or {number}), 

or 

● Use the drop-down list to choose from a set of preformatted options.

For example, if you want to display agent names and extension 
numbers on reports, enter {name} {number} in the Format box. 

The Example box provides an example of what the format looks like 
based on your current definition.

3. Perform one of the following actions, depending on whether you want to 
save the changes:
● Select OK to save your changes. 

● Select Cancel to clear your changes. 
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Creating a new report color scheme 7

To create a new color scheme for reports:

1. Use one of the following methods to open the Options window:
● From the Tools menu, select Options.

● Select the Options button  on the toolbar.

2. Select the Report Colors tab.

3. From the Scheme drop-down list, select the color scheme with which you 
want to begin.

The system displays the view of the scheme:

4. From the Background options list, select White or Automatic.

5. Click the color bar (1 through 16) that you want to modify.
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6. Select either the Color Selector or the Pattern Selector button.

If you select the Color Selector button, the system displays the following 
window:

If you select the Pattern Selector button, the system displays the following 
box:

7. Perform one of the following actions to select a new color or pattern.
● Choose from the Basic colors palette.

● Create a custom color using standard Microsoft Windows procedures.

● Click the pattern that you want from the Pattern Selector window.
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8. Repeat Step 5 through Step 7 until you have updated all of the color bars 
that you want to modify.

! CAUTION:
If you do not save the new color scheme using the Save As button, the changes 
that you have made will overwrite the default color scheme that you modified.

9. When you are done modifying color bars, select the Save As button.

The system displays the following window:

10. Type the name of the report color scheme that you created in the text box.

11. Select OK to save the scheme and the scheme name.

NOTE:
To view the changes that you made to a color scheme at any point in the 
modification, select Apply. When you do this, the current color scheme is 
applied to any reports that are running.
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Creating a new threshold color scheme 7

To create a new threshold color scheme for reports:

1. Use one of the following methods to open the Options window:
● From the Tools menu, select Options.

● Select the Options button  on the toolbar.

2. Select the Threshold Colors tab.

3. From the Scheme drop-down list, select the color scheme with which you 
want to begin.

The system displays the view of the scheme:

4. Select the element of threshold highlighting that you want to modify colors 
for from the list box.

The system displays the current setting for the element to the right of the 
list box.
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5. Set the color that will be displayed as text: 

a. Select the Color Selector button that is next to the Text display box.

The system displays the following window

b. Perform one of the following actions to select a new color.

● Choose from the Basic colors palette.

● Create a custom color using standard Microsoft Windows 
procedures.

c. Select OK when you are done.

The system displays the Options window.
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6. Set the color that will be displayed as the background on the threshold 
element:

a.Select the Color Selector button that is next to the Background display 
box. 

The system displays the Color palette.

b. Perform one of the following actions to select a new color.

● Choose from the Basic colors palette.

● Create a custom color using standard Microsoft Windows 
procedures.

a. Select OK when you are done.

The system displays the Options window.

7. Repeat Step 4 through Step 6 until you have updated all of the threshold 
element colors that you want to modify.

8. When you are done modifying the threshold element colors, select the 
Save As button.

The system displays the Save Scheme As window:

9. Type the name of the threshold color scheme that you created in the text 
box.

10. Select OK to save the scheme and the scheme name.

NOTE:
To view the changes that you made to a color scheme at any point in the 
modification, select Apply. When you do this, the current color scheme is 
applied to any threshold highlights that are displayed on running reports.
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Creating a new name format 7

To create a new name format:

1. Use one of the following methods to open the Options window:
● From the Tools menu, select Options.

● Select the Options button  on the toolbar.

2. Select the Name Format tab.

3. In the Entity list, select the CMS entity for which you want to change the 
name format.

4. In the Format text box, use the drop-down list to select one of the standard 
formats, or type in a name combination.

5. Select OK.

6. If you typed a nonstandard name format in Step 4, the format is not saved 
in the Format list as a standard option.

To select another name format, select the Name Format tab, select the 
format, and then select OK.
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Exiting and restarting reports 7

To exit a report and return to the Supervisor Controller window:

1. Perform one of the following actions:

● Double-click the System button.

● Select Close from the System button menu.

● Select Exit from the Report menu.

NOTE:
If the system shuts down due to an error, any changes that you made to 
the report or reports that you are running are saved.

To restart a report, that is, return to the report input window:

1. From the Report menu, select Restart.

NOTE:
Work State drill-down reports and unsaved reports that were created in 
the Report Wizard cannot be restarted.
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Overview 8

This chapter explains how to install the CentreVu Terminal Emulator 
(Terminal) software and gives an overview of Terminal. It also provides 
procedures for how to set up profiles for using Terminal. 

This chapter includes the following sections:
● “Using CentreVu Terminal Emulator with CentreVu Supervisor” on page 

8-3

● “Installing Terminal Emulator” on page 8-4

● “Opening and exiting CentreVu Terminal Emulator and CentreVu CMS” 
on page 8-5

● “Using CentreVu Terminal Emulator” on page 8-10

● “CentreVu Terminal Emulator messages” on page 8-24



  
 CentreVu Supervisor V9 Installation and Getting Started
Installing and using CentreVu Terminal Emulator
Overview 8-2

About CentreVu Terminal Emulator
Terminal is packaged with the CentreVu Supervisor (Supervisor) software. 

Terminal is a software application that emulates a 615 Color (615C) terminal. It 
is used to access the CentreVu Call Management System (CMS) server from a 
PC that is running Microsoft Windows*. You can use Terminal with any CMS 
server that supports 615 or 615C terminal types.

NOTE:
Terminal must be separately installed. It is not automatically installed 
with Supervisor Version 9. 

*Microsoft Windows is a trademark of Microsoft Corp.
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Using CentreVu Terminal Emulator with 
CentreVu Supervisor 8

If you are using Supervisor and Terminal, you will use Terminal for the 
following CMS capabilities:
● ACD Administration — Vector Contents.

NOTE:

You can also use Visual Vectors to access vector information and edit 
vectors.

● cmsadm and cmssvc command capabilities.

● Solaris* system command capabilities.

● INFORMIX† database commands.

● Forecast.

● Shortcuts.

● Timetables.

● Creating and editing CMS custom reports.

● Administering ACDs for Generic 2.2 switches with the Expert Agent 
Selection (EAS) feature. For all of the other switches with EAS, you may 
use Supervisor to perform ACD Administration operations (except for 
Vector Contents) and run the applicable configuration reports.

* Solaris is a registered trademark of Sun Microsystems, Inc.
† INFORMIX is a registered trademark of Informix Software, Inc.
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Installing Terminal Emulator 8

To install Terminal:

1. In the directory that contains the Supervisor files, find the Terminal setup 
file, SetupTrm.exe.

2. Double-click the SetupTrm.exe file to begin the installation.

After a short wait, the system displays the Terminal Emulator Setup 
Welcome window.

3. Select Next to proceed with the installation. 

4. Follow the instructions that the system displays on the windows to install 
Terminal.

When the Installation is finished, the system displays the Installation 
Completed window. 

5. Select Finish to return to your desktop.

You can now begin using Terminal.
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Opening and exiting CentreVu Terminal 
Emulator and CentreVu CMS 8

This section includes the following information:
● “Opening CentreVu Terminal Emulator” on page 8-6

● “Logging in to CentreVu CMS” on page 8-7

● “Exiting Terminal” on page 8-9
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Opening CentreVu Terminal Emulator 8

To open Terminal:

1. From the Microsoft Windows* Start menu, select Programs > Avaya 
CentreVu Supervisor 9.0.

2. Select CentreVu Terminal from the Avaya CentreVu Supervisor menu.

The system displays the Terminal window with no connection active:

The size of the Terminal window is fixed at 24 rows by 80 columns, but the 
system resizes the window based on font size.

*Microsoft Windows is a trademark of Microsoft Corp.
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Logging in to CentreVu CMS 8

To log in to CMS:

1. From the Profile menu, select Open.

NOTE:

If you do not have a profile created, see “Creating profiles” on page 8-15.

When you select a connection profile, a connection is initiated and the 
system displays a status window. The system closes the status window 
when the connection is established. If the connection is established through 
the network or a dedicated serial line, you see the CMS login: prompt. 
If the connection is established through a modem, the modem dials the 
number of the remote host and then attempts to connect.

NOTE:

If you want to stop the login process but keep Terminal running, select 
Disconnect from the Connection menu. If you want to stop the login 
process and close Terminal, select Exit from the Profile menu.

Once a connection has been established, log in to the remote CMS host using 
standard CMS login procedures.
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2. At the login: prompt, type your CMS login ID, and press Enter.

3. At the Password: prompt, type your CMS password (it does not 
display on the screen), and press Enter.

4. At the Terminal type: prompt, type 615c or CVTERM, and press 
Enter.

NOTE:

Terminal does not use cvsup as the terminal type.

The system displays the CMS Main Menu. 

NOTE:

If the system displays a prompt, such as $ or #, instead of the terminal 
type prompt or the CMS Main menu, type cms, and press Enter.
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Exiting Terminal 8

To exit Terminal:

1. From the CMS Main Menu, select Logout. 

The system displays a window indicating that the CMS connection was 
dropped.

NOTE:

If the system displays a prompt, such as $ or #, instead of the terminal 
type prompt or the CMS Main menu, type exit, and press Enter.

2. Perform one of the following actions:
● Select OK

● Press Enter

3. From the Profile menu, select Exit. 

NOTE:

If you select Exit or try to close the Terminal window while a connection is 
active, the system displays a message informing you of this and asking if 
you want to exit anyway. Select Yes to end the CMS connection and exit 
Terminal, or select No to keep the connection active and ignore the Exit 
request.
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Using CentreVu Terminal Emulator 8

This section contains the following information:
● “CentreVu Terminal Emulator window” on page 8-10

● “Creating profiles” on page 8-15

● “Editing profiles” on page 8-17

● “Setting profile options” on page 8-18

CentreVu Terminal Emulator window 8

The following figure shows the Terminal window:

Title bar

Menu bar

Application window

Function keys
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The Terminal window contains the following items:
● Title bar. Displays “Avaya CentreVu Terminal” and the name of the 

current connection profile. If no profile is currently selected, “untitled” is 
displayed instead of the profile name.

● Menu bar. Includes the Profile, Edit, Connection, Reset, and Help 
menus.

● Application window. The area of the screen where you log in to CMS and 
use CMS.

● Function keys. The keys at the bottom of the Terminal’s main window. 
Initially, these keys are not visible. After you have logged into CMS, the 
function keys are appropriately labeled and work the same as the standard 
CMS Screen-Labeled Keys (SLKs). 

See CentreVu® CMS R3V9 Administration, 585-214-015, for definitions of 
and instructions for using the function keys and their associated menus.

Menu bar 8

The following sections describe the menus on the Terminal menu bar, each 
menu item, and the action each menu item performs.

Profile menu 8

From this menu you, can create, open, and save a connection profile. You 
can also exit Terminal from this menu. Profiles are used to store 
information that is related to how a particular user connects to the remote 
host. The following table lists the items on the Profile menu and describes 
the action that each item performs.

Menu item Action

New Creates a new connection profile. By default, this 
connection profile is named “profile 1” until you save 
it. This item is unavailable if a connection is already 
active.
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Open... Opens an existing connection profile. The system 
displays a window with the current profiles listed 
when this menu item is selected. Once you select a 
profile to open, that profile becomes the first profile 
in the list of recently accessed profiles. This item is 
unavailable if there is already a connection active.

Save Saves the current connection profile.

Save As... Brings up a window that requests a name under 
which to save the profile. Existing profile names are 
listed in the Save Profile As window. You can select 
one of these names or enter a new profile name in the 
Profile Name text box. If you use an existing profile 
name, the system displays a message that warns you 
that you are overwriting the contents of an existing 
profile.

1...4 Displays the four most-recently opened connection 
profiles. You can choose a numbered profile for quick 
access. The most recently selected profile that you 
choose becomes profile number 1, and the other 
items are renumbered accordingly. These items are 
unavailable if there is a connection already active.

Exit Exits Terminal. If there is a profile that was modified 
but not saved, a warning message is displayed.

Menu item Action
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Edit menu 8

From this menu, you can copy selected text to the Microsoft Windows 
Clipboard, paste the contents of the Clipboard to a remote host computer, 
and clear the contents of the Clipboard. In this case, “pasting” means 
sending the selected text to the screen as if it were typed by the user. The 
capability to cut text is not supported by Terminal. The following table lists 
the items on the Edit menu and a brief description of the action each item 
performs. You can also use the basic Microsoft Windows keyboard 
shortcuts.

Connection menu 8

From this menu you can connect to, disconnect from, or send a break to a 
remote host computer. You also use this menu to set up or change Terminal 
options, that is, communications, modem, and font. The following table 
lists the items on the Connection menu and describes the action that each 
item performs.

Menu item Action

Copy Copies the selected text to the Microsoft Windows 
clipboard.

Paste Pastes (sends) the contents of the Microsoft 
Windows clipboard to the location of your cursor 
on your PC as if you had typed it in.

Clear Clears the contents of the Microsoft Windows 
clipboard.

Menu item Action

Connect Establishes a connection to a remote host computer 
as specified in the active connection profile. If a 
connection is already active, this menu item is 
unavailable.

Disconnect Disconnects the active connection. If there is no 
active connection, this menu item is unavailable.
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Reset menu 8

From this menu, you can reset the terminal for Terminal Emulator. This 
provides a way to log in to Audix and the switch.

Help menu 8

From this menu, you can get online Help for Terminal. The following table 
lists the items on the Help menu and describes the action that each item 
performs.

Send Break Sends a “break” sequence to a remote host 
computer. A break is used to temporarily suspend 
an operation or transmission. If your connection is 
“hung up” and the host appears not to respond 
when you press keys on your keyboard, try 
sending a break.

Options... Brings up a window from which you can set up or 
change Terminal options. Terminal options are 
grouped under three tabs: Communications, 
Modem, and Font. 

Menu item Action

Contents Displays a table of contents of Help topics.

Technical Support Shows how to get Terminal technical support.

About... Opens the Terminal Help About window.

Menu item Action
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Creating profiles 8

To create a profile:

1. Open Terminal.

2. From the Profile menu, select New.

The system displays the Options window:
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3. Set the Terminal options.

NOTE:

The Terminal Options are grouped under three tabs: Communications, 
Modem, and Font. See “Communications tab” on page 8-19, “Modem tab” 
on page 8-21, and “Font tab” on page 8-22 for procedures on setting the 
options in each tab.

4. Select Save As from the Profile menu.

The system displays the Save Profile As box:

5. Type the name of the profile in the Profile Name text box

6. Select OK.

NOTE:

If you want to overwrite an existing profile with one you have just created, 
double-click the name in the list box.
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Editing profiles 8

To edit an existing profile:

1. From the Profile menu, select Open.

2. Choose the name of the profile that you want to edit.

3. Select Open.

4. From the Connection menu, select Options.

5. Edit the profile.

6. Select OK.

7. From the Profile menu, select Save. 
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Setting profile options 8

From the Connection menu, select Options to set up how you will connect to 
the CMS host computer. The following sections describe the options that are 
available and give illustrations of settings for standard Terminal profiles.

The following figure show the Options window with the Communications tab 
active.

When you are working in any of the windows, the following conventions are 
used:
● Select OK to set your current settings in the selected profile and close the 

Options window.

● Select the Cancel button to close the window without accepting the current 
settings.

● Select the Help button to open a Help window that provides help on the 
currently selected folder tab.

Communications tab Modem tab Font tab
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Communications tab 8

Select the Communications tab to display the window that lets you set up or 
change the options for connecting to a remote host computer.

Select Network, Serial, or Modem from the Connection box. The following 
sections provide explanations and examples of the settings that are required for 
each type of connection.

Network connection settings 8

Select Network if you are connecting to the remote CMS through a 
network. The following figure shows an example of standard settings for a 
network connection:

In the Network Settings area, enter the following required information for 
this setting:

● CMS Network Address. Enter the name or the Internet Protocol (IP) 
address of the remote host. There is no default.

● Network Port. Enter the network port that you want to connect. The 
default is 23, which is the network port reserved for Telnet. 

NOTE:

Do not change these settings unless you are instructed to do so by your 
network administrator.
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Serial and Modem connection settings 8

Select Serial if you are connecting to the remote CMS through a serial 
connection. Select Modem if you are connecting to the remote CMS using 
a modem. The following figure shows an example of standard settings for a 
serial or modem connection:

In the Serial and Modem Settings area, enter the following required 
information for this setting:

● Port. Select the communication (COM) port you will use to connect to 
the CMS server from the drop-down list. The options are COM1, 
COM2, COM3, and COM4.

● Baud Rate. Select the baud rate from the drop-down list. The options 
are 110, 300, 600, 1200, 2400, 4800, 9600, and 19.2K.

● Flow Control. Select the flow control from the drop-down list. The 
options are None, Xon/Xoff (software), Rts/Cts (hardware), or Both.

● Parity. Select the parity setting from the drop-down list. The options 
are None, Odd, Even, Mark, and Space.
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● Data Bit. Select the number of data bits from the drop-down list. The 
options are 5, 6, 7, and 8.

● Stop Bits. Select the number of stop bits from the drop-down list. 
The options are 1, 1.5, and 2.

NOTE:

Do not change these settings unless you are instructed to do so by your 
network administrator.

Modem tab 8

Select the Modem tab to set up or change dial strings for connecting to the 
remote CMS through a modem port. The following figure shows an example of 
standard modem settings:

Use the following information to set up the modem connection:
● Phone Number. Enter the telephone number of the remote host.

● Dial Prefix. Enter the characters to send to the modem before the 
telephone number of the remote host. For example, if a “9” must be dialed 
before the telephone number, enter 9 after the phrase ATDT (ATDT9).
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● Dial Suffix. Enter the characters to send to the modem after the telephone 
number of the remote host. For example, if an extension must be dialed 
after the telephone number of the remote host, enter it here.

● Hangup String. Enter the characters to send to the modem to cause it to 
hang up the connection. The default is ATH.

● Reset String. Enter the characters to send to the modem to cause it to reset 
itself. The default is ATZ.

● Auto Retry. Turns the auto retry option on or off. If the check box is not 
selected, the modem tries only once to establish a connection to the remote 
host.

● Time (seconds) allowed for connection. Enter the maximum time to wait 
for the connection to be established. The valid values are 1 to 999 seconds. 
The default value is 45 seconds.

Font tab 8

Select the Font tab to change the font size that is used by Terminal when you 
are logged in to CMS. The following figure shows an example of the standard 
font settings for Terminal:
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In the Font Sizes area, select one of the following: 
● Small. This font is approximately 8 points. It is appropriate for video 

displays that have a resolution of 640 x 480 (VGA) or less.

● Medium. This font is approximately 9 points. It is appropriate for video 
displays that have a resolution of 800 x 600 or 1024 x 768. Medium is the 
default font size.

● Large. This font is approximately 10 points. It is appropriate for video 
displays that have a resolution of 1024 x 768 or greater.

● The Sample text box shows what the selected font size looks like.
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CentreVu Terminal Emulator messages 8

There are two types of messages you can receive when using Terminal:
● “Error messages” on page 8-24

● “Information messages” on page 8-25

Error messages 8

The following messages are displayed in a window with an OK button:

Unable to connect to the remote host. 8

Terminal failed to connect to the remote host. If the reason for failure can be 
determined, the system displays one of the following messages:
● Busy, no answer.

● The remote host is not responding.

● The network is not responding.

The connection to the remote host was lost. 8

Some possible causes for this message are:
● The remote host crashed.

● The network dropped the connection.

● The modem hung up the line.

The profile name does not exist. 8

The system displays this message if you try to open a profile with the specified 
name and it does not exist.
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Information messages 8

The following messages are displayed in a box with Yes and No buttons:

The profile name exists, replace? 8

The system displays this message if you try to save a profile with the specified 
name and it already exists.

Save changes to name? 8

The system displays this message if you try to exit Terminal without saving 
changes to the profile with the specified name.

A connection is active, exit anyway? 8

The system displays this message if you try to exit Terminal while a connection 
is active.
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Troubleshooting 9

Overview 9

If you are having trouble with any of the procedures in this document, read this 
section before you call the National Customer Care Center. The problem may 
be something simple that you can quickly solve yourself.

If the information in this section does not help you to solve the problem, contact 
the Avaya National Customer Care Center on 1-800-242-2121. For support 
outside of the United States, contact your Avaya representative or distributor. 
Avaya also offers fee-based installation consultation.

If you receive any error messages in the course of a failed installation, record 
the messages to assist National Customer Care Center personnel in diagnosing 
the problem.
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Troubleshooting tips 9

This section will help you with problems you may encounter when installing 
CentreVu Supervisor (Supervisor), logging in to Supervisor, or running 
Supervisor. It contains tables that describe the error messages that may be 
displayed in Supervisor.

Installation error messages 9

Use the following information to help you with error messages encountered 
while installing Supervisor on a network server or installing Supervisor on a 
PC. The following types of error messages can appear:
● Information. Indicates that the error will not affect the success of the 

installation. Also indicates that you do not have privileges to perform the 
installation.

● Warning. Indicates that the error may affect the success of the installation.

● Severe. Indicates that the installation will fail, and that Setup will exit.

Error message Corrective action Type

Installing to the WINDOWS 
or WINDOWS SYSTEM 
directories is not permitted. 
Select another directory.

 Select another directory. WARNING

Invalid directory name 
specified.

Provide a valid directory 
name.

WARNING

Invalid Location. You cannot 
install CentreVu Supervisor 
to a floppy drive. Please 
select another location.

Select another drive. WARNING
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Perform Rollback? This 
installation did not complete. 
Would you like to rollback 
the changes that were made 
during the partial 
installation?

Select Yes to delete files that 
were installed or to reinstate 
files in the registry that were 
changed during the partial 
installation.

SEVERE

Setup has determined that 
CentreVu Supervisor 9.0 was 
previously unsuccessfully 
attempted to be installed on 
this computer. Since the PC 
configuration was changed, 
Setup will attempt to restore 
the PC to its original 
configuration (cleanup) 
before continuing with 
Setup.

Select Next to continue with 
the installation. It is 
important that the PC is 
restored to its original 
configuration, or Supervisor 
may not install or run 
correctly. 

SEVERE

The drive selected either 
does not exist or has 
insufficient space available.

Enter a different destination 
drive.

Select another drive. WARNING

You do not have 
administrative privileges. 
Please log on as 
administrator and install 
Centre Vu Supervisor 9.0.

Contact your system 
administrator, or select a PC 
on which you have 
administrative privileges.

INFORMA
TION

Error message Corrective action Type
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Login error messages 9

Use the following information to help you with problems you may encounter 
when logging in to the CentreVu Call Management System (CMS) server.

Error message Corrective action

A bad or invalid WINSOCK.DLL 
was detected on the system. Please 
correct this problem and try again.

Reinstall network stack.

An action cannot be completed 
because a component (cvsServer) is 
not responding. Choose “Switch To” 
to activate the component and 
correct the problem.

Select Switch To to correct the 
problem. If the problem still exists, 
install Dcom95 before attempting to 
run Supervisor again. (See “Other 
Requirements” on page 1-12 for 
further information.)

Could not communicate with the 
modem.

Make sure that the communications 
and modem settings are correct. Use 
the Communications and Modem 
tabs in the Options window to verify 
and change settings.

Could not connect to the server Try again. If you still have trouble 
after your third attempt, contact your 
system administrator to see if the 
server is working properly.

Your CentreVu Supervisor software 
is not compatible with the 
CentreVu CMS server software. 
The CentreVu CMS server must be 
upgraded before you can log in. 
Contact your system administrator.

Contact your system administrator.



  
 CentreVu Supervisor V9 Installation and Getting Started
Troubleshooting
Troubleshooting tips 9-5

This version of CentreVu 
Supervisor is not compatible with 
the software on your CentreVu 
CMS server. Please upgrade your 
PC with the appropriate version of 
CentreVu Supervisor. Contact your 
CentreVu CMS system 
administrator.

Select a different server on which 
the CMS version that you selected 
is installed, or select a different 
CMS version (R3V6, R3V8, 
R3V9).

Contact your CMS system 
administrator.

Could not find the file 
DALEAPP.EXE in the Avaya 
CentreVu Supervisor directory. 
Please re-install this file into the 
Avaya CentreVu Supervisor 
directory or contact technical 
support.

Reinstall Supervisor. If you cannot 
solve this problem yourself, contact 
the National Customer Care Center 
on 1-800-242-2121.

Could not initialize 
communications.

Try again. If you still have trouble 
after your second attempt, contact 
the National Customer Care Center 
on 1-800-242-2121.

Could not initialize 
DALEAPP.EXE. Please try to login 
again or contact technical support

1. Exit Microsoft Windows.a

2. Open Microsoft Windows.

3. Try to connect again.

4. If this does not work, reinstall 
Supervisor and try to connect.

5. If this does not work, contact the 
National Customer Care Center 
on 1-800-242-2121.

Could not initiate a socket 
connection.

The network is not installed 
properly. Use the Bravo Tool to help 
you isolate the network problem, or 
contact your system administrator.

Error message Corrective action
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Could not open the specified serial 
port. Please check communications 
settings, correct any problems, and 
try again.

In the Options window, check the 
settings under the Communications 
tab. Check to see if any other device 
is connected to the port and that you 
have the correct port assigned.

Could not resolve the hostname 
’<user-entered server 
name>‘. Please check 
communications settings, correct 
any problems, and try again

The hostname was not recognized by 
the Domain Name Services (DNS). 
Try the IP address instead of the 
hostname. If this does not work, 
contact your system administrator.

The application could not be started 
because system memory is low. 
Please close some applications and 
try again.

Close any open applications and try 
again.

The application could not be started 
because the executable file is 
corrupt. Please reinstall CentreVu 
Supervisor or call Technical Support.

Remove Supervisor and reinstall it. 
If Supervisor still does not start, 
contact the National Customer Care 
Center on 1-800-242-2121.

The application could not be started 
because the executable was not 
found. Please reinstall CentreVu 
Supervisor or call Technical Support.

Reinstall Supervisor or contact the 
National Customer Care Center on 
1-800-242-2121.

The application could not be started 
because the path to the executable 
was not found. Please reinstall 
Avaya CentreVu Supervisor or call 
Technical Support.

Reinstalling Supervisor or contact 
the National Customer Care Center 
on 1-800-242-2121.

The carrier detect signal was lost. This is a modem-related problem. 
Try connecting again. If the problem 
persists, contact your system 
administrator.

Error message Corrective action
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The connection to the server has 
been lost, and CentreVu Supervisor 
must exit. Please try to connect 
again later.

This is a network-related problem. 
A nonrecoverable break in the 
network was received. Try to log in 
to the CMS server again. If the 
problem persists, contact your 
system administrator.

The connection to the server was 
lost.

This is a network-related problem. 
A nonrecoverable break in the 
network was received. Try to log in 
to the CMS server again. If the 
problem persists, contact your 
system administrator.

The file AOS.EXE is corrupt, so 
CentreVu Supervisor must exit. 
Please re-install this file into the 
Avaya CentreVu Supervisor 
directory or contact technical 
support.

Reinstall Supervisor. During the 
installation, make sure you do not 
skip icon installation. Or, contact 
the National Customer Care Center 
on 1-800-242-2121.

The file AOS.EXE is not in your 
Avaya CentreVu Supervisor 
directory, so CentreVu Supervisor 
must exit. Please reinstall CentreVu 
Supervisor.

Reinstall Supervisor.

The file WINSOCK.DLL could not 
be found. Please ensure that this 
file is on your workstation’s path.

Check for proper installation of the 
network. Contact your system 
administrator for help.

Error message Corrective action
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The maximum number of CentreVu 
Supervisor logins on the server has 
been reached. Please try again later.

The number of users that have been 
authorized to use Supervisor has 
been met. You will be denied login 
until the number of users fall below 
the authorized number. 

If you continue to have this problem, 
you can order more user licenses 
from the National Customer Care 
Center on 1-800-242-2121

The network connection to ’<user-
entered server name>‘ timed 
out.

Supervisor was unable to log in to 
the server. This error indicates that 
there may be a problem on the 
server. 

Contact your CMS Administrator.

The network connection was broken. There is possibly a problem with the 
network. Contact your system 
administrator.

The passwords you entered do not 
match. Please retype the passwords 
and try again.

Check to see if the Caps Lock key is 
on. If it is, turn it off. Then, retype 
the password and try again. 

The serial connection was broken. Try to log in to the CMS server 
again. If the problem persists, 
contact your system administrator.

The server did not recognize your 
Login ID and/or Password. Please 
try again.

Make sure that you entered the 
correct login ID and password. If 
you did, make sure that the Caps 
Lock key is not on.

The server did not respond to the 
login request. Try again?

This type of error occurs when the 
network is busy. Try again. If the 
problem persists, contact your 
system administrator.

Error message Corrective action
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The server does not support this 
version of CentreVu Supervisor. 
Please contact your system 
administrator.

There is an incompatibility problem 
between the server and Supervisor. 
Upgrade the CMS server or install 
an older version of Supervisor.

The server is currently in single-
user mode. Please try again later.

You are logging in to the CMS 
server when it is in single-user 
mode. Try again later.

The server is not set up to support 
CentreVu Supervisor. Please 
contact your system administrator.

Supervisor is not authorized on the 
server (either the number of 
Supervisor users = 0 or the feature 
is not authorized). Contact your 
system administrator.

The server refused the connection. In the Options window, check the 
Network Port number.

There was an unknown failure on 
the server.

Contact your CMS Administrator.

This version of CentreVu 
Supervisor is not supported by the 
server. Please contact your system 
administrator.

There is an incompatibility problem 
between the server and Supervisor. 
Upgrade the CMS server or install 
an older version of Supervisor.

You are not recognized as a valid 
server user. Please contact your 
system administrator.

Your login ID is not administered 
on the CMS server. Contact your 
system administrator.

Your new password must differ 
from the old by at least three 
character positions.

Choose another password. It must 
have at least three different 
character positions than your old 
password. It also must have at least 
two alphabetic characters, at least 
one numeric or special character, 
and must be six characters in 
length.

Error message Corrective action
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Your password may not be the same 
as or this similar to your login ID

Choose another password. It must 
have at least three different 
character positions than your old 
password. It also must have at least 
two alphabetic characters, at least 
one numeric or special character, 
and must be six characters in 
length.

Your password must be at least six 
characters in length.

Choose another password. Your 
password must have at least two 
alphabetic characters, and at least 
one numeric or special character.

Your password must contain at least 
two alphabetic characters, and at 
least one numeric or special 
character.

Choose another password. Your 
password must also be at least six 
characters in length.

Your UNIX shell is not set to 
/usr/bin/cms, so Automatic Login 
will not work properly. Please 
select Manual Login in the Options 
dialog box and try again.

On the Supervisor Controller, select 
Tools then Options... From the 
Options window, select Manual 
Login and try logging in to the 
CMS server manually. Call your 
system administrator to change 
your shell.

a. Microsoft Windows is a trademark of Microsoft Corp.

Error message Corrective action
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OCX and DLL incompatibilities 9

Supervisor and other applications on your PC use OCX and DLL files. Some of 
the OCXs and DLLs that Supervisor uses may already exist on the PC because 
they are used by other applications. Problems can occur when Supervisor uses 
existing OCXs and DLLs that are an incompatible with what Supervisor needs. 
These problems may appear as General Protection Faults (GPF), lockups, or 
other unexpected problems. To determine if this type of problem exists:

1. Perform one of the following actions:
● Remove everything from your StartUp group

● Hold down the Shift key and press the L key while starting.

2. Restart Microsoft Windows.

3. Run Supervisor. Make sure that Supervisor is the only application that is 
running.

NOTE:

If the problem went away, it means that other software loaded on your PC 
is using a OCX or DLL that is not compatible with Supervisor.

4. Start running the software that was in the StartUp group. 

If you still encounter problems, then you will not be able to run this software at 
the same time as you run Supervisor. If you have further questions, contact the 
Avaya National Customer Care Center on 1-800-242-2121. For support outside 
of the United States, contact your Avaya representative or distributor.

If you did not encounter problems, it is likely that this software is compatible 
with the version of OCX or DLL that Supervisor uses. 

Microsoft Windows swap files 9

Systems should be running with permanent swap files. This increases 
performance during swap file operations.
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Installing CentreVu Supervisor 9

Before you install Supervisor, make sure no other application is running. This 
includes items that may be in the Microsoft Windows StartUp group and items 
specified via the WIN.INI file load= and run= parameters. Restart Microsoft 
Windows after temporarily moving items from the StartUp group to another 
group and after “commenting out” the load= and run= lines of the 
WIN.INI file.

Preserving CentreVu Supervisor user profiles 9

In the event that there is a failure during a new or upgrade Supervisor 
installation, the old software can be reinstalled; however, if the user has any 
preferences set, these will be lost. Use the following procedure to preserve user 
preferences before a new installation or upgrade:

1. In the Microsoft Windows Explorer, locate the Avaya\CentreVu Supervisor 
folder (generally under Program Files).

2. Open the folder and copy the Profiles file tree to another location.

3. Reinstall or upgrade Supervisor.

4. Copy the saved profiles to the Profiles tree in the new Supervisor 
installation.

Resolving TCP/IP host name 9

In the event that initial configuration of the TCP/IP server for Supervisor has an 
error or other problem, use the following procedure to resolve host name 
problems:

1. To ensure that this is the problem, open an MS-DOS prompt or command 
prompt in Microsoft Windows.

2. Ping the CMS host. 

If the host cannot be found, contact your network administrator. If the host 
is found, the reply will contain the host’s IP address.

3. Check that the CMS host entry on the Domain Name Server (DNS) is 
correct. If it is wrong or missing, use the IP address returned to you to 
correct or create the entry.

4. Edit the LMHOSTS file on the user PC to include a line for the CMS 
server, which is:

server name <tab> IP address
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Proper operation of networking software 9

To ensure that the PC networking software is loaded and functional, you should 
test the networking connectivity to the target CMS server prior to running 
Supervisor. To test this functionality, use the network software’s own ftp/telnet 
application. If this works, but Supervisor still cannot establish connection, it is 
most likely a problem with the WINSOCK.DLL.

Problems with serial/modem connections 9

If you have a bad serial or modem connection, you will encounter slow data 
transfers and frequent loss of the serial connection. The Supervisor controller 
will report this as a “Serial Connection Broken” error message. If automatic 
login was selected, Supervisor will attempt to connect again.

What to check for if you have serial or modem connection problems:

1. Make sure that the RTS/CTS flow control string is selected in the Options 
window.

2. Check to see if your serial connection to the CMS server or modem is 
wired correctly for hardware flow control. For modem connections, make 
sure you have the correct cable wiring between the modem and the CMS 
server.

3. Your hardware flow control on the CMS server's serial ports must be on 
and functioning properly. Refer to the your SPARCserver documentation 
for correct configuration of hardware flow control for your respective 
serial communications.

4. 16550A UARTS must be in use on the PC running Supervisor. The 
following parameters in the [386Enh] section of the PC's SYSTEM.INI 
file should be set to:

COMnFIFO=1

Where n is the communications port being used. This will ensure that the 
FIFO buffer capability of the communications port will be used.

5. Some terminal server connections may require the addition of 
EscAllCtrl=1 in the [LINK] section of the Centrevu.ini file.
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Using a secondary system password on the CMS server9

If you use a secondary system password on your CMS server, set the 
[CONTROL] SystemPasswordPrompt= section in the Centrevu.ini file 
to a string that is the security password prompt of your CMS server. 

For example: 

[CONTROL]

SystemPasswordPrompt=External security:



   CentreVu Supervisor V9 Installation and Getting Started
Saving as HTML
Overview A-1

CentreVu
Supervisor

Saving as HTML A

Overview 1

The Save as HTML function is available with CentreVu Supervisor 
(Supervisor) Version 8 and newer releases. Save as HTML allows the user to 
export a snapshot of a report running in Supervisor and save it as an HTML file. 
Any report generated in Supervisor can be converted to an HTML file. This file 
can then be stored on a Web server for viewing on the Internet or an Intranet. 

To view the HTML file, your Internet browser must support tables and .gif 
graphic files. For example, Netscape Navigator* 3.0 or Microsoft† Internet 
Explorer 3.0, or later versions of either, support tables and .gif graphic files.

Here are some points to remember when using the Save as HTML function:
● Save as HTML does not automatically save the HTML file onto a Web 

server. You must copy the HTML file and any associated graphics to the 
Internet server you want to use. 

● Save as HTML does not automatically update the HTML for real-time 
reports.

*Netscape Navigator is a trademark of Netscape Communications Corporation.
†Microsoft Internet Explorer is a registered trademark of Microsoft Corp.
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● Save as HTML is found in the pull-down report menu on an open report.

● Save as HTML does not support 32-bit color mode for graphics saved 
using Save as HTML.

Using Save as HTML 1

To save a report as an HTML file, do the following:

1. While running the report you want to save, select Save as HTML from the 
Report menu, as shown below:
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The system displays the Save as HTML window:

2. In the Template section of the Save as HTML window, do one of the 
following:
● If you want to use a template, type the template file name in the 

template field, select the template from the drop-down history lists, or 
select the browse button and browse for a template.

● If you do not want to use a template, select the Do not use a template 
radio button.

3. In the Output section, select one of the following:
● Select Use CentreVu Supervisor fonts to preserve the report fonts 

as you see them in Supervisor.

● Select Use Web Browser default fonts to display the output file 
using Internet browser default fonts.

4. To specify the name of the HTML output file to be created, do one of the 
following:
● Type the name of the output file in the file name field.

● Select the file name from the pull-down history list.

● Select the browse button and browse for a file name.
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5. You can now do either of the following:
● If you want to schedule the creation of an HTML file, select the 

Script button at the bottom of the window. The Script button 
displays the Save as Script window, which lets you create a new 
script for the selected report, run the report, and save it in HTML 
format. The report will exit after the save is complete.

NOTE:

For more information on the Scripting feature, see CentreVu® CMS R3V9 
Administration, 585-214-015.
● Select the OK button to save the report in HTML file format. 

The HTML file that has been generated can be modified to fit your 
specific need using an HTML or text editor. The report can now be 
viewed with an Internet browser. 

Output files 1

You must select a name for the HTML file you are creating. You must specify 
the full file path (for example, c:\temp\myrpt.htm) to save the file in a 
directory other than the current directory.

If there are charts associated with the file, they are converted into .gif files and 
numbered in the order created. For example, c:\temp\myrpt1.gif and 
c:\temp\myrpt2.gif.

The output file is created using the templates and fonts you have specified. 
After the HTML is saved, you can move or copy it and all associated graphics 
files to a Web server directory for viewing on the Internet or an Intranet.
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Using templates 1

Templates are HTML files that can be created or edited using an HTML or text 
editor. A template can be used to provide company logos, background color, 
specific fonts, or surrounding text to the HTML file. The templates are limited 
by what your Web browser supports. Templates are installed with Save as 
HTML.

NOTE:

If you do not select a template, the HTML file displays only the report. 

Not using templates 1

If you choose not to use existing templates, Save as HTML does the following:
● Generates standard surround tags <HTML> and <BODY> in order for 

your report to be converted to HTML

● Sets the background color white and font color to black 

● Gives the page the same title as the report title.

Using existing templates 1

Supervisor provides you with templates to use when saving a report as an 
HTML file. Sample templates can be found in the samples directory of the 
Supervisor directory where the executable files were installed.
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Save as HTML template tags 1

The following table describes the tags used by Save as HTML and which can be 
used to create templates.

Fonts 1

If you choose to use the Supervisor fonts, the font face and size are preserved in 
the HTML file, as follows:
● The fonts used in Supervisor are Arial, Courier New and Times New 

Roman. 

● In the event these fonts are not available on the computer viewing the 
HTML file, backup fonts are used. The backup fonts are Helvetica for 
Arial, Courier for Courier New, and Times for Times New Roman.

● If you choose to use the Web browser’s default fonts, the HTML file will 
not specify any fonts, as follows:

— If you choose not to preserve the Supervisor fonts, the appearance of 
the report in the HTML file may change. 

— If you choose to use a template, do not preserve the Supervisor fonts if 
the template specifies the fonts.

HTML tag Description

<CVSUP_TITLE> This tag is replaced with the title of report in the 
HTML file. If this tag is used within the 
<TITLE> tags, the title of the report will be 
used as heading to the page. Multiple uses of 
this tag are allowed.

<CVSUP_BODY> This tag is replaced by the report body in the 
HTML file. However, only the first occurrence 
of this tag is replaced. If a template is used and 
the <CVSUP_BODY> tag is not in the 
template, an error occurs, and the Save as 
HTML operation is aborted.
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ACD See Automatic Call Distribution.

Actions Menu A menu in the upper-left corner of the 
Supervisor Operations windows. The menu 
lists the actions available for that particular 
user window (for example, add, modify, and 
delete). You select an action after entering the 
necessary data in the user window.

Add A Supervisor action that adds the data 
entered in the given window to the CMS 
database.

Add/Remove 
Programs 
Wizard

A Microsoft Windows feature that guides you 
through a series of steps in order to remove 
programs that have been installed on your 
computer. The Add/Remove icon is found in 
the Control Panel dialog box.



  
 CentreVu Supervisor V9 Installation and Getting Started
Glossary

GL-2

Administrator 
Privileges

Permissions assigned to a Centrevu 
Supervisor user in order to administer specific 
elements, such as installing CentreVu 
Supervisor on a network. Access permissions 
are specified as read or write permission. 
Read permission means the user can access 
and view only Supervisor data. Write 
permission means the Supervisor user can 
add, modify, or delete Supervisor data.

Agent A person who answers calls to an extension in 
an ACD split/skill. The agent is known to CMS 
by a login identification keyed into a voice 
terminal.

Agent 
Reports

A group of reports that give the status of 
agents in an agent group, selected splits or 
skills, or real-time information and statistics.

Agent Skill An attribute that is associated with an ACD 
agent. Agent Skills can be thought of as the 
ability for an agent with a particular set of 
skills to handle a call that requires one of a set 
of skills. An agent can be assigned up to four 
skills. 

Application 
Folder

A folder on the network server that holds 
CentreVu Supervisor application software—
executables and components.
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Automatic 
Call 
Distribution 
(ACD)

A switch feature using software that channels 
high-volume incoming and outgoing call traffic 
to agent groups (splits or skills). 

Also an agent state where the extension is 
engaged on an ACD call.

Automatic 
Script

A Supervisor feature that launches a new 
Supervisor session that logs into CMS and 
runs the requested tasks in the background. 
Actions do not display on the PC. See also 
Interactive Script and Script.

AutoPlay A Microsoft Windows feature that causes an 
application on a CD-ROM to run without any 
user interaction as soon as the CD-ROM is 
inserted into the drive.

Call 
Management 
System 
(CMS)

A software product used by business customers that 
have AT&T telecommunications switches and receive 
a large volume of telephone calls that are processed 
through the Automatic Call Distribution (ACD) feature 
of the switch. The CMS collects call-traffic data, 
formats management reports, and provides an 
administrative interface to the ACD feature in the 
switch.

CentreVu 
Advocate

A collection of ECS features that provide new 
flexibility in the way a call is selected for an agent in a 
call surplus situation and in the way that an agent is 
selected for a call.

Client A single PC that uses CentreVu Supervisor.
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CMS See Call Management System.

Controller A Supervisor feature that allows the user to 
access CMS reports and operations. The 
Controller includes a toolbar, a menu bar, a 
status bar, tooltips, and indicators/

Custom 
Reports

Real-time or historical reports that have been 
customized from standard reports or created 
from scratch.

Database A group of tables that store ACD data according to a 
specific time frame: current and previous intrahour 
real-time data and intrahour, daily, weekly, and 
monthly historical data.

Database 
Item

A name for a specific type of data stored in one of the 
CMS databases. A database item may store ACD 
identifiers (split numbers or names, login IDs, VDNs, 
etc.) or statistical data on ACD performance (number 
of ACD calls, wait time for calls in queue, current 
states of individual agents, etc.).

Database 
Table

CMS uses these tables to collect, store, and retrieve 
ACD data. Standard CMS items (database items) are 
names of columns in the CMS database tables.

Data Points Points of historical data. A data point should 
include data for each interval of the working 
day.

Delete A Supervisor action that removes the entry on 
the window from the CMS database.
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Designer 
Reports

Customized reports that can be created using 
CentreVu Supervisor’s Report Designer feature, and 
which are run from CentreVu Supervisor.

Dialog Box A small on-screen window that conveys or 
requests information from the user. This 
window can contain list boxes, text boxes, 
tabbed pages, and so forth.

Dictionary A CMS subsystem that can be used to assign names 
to various call center elements such as login IDs, 
splits/skills, trunk groups, VDNs and vectors. These 
names appear on reports, making them easier to 
interpret.

Edit Menu A menu on the Supervisor Operations 
windows. The menu lists the actions available 
for that particular user window (for example, 
cut, copy, and paste). 

Exception A type of activity on the ACD which falls 
outside of the limits you have defined. An 
exceptional condition is defined in the CMS 
Exceptions subsystem, and usually indicates 
abnormal or unacceptable performance on 
the ACD (by agents, splits/skills, VDNs, 
vectors, trunks, or trunk groups).

Exceptions 
Reports

Display occurrences of unusual call-handling 
events.

Find One A CMS action that searches the database for entries 
thatch the input value.
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Graphics A CMS reporting option that allows you to view some 
reports in bar graph format.

Grayed Out When you do not have access to a menu or action list 
item, it will be grayed out (that is, dimmed or displayed 
in a different color from the rest of the menu or action 
list).

Historical 
Reports

Display past ACD data for various agent, split/skill, 
trunk, trunk group, vector, or VDN activities. A report 
summary of call data into daily, weekly or monthly 
totals

HTML See HyperText Markup Language.

Hypertext A linkage between related text. For example, 
if you select a word in a sentence, information 
about that word is retrieved if it exists, or the 
next occurrence of the word is found.

HyperText 
Markup 
Language

A standard for defining documents with 
hypertext links. See also Hypertext.

Input Field An area on window where you specify 
information that you would like to view, add, 
modify, or delete.

Installation 
Folder

A folder on the network that holds all of the 
CentreVu Supervisor files. Setup.exe is run 
from this folder to install Supervisor on each 
client computer.
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Integrated 
Reports

Integrated reports compile call center 
information from any starting point in the last 
24 hours up to and including the current 
interval.

Interactive 
Script

A Supervisor feature that runs the requested 
tasks in the current Supervisor session and 
displays the actions on the PC. You can input 
requested information while the script is 
running. See also Automatic Script and Script.

Jump In Help, a command that moves you from the 
currently displayed topic to another topic.

LAN See Local Area Network.

List All A CMS action that lists all the entries that matched the 
current field values.

Local Area 
Network 
(LAN)

Two or more computers connected by cable 
and using a suitable operating system and 
application software so they can directly share 
hard disks, printers, and other peripherals, 
and files.

Local 
Installation

With this type of installation, you install all of 
the Supervisor software to disk space local to 
each computer from a CD-ROM or from the 
network.

Log A file that contains a record of computer 
activity as well as backup and recovery data.
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Maintenance A CMS subsystem that is used for doing 
routine maintenance of the CentreVu CMS, 
such as backing up data, checking on the 
status of the connection to the switch, and 
scanning the error log.

Name Fields Fields in which you may enter a name (synonym) that 
has been entered in the Dictionary subsystem (for 
example, names of agents, splits/skills, agent groups, 
trunk groups, vectors, VDNs).

Network 
Server

A computer in a network shared by multiple users.

Pop-up A small window containing information that 
displays over a Help window.

Queue/Agent 
Reports

A group of reports that give the status of all 
top agents in a skill and queue status, or skill 
status for a selected skill.

Readme File A file that provides up-to-the-minute 
information on a newly released product; in 
this case, CentreVu Supervisor.

Read-Only A folder or file that can be read, but not 
updated or erased.
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Real-Time 
Reports

Display current ACD call activity on agents, 
splits/skills, trunks, trunk groups, vectors, and 
VDNs for the current or previous intrahour 
interval. Current intrahour interval real-time 
reports are constantly updated as data 
changes during the interval. Previous 
intrahour interval real-time reports show data 
totals for activity that occurred in the previous 
intrahour interval.

Registry The system-wide depository of information 
supported by Microsoft Windows. The registry 
contains information about the system and its 
applications, including clients and servers.

Report 
Designer

A CentreVu Supervisor feature that enables 
users to design their own reports.

Report 
Wizard

A CentreVu Supervisor feature that delivers 
user assistance, by way of a wizard, to quickly 
and easily generate new customized reports. 
The wizard provides instructional help that 
guides the user through a series of tasks that 
create a new customized report. Report 
Wizard is a supplement to Report Designer.

Run A Microsoft Windows command that lets you 
execute a program, such as Supervisor 
installation.
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Scripting A CMS feature lets you automate actions 
such as changing an agent’s skills, running 
reports, exporting report data, and many other 
CMS functions. For example, you can create 
a script to run a specified report and export 
the data on schedule. 

Scroll To use the bar on the side of the report 
window to move forward, backward, up, or 
down within a window.

Setup 
Program

A program that configures a system for a 
particular environment; for example, it informs 
the system of a new device or interface, such 
as CentreVu Framework.

Shared 
Installation

With this type of installation, the CentreVu 
Supervisor application software is installed to 
a shared application folder on the network 
server, but user-specific files and logs are 
stored in a Supervisor folder on each user’s 
PC or on their own network drive.

Shortcut An icon on your computer screen that enables 
you to select and run an application (for 
example, CentreVu Supervisor) quickly and 
easily.

Skill An attribute that is assigned to an ACD Agent. 
Agent Skills can be thought of as the ability for 
an Agent with a particular set of skills to 
handle a call which requires one of those 
skills. 
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Solaris 
System

A multi-user operating system developed by sun 
Microsystems. The operating system on which CMS 
runs.

Split A group of extensions that receives special-purpose 
calls in an efficient, cost-effective manner. Normally, 
calls to a split arrive primarily over one or a few trunk 
groups.

Standard 
Reports

The set of reports that are delivered with the CMS or 
CentreVu Supervisor software.

Start Menu The menu that appears when you click on the 
Start button in the Microsoft Windows taskbar. 
This menu contains programs and other 
Microsoft Windows applications.

Taskbar The bar that appears by default at the bottom 
of the Microsoft Windows desktop. You can 
click buttons that appear on this bar to switch 
between running programs.

Terminal A combination of monitor (video display) and 
keyboard used to communicate with a remote 
computer to type and display information. 

Terminal 
Emulator

A Supervisor software application that 
emulates a 615 Color (615C) terminal.

Toolbar A row of Controller buttons used to activate 
various functions of the Supervisor 
application.
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Tooltips Brief descriptions that display when the 
mouse pointer is over a toolbar button.

Trunk Group 
Report

Displays the status of each trunk in a selected 
trunk group.

UNIX System A multi-user operating system developed by 
AT&T in 1969. The operating system on the 
computer on which CMS runs.

User ID The login ID for a CMS user.

VDN See Vector Directory Number.

VDN Reports A group of reports that show profiles of 
current VDN performance, call handling 
information for a specific VDN based on skill 
preference, and how calls to specific VDNs 
have been handled.

Vector A list of steps that process calls in a user-
defined manner. The steps in a vector can 
send calls to splits, play announcements and 
music, disconnect calls, give calls a busy 
signal, or route calls to other destinations. 
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Vector 
Directory 
Number 
(VDN)

An extension number that enables calls to 
connect to a vector for processing. A VDN is 
not assigned an equipment location. It is 
assigned to a vector. A VDN can connect calls 
to a vector when the calls arrive over an 
assigned automatic-in trunk group or when 
calls arrive over a dial-repeating (DID) trunk 
group and the final digits match the VDN.

Vector Report A report that lists the number of calls to 
specific vectors.

Window A rectangular, on-screen frame through which 
you can view a menu, data entry fields, 
reports, or messages.
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Index
Symbols

% Axis check box, 7-34

Numerics

2-dimensional, 7-33
3D Effects Tab, 7-30

Depth to Height, 7-31
Elevation, 7-30
Projection, 7-31
Rotation, 7-30
Viewing Distance, 7-31
Width to Height, 7-31

3-dimensional, 7-33
Rotating, 7-46

A

About CentreVu Supervisor, 1-2
Above Point, label parameter, 7-37
ACD

Current, 5-42, 7-6
Selecting, 6-4, 7-6
Status Indicators, 5-27

Action Buttons, 5-41
Actions Menu, 5-41, 6-6

Add, 6-7, 6-11
Cancel, 6-7
Copy, 6-7
Create, 6-7
Delete, 6-7
Exit, 6-7
Find one, 6-7, 6-13
Get contents, 6-7
List all, 6-7, 6-12
List Devices, 6-7

Actions Menu, (continued)
Modify, 6-7
Next, 6-7, 6-13
Previous, 6-7, 6-13
Run, 6-8
Scripting, 6-8
Select tables, 6-8
Start, 6-8

Add Button, 6-7, 6-11
Add/Remove Button, 4-3
Agent Administration Button, 5-25, 5-31
Agent Administration icon, 7-39
Agent Real-Time icon, 7-39
Agent Thresholds, 7-62
All Data, Exporting, 7-16
Allow xx seconds, 8-22
Application Window, 8-11
Apply Button, 5-40
Auto Retry, 8-22
AutoPlay, Definition, 1-9
Axis

Display, 7-32
Tab, 7-32

B

Background Color, 7-29
Base, label parameter, 7-37
Baud Rate Setting, 8-20
Below Point, label parameter, 7-37
Browse Button, 5-42

Selecting Report Dates, 7-7
Selecting Report Times, 7-10
Using, 5-43 to 5-46

Browse Selector Window
Multiple Entries Input, 5-45
Single Entity Input, 5-44

Buttons
Add, 6-7, 6-11
Agent Administration, 5-25
Apply, 5-40
Browse, 5-42, 5-43 to 5-46
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Buttons, (continued)
Call Center Administration, 5-25
Cancel, 5-40, 6-7
Copy, 6-7
Create, 6-7
Delete, 6-7
Dictionary, 5-25
Exceptions, 5-25
Exit, 6-7
Find one, 6-7, 6-13
Get contents, 6-7
Help, 5-40
List all, 6-7, 6-12
List Devices, 6-7
Login, 5-20
Logout, 5-25
Maintenance, 5-26
Modify, 6-7
Next, 6-7, 6-13
OK, 5-40
Options, 5-20, 5-22, 5-25
Previous, 6-7, 6-13
Print Setup, 7-53
Reports, 5-25
Run, 6-8
Script, 5-40, 6-8, 7-49
Select tables, 6-8
Start, 6-8
System Setup, 5-26
User Permissions, 5-26

C

Call Center Administration Button, 5-25, 
5-31

Call Management System
Definition, 1-6
Supervisor Requirements, 1-15
System Capacities, 1-15

Cancel Button, 5-40, 6-7
Canceling Installation, 1-9
Category Name, data point label, 7-38
Caution Threshold icon, 7-41
Center, label parameter, 7-37

CentreVu Terminal Emulator
Creating profiles, 8-15 to 8-16
Definition, 8-2
Exiting, 8-9, 8-12
Installing, 8-4
Logging into CMS, 8-7, 8-8, 8-9
Messages

Error, 8-24
Information, 8-25

Using, 8-3, 8-10
Window, 8-10 to 8-11

Application, 8-11
Function keys, 8-11
Menu bar, 8-11
Title bar, 8-11

Change Agent Splits/Skills, 7-19
Chart Format Options

3D Effects Tab, 7-30
Axis Tab, 7-32
Data Point Labels Tab, 7-37
General Tab, 7-29
Legend Tab, 7-36
Title Tab, 7-35
Type Tab, 7-33

Chart Reports
Copying, 7-50
Metafile format, 7-50

Chart Type, 7-33
Charts

Copying data, 7-15, 7-50
Exporting Data, 7-15
Formatting, 7-17
Rotating a 3D, 7-46

Choosing a profile, 8-12
Clear All, 6-10
Client Setup, 3-11
Close Button, 5-20
CMS (see also Call Management 

System), 1-6
CMS Network Address, 8-19
CMS Operations

Deleting Database Items, 6-16
Finding database items, 6-12
Input window, 6-4
Menus

Actions, 6-6
Edit, 6-9
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CMS Operations, (continued)
Modifying database items, 6-14
Running, 6-3 to 6-5

CMS Server
Logging in, 5-21, 8-8

Password prompt, 8-8
Terminal type prompt, 8-8

Logging out, 8-9
CMS Server Requirements, 1-14
CMS Servers, 5-21
Color, Changing Threshold, 7-61
Column Width, changing, 7-52
Commands Menu, 5-29

Agent Administration, 5-31
Call Center Administration, 5-31
Dictionary, 5-30, 6-3
Exceptions, 5-30
Reports, 5-29

Communications Tab, 7-75, 7-77, 7-78, 7-
80, 8-19

Modem, 8-20
Network, 8-19
Serial, 8-20

Connect Menu, 5-21, 5-28
CMS Servers, 5-21
Exit, 5-28
Login, 5-21
Logout, 5-28

Connection Menu, 8-13, 8-14
Connect, 8-13
Disconnect, 8-13
Options, 8-14, 8-18
Send Break, 8-14

Connection, establishing, 8-7
Contents, Help, 1-11
Conventions, writing, P-5
Copy, 6-10
Copy Button, 6-7
Create Button, 6-7
Creating profiles, 8-11, 8-15 to 8-16
Current ACD, 5-42
Current Date and Time, 5-27
Custom icon, 7-40
Cut, 6-9

D

Data Bit Setting, 8-21
Data Point Labels Tab, 7-37

Above Point, 7-37
Base, 7-37
Below Point, 7-37
Category Name, 7-38
Center, 7-37
Inside, 7-37
None, 7-37
Outside, 7-37
Percent, 7-38
Right, 7-38
Series Name, 7-38
Value, 7-38

Dcom95 Installation, 1-13
Default ACD, 7-75
DEFINITY Enterprise Communications 

Server (ECS), 1-6
Delete Button, 6-7
Deleting Database Items, 6-16
Depth to Height, 7-31
Designing a report, 7-13
Dial

Prefix, 8-21
Strings, 8-21
Suffix, 8-22

Dictionary Button, 5-25, 5-30
Dictionary Commands, 6-3
Dictionary icon, 7-39
DLL Incompatibilities, 9-11
Drill-Down Reports, 7-18

E
Edit Menu, 5-41, 6-9, 7-15, 8-13

Clear, 8-13
Clear all, 6-10
Copy, 6-10, 7-15, 8-13
Cut, 6-9
Export All Data, 7-16
Export Chart Data, 7-15
Export Table Data, 7-16
Paste, 6-10, 8-13
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Editing Profiles, 8-17
Elevation, 7-30
Ending Interval, 7-10
Error Messages, 9-2 to 9-10

Installation, 9-2 to 9-3
Login, 9-4 to 9-10
Terminal, 8-24

Exception Count, 5-26
Exceptions

Button, 5-25
Icon, 7-39

Exceptions Button, 5-30
Exit, 6-7, 7-14

Reports, 7-89
Supervisor, 5-28

Exit Button, 6-7
Exiting Terminal, 8-9, 8-12
Export

All Data, 7-47
Chart Data, 7-47
Data window, 7-48 to 7-49
Table Data, 7-47

Exporting

Table Data, 7-47
All Data, 7-47
Chart Data, 7-47
Report Data, 7-47 to 7-49
Save as Script, 7-49

F

Find one button, 6-7, 6-13
Find Tab, 1-11
First Day of Week, 7-75
Fixed Columns, 7-25
Fixed Rows, 7-25
Flow Control Setting, 8-20
Font Tab, 8-22

Large, 8-23
Medium, 8-23
Sample Text, 8-23
Small, 8-23

Format Menu, 7-17
Chart, 7-17
Sort by, 7-17
Table, 7-17

Formatting Chart Reports
3D Effects Tab, 7-30
Axis Tab, 7-32
Data Point Labels Tab, 7-37
General Tab, 7-29
Legend Tab, 7-36
Title Tab, 7-35
Type Tab, 7-33

Formatting Table Reports
General Tab, 7-25
Sort Tab, 7-26

Function keys, 8-11

G

General Tab, 7-25, 7-29, 7-75
Axis Display, 7-32
Background Color, 7-29
First Day of Week, 7-75
Fixed Columns, 7-25
Fixed Rows, 7-25
Real-Time, 7-29
Show Gridlines, 7-25

Get Contents Button, 6-7

H

Hangup String, 8-22
Help, 1-10, 1-10, 1-11, 1-11, 5-22

About Help, 5-23
Button, 5-40
Contents, 1-11, 5-23
Find Tab, 1-11
Learning to use, 1-11
Main Categories (books), 1-10
On open windows, 1-11
Technical Support, 5-23
Topics, 1-10

Help Menu, 8-14
About, 8-14
Contents, 8-14
Technical Support, 8-14

Helpline, 1-9, 9-1, 9-11
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History List, 5-41
How to use, 5-47

HTML, Saving as, 7-13, A-1 to A-6

I

Icons
Agent Administration, 7-39
Agent Real-Time, 7-39
Caution Threshold, 7-41
Custom, 7-40
Dictionary, 5-25, 7-39
Exceptions, 5-25, 7-39
Logout, 5-25
Maintenance, 5-26, 7-39
Options, 5-20, 5-25
Other, 7-40
Previous, 6-7, 6-13
Reports, 5-25
Split/Skill, 7-40
System Setup, 5-26
Trunk, 7-40
User Permissions, 5-26
VDN, 7-40
Vector, 7-40
Warning Threshold, 7-41

Information Messages, Terminal, 8-25
Input Fields

Completing, 5-43
Definition, 5-41

Input Windows
Completing, 5-41
Definition of fields, 5-41

Inside, label parameter, 7-37
Install/Uninstall Tab, 4-2
Installation

Canceling, 1-9
CentreVu Terminal Emulator, 8-4
CMS Server

Requirements, 1-14
Dcom95, 1-13
Local, 2-1
Other Requirements, 1-13

Installation, (continued)
PC Requirements

Network Connection, 1-12
Serial Connection, 1-12
Windows 95, 1-13
Windows NT, 1-13

Service Pack 3, 1-13
Support, 1-9
Tips, 1-9

L

Large Font, 8-23
Left, label parameter, 7-38
Legend Tab, 7-36

Location, 7-36
Visible, 7-36

List all button, 6-12
List Devices button, 6-7
Lists, History, 5-41
Local Installation, 1-7, 2-1

Network Folder, Preparing, 2-2 to 2-3
Previous Version Found, 2-7, 3-12
Replace CentreVu Supervisor 5.0, 2-

8, 2-8, 3-13, 3-13
Selecting Components, 2-12, 3-17
Selecting the Destination Folder, 2-10
Selecting the Local Directory, 2-

9 to 2-10
Selecting the Shortcuts Folder, 2-13, 

3-18
Selecting the Type of Installation, 2-11
Setting Up the PC, 2-3 to 2-15
Type of Location, 2-6
Using Start/Run, 2-4 to 2-6

Location
of Legend, 7-36
of title, 7-35

Logging into CMS, 8-7, 8-8, 8-9
Logging out of CMS, 8-9
Login

Button, 5-20, 5-21
Prompt, 8-8

Login Status Indicator, 5-26
Logout Button, 5-25, 5-28
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M

Maintenance
Button, 5-26, 5-34
Icon, 7-39

Margins, defining page, 7-55
Maximize/Minimize Buttons, 5-20
Maximizing Report Output Windows, 7-51
Medium Font, 8-23
Menu Bar, 5-41

About CentreVu Supervisor, 5-23
Commands, 5-29

Agent Administration, 5-31
Call Center Administration, 5-31
Dictionary, 5-30
Exceptions, 5-30
Reports, 5-29

Connect, 5-21, 5-28
CMS Servers, 5-21
Exit, 5-28
Login, 5-21
Logout, 5-28

Connected to CMS Server, 5-27
Help, 5-22
Help Contents, 5-23
Not Connected to CMS Server, 5-21
Report, 7-11
Scripts, 5-35
Technical Support, 5-23
Terminal, 8-11
Tools, 5-22, 5-32

Add Button, 5-33
Advanced, 5-22, 5-33
Maintenance, 5-34
Options, 5-22, 5-33
Remove Button, 5-33
System Setup, 5-34
User Permissions, 5-34

Menus
Pop-Up, 7-42
Right Mouse Button, 7-42

Minimizing Report Output Windows, 7-51

Modem Connection
Baud Rate, 8-20
Data Bit, 8-21
Flow Control, 8-20
Parity, 8-20
Port, 8-20
Problems, 9-13
Settings, 8-20
Stop Bits, 8-21

Modem Tab, 8-21
Allow xx seconds, 8-22
Auto Retry, 8-22
Dial Prefix, 8-21
Dial Suffix, 8-22
Hangup String, 8-22
Reset String, 8-22

Modify button, 6-7
Modifying Database Items, 6-14

N

Name Format Tab, 7-80
National Customer Care Center Phone 

Number, 1-9, 9-1, 9-11
Network Connection, 1-12
Network Connection Settings, 8-19

CMS Network Address, 8-19
Network Port, 8-19

Network Port, 8-19
Network Setup, 2-15, 3-2 to 3-20
Network Software Operation, 9-13
Next button, 6-7, 6-13
None, label parameter, 7-37
Numbers, displaying page, 7-55

O

OCX Incompatibilities, 9-11
OK Button, 5-40
On a specific topic, 1-11
Opening a profile, 8-12
Opening Terminal, 8-6
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Operations
Actions menu, 6-6
Edit menu, 6-9
Input window, 6-4

Operations Window
Adding items, 6-11
Modifying items, 6-14

Options Button, 5-20, 5-22, 5-25, 5-33
Options Menu, 7-20

Restore Original View, 7-20
Status Bar, 7-20
Thresholds, 7-20

Options Tab
Default ACD, 7-75
Synchronize PC and CMS Time at 

Login, 7-76
Use Tooltips, 7-76
User Sound, 7-76

Options...
Communications Tab, 7-75, 7-77, 

7-78, 7-80
General Tab, 7-75
Name Format Tab, 7-80
Report Colors Tab, 7-77
Threshold Colors Tab, 7-78

Organize Scripts window, 5-35
Other icon, 7-40
Outside, label parameter, 7-37

P

Package Contents, 1-8
Page

Margins, defining, 7-55
Numbering, 7-55
Setup, 7-12, 7-54

Parity Setting, 8-20
Password Prompt, 8-8
Paste, 6-10
Percent, data point label, 7-38
Port Setting, 8-20
Previewing a report, 7-13
Previous Button, 6-7, 6-13
Previous Version Found, 2-7, 3-12
Print Setup, 7-53
Printer selection, 7-53

Printing a report, 7-12
Profile Menu, 8-11 to 8-12

1...4, choosing a profile, 8-12
Editing profiles, 8-17
New, 8-11
Open, 8-7, 8-12
Save, 8-12
Save As, 8-12
Save Profile As, 8-16

Profile Options
Communications Tab, 8-19
Font Tab, 8-22
Modem Tab, 8-21
Setting, 8-16, 8-18
Window, 8-15

Profiles, creating, 8-15 to 8-16
Projection, 7-31

R

Readme File
Accessing, 2-3, 3-3
Where to Find, 1-9

Real-Time, 7-29
Related Documents, P-7
Replace CentreVu Supervisor 5.0, 2-8, 

2-8, 3-13, 3-13
Report

Dates, 7-7
Destinations, 7-6
Layouts

Chart, 7-23
Table, 7-22

Restoring view, 7-20
Thresholds, Minimized, 7-41
Times, 7-10

Ending Interval, 7-10
Starting Interval, 7-10

Windows, Minimizing, 7-39
Report Colors Tab, 7-77
Report Designer, 7-3
Report Menu, 7-12

Design, 7-13
Exit, 7-14
Page Setup, 7-12



  
 CentreVu Supervisor Version 9 Installation and Getting Started
Index

IN-8

Report Menu, (continued)
Print, 7-12
Print Preview, 7-13
Restart, 7-12
Save, 7-13
Save As, 7-13
Save as HTML, 7-13
Script, 7-14

Report Menu Bar, 7-11
Edit, 7-15
Format, 7-17
Options, 7-20
Report, 7-12
Tools, 7-18

Report Selector Window, 7-4
Reports

Change Agent Splits/Skills, 7-19
Chart, 7-23
Copying chart, 7-50
Drill Down, 7-18
Exiting, 7-89
Formatting

Changing column widths, 7-52
Chart, 7-28
Table, 7-24

Historical
Run Dates, 7-7
Run Times, 7-10

Printing, 7-53
Report Selector Window, 7-3
Resize, 7-51
Resizing windows, 7-51
Restarting, 7-89
Running, 7-3
Saving to File, 7-15, 7-16
Setting Threshold Highlights, 7-56
Specifying page setup, 7-54
Status Bar, 7-20
Table, 7-22
Threshold Settings, 7-18

Reports Button, 5-25, 5-29
Reset String, 8-22
Resizing Report Windows, 7-51
Restarting a report, 7-12, 7-89
Restore Original View, 7-20
Right Mouse Button menu, 7-42

Right, label parameter, 7-38
Rotating a 3D Chart, 7-46
Rotation, 7-30
Run button, 6-8

S

Sample Text box, 8-23
Save As, 7-13
Save as HTML, 7-13, A-1 to A-6

Dialog box, A-3
Selecting fonts, A-3, A-6
Using a template, A-3

Save Profile As dialog box, 8-16
Saving a profile, 8-12
Saving a report, 7-13
Script

Automatic, 7-14
Interactive, 7-14
Report menu, 7-14
Save as Script dialog, 7-14

Script Button, 5-40, 6-8
Scripting

Organizing Scripts, 5-35
Scripts menu, 5-35

Scripts Menu, 5-35
Search for Help On, 1-11
Secondary System Password, using, 9-14
Select Components, 2-12, 3-17
Select Destination Directory, 3-15
Select Destination Folder, 2-10, 3-8
Select Folder, 2-13, 3-18
Select Local Directory, 2-9 to 2-10
Select Location, 2-9 to 2-10, 3-14 to 3-15
Select Network Location, 3-7 to 3-8
Select tables button, 6-8
Selector Windows, 5-39 to 5-40

Apply button, 5-40
Cancel button, 5-40
Help Button, 5-40
OK button, 5-40
Script button, 5-40
Tab folders, 5-39
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Serial Connection, 1-12
Baud Rate, 8-20
Data Bit, 8-21
Parity, 8-20
Port, 8-20
Problems, 9-13
Settings, 8-20
Stop Bits, 8-21

Series Name, data point label, 7-38
Service Pack 3 Installation, 1-13
Setting Profile Options, 8-18
Setting Report Threshold Highlights, 7-56
Shared Network Installation, 1-7

Client Setup, 3-11
Selecting the Components, 3-17
Selecting the Destination 

Directory, 3-15
Selecting the Location, 3-14 to

3-15
Selecting the Shortcuts Folder,

3-18
Selecting the Type of 

Installation, 3-16
Network Setup, 2-15, 3-2 to 3-20

Doing Administrative Tasks, 3-2
Selecting the Destination Folder,

3-8
Selecting the Network Location,

3-7 to 3-8
Selecting Type of Location, 3-6
Using Start/Run, 3-4

Show Gridlines, 7-25
Skill, Change Agent, 7-19
Small Font, 8-23
Sort Tab, 7-26
Split, Change Agent, 7-19
Split/Skill icon, 7-40
Split/Skill Thresholds, 7-67
Stacked check box, 7-34
Start button, 6-8
Starting Interval, 7-10

Status Bar, 7-20
ACD Status Indicators, 5-27
Connected to CMS Server, 5-26
Current Date and Time, 5-27
Exception Count, 5-26
Login

Status Indicator, 5-26
Not Connected to CMS Server, 5-20

Stop Bits Setting, 8-21
Supervisor

Icon, 5-37
Menus, using, 5-38
Performance, 1-16
Reliability/Availability, 1-16
Security, 1-16
Selector Windows, 5-39 to 5-40
Upgrading, 1-13

Synchronize PC and CMS Time at 
Login, 7-76

System Menu Box, 5-19
System Setup, 5-26
System Setup Button, 5-34
System Tray Icon

Controlling the sort order, 5-37
Turning on and off, 5-37
Using, 5-37

T

Tab Folders
Operations, 5-39
Reports, 5-39

Table
Exporting Data, 7-16
Formatting, 7-17
Sorting, 7-17

Table Format Options
General Tab, 7-25
Sort Tab, 7-26

Technical Support, 5-23
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Terminal
Creating profiles, 8-15 to 8-16
Definition, 8-2
Exiting, 8-9, 8-12
Installing, 8-4
Logging into CMS, 8-7, 8-8, 8-9
Messages, 8-24 to 8-25

Error, 8-24
Information, 8-25

Opening, 8-6
Using, 8-3, 8-10
Window, 8-10 to 8-11

Application, 8-11
Function keys, 8-11
Menu bar, 8-11
Title bar, 8-11

Terminal Menu Bar
Connection Menu, 8-13, 8-14
Edit Menu, 8-13
Help Menu, 8-14
Profile Menu, 8-11 to 8-12

Terminal type prompt, 8-8
Text Boxes, Completing, 5-43
Threshold Colors Tab, 7-78
Threshold Highlights

Agent Thresholds, 7-62
Caution Icon, 5-37
Minimized, 7-41
Setting, 7-56
Settings, accessing, 7-42
Split/Skill Thresholds, 7-67
Supervisor icon, 5-37
VDN Thresholds, 7-71
Warning icon, 5-37

Threshold Settings, 7-18
Highlighting, 7-20

Threshold, Color, 7-61
Title Bar

Connected to CMS Server, 5-24
Not Connected to CMS Server, 5-20

Title Bar, Terminal, 8-11
Title Tab, 7-35

Location, 7-35
Visible, 7-35

Toolbar
Buttons, 5-25
Connected to CMS Server, 5-25
Not Connected to CMS Server, 5-20

Toolbar Action buttons, 5-41
Tools Menu, 5-22, 5-32, 7-18

Add Button, 5-33
Advanced, 5-22, 5-33
Change Agent Splits/Skills, 7-19
Drill-Down Reports, 7-18
Maintenance, 5-34
Options, 5-22, 5-33
Remove Button, 5-33
System Setup, 5-34
Threshold Settings, 7-18
User Permissions, 5-34

Topics, Help, 1-10
Troubleshooting, 9-1

Installing CentreVu Supervisor, 9-12
Networking Software Operation, 9-13
OCX and DLL Incompatibilities, 9-11
Preserving CentreVu Supervisor User 

Profiles, 9-12
Resolving TCP/IP Host Name, 9-12
Secondary System Password, 9-14
Serial/Modem Connections 

Problems, 9-13
Windows Swap Files, 9-11

Trunk icon, 7-40
Type of Install, 2-11, 3-16
Type of Location, 2-6, 3-6
Type Tab, 7-33

% Axis, 7-34
2D vs. 3D, 7-33
Chart Type, 7-33
Stacked, 7-34

U

Uninstalling CentreVu Supervisor, 4-
1 to 4-3

What is Removed, 4-1
Upgrading Supervisor, 1-13
Use Sound, 7-76
Use Tooltips, 7-76
User Permissions, 5-26
User Permissions Button, 5-34
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V

Value, data point label, 7-38
VDN icon, 7-40
VDN Thresholds, 7-71
Vector icon, 7-40
Viewing Distance, 7-31
Visible check box, 7-35, 7-36

W

Warning Icon, 5-37
Warning Threshold icons, 7-41
Width to Height, 7-31
Windows

Closing, 5-48
Deleting items, 6-16
Input definitions, 5-41
maximizing, 7-51
minimizing, 7-51
Resize, 7-51
Resizing, 7-51

Windows Swap Files, 9-11
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helping us to improve our documentation.
1. Please rate the effectiveness of this document in the following areas:
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